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Legal information 
Warning notice system 

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger. 

DANGER  
indicates that death or severe personal injury will result if proper precautions are not taken. 

WARNING  
indicates that death or severe personal injury may result if proper precautions are not taken. 

CAUTION  
indicates that minor personal injury can result if proper precautions are not taken. 

NOTICE  
indicates that property damage can result if proper precautions are not taken. 

If more than one degree of danger is present, the warning notice representing the highest degree of danger will 
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to 
property damage. 

Qualified Personnel 
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. 
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and 
avoiding potential hazards when working with these products/systems. 

Proper use of Siemens products 
Note the following: 

WARNING  
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended 
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed. 

Trademarks 
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner. 

Disclaimer of Liability 
We have reviewed the contents of this publication to ensure consistency with the hardware and software 
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the 
information in this publication is reviewed regularly and any necessary corrections are included in subsequent 
editions. 
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Preface 

SINUMERIK documentation 
The SINUMERIK documentation is organized in the following categories: 

● General documentation 

● User documentation 

● Manufacturer/service documentation 

Additional information 
You can find information on the following topics under the link 
(www.siemens.com/motioncontrol/docu): 

● Ordering documentation/overview of documentation 

● Additional links to download documents 

● Using documentation online (find and search in manuals/information) 

Please send any questions about the technical documentation (e.g. suggestions for 
improvement, corrections) to the following address: 
(mailto:docu.motioncontrol@siemens.com)  

My Documentation Manager (MDM) 
Under the following link you will find information to individually compile OEM-specific 
machine documentation based on the Siemens content: MDM (www.siemens.com/mdm)  

Training  
For information about the range of training courses, refer under: 

● SITRAIN (www.siemens.com/sitrain) - training courses from Siemens for automation 
products, systems and solutions 

● SinuTrain (www.siemens.com/sinutrain) - training software for SINUMERIK 

FAQs 
You can find Frequently Asked Questions in the Service&Support pages under Product 
Support (www.siemens.com/automation/service&support). 

http://www.siemens.com/motioncontrol/docu�
mailto:docu.motioncontrol@siemens.com�
http://www.siemens.com/mdm�
http://www.siemens.com/sitrain�
http://www.siemens.com/sinutrain�
http://www.siemens.com/automation/service&support�
http://www.siemens.com/motioncontrol/docu):
http://www.siemens.com/automation/service&support
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SINUMERIK 
You can find information on SINUMERIK under the following link: 
(www.siemens.com/sinumerik)  

Target group 
This documentation is intended for commissioning personnel. 

The plant or system is readily assembled and wired. For the following steps, e.g. configuring 
the individual components, the Commissioning Manual contains all necessary information or 
at least references.  

Benefits 
The intended target group can use the Commissioning Manual to test and commission the 
system or the plant correctly and safely. 

Utilization phase: Setup and commissioning phase 

Standard version 
This documentation only describes the functionality of the standard version. Extensions or 
changes made by the machine manufacturer are documented by the machine manufacturer.  

Other functions not described in this documentation might be executable in the control. This 
does not, however, represent an obligation to supply such functions with a new control or 
when servicing. 

Further, for the sake of simplicity, this documentation does not contain all detailed 
information about all types of the product and cannot cover every conceivable case of 
installation, operation or maintenance. 

Technical Support  
Country-specific telephone numbers for technical support are provided in the Internet under 
"Contact" (www.siemens.com/automation/service&support).  

EC Declaration of Conformity 
The EC declaration of conformity for the EMC directive can be found in the Internet 
(www.siemens.com/automation/service&support).  

There, as search term, enter the number 15257461 or contact your local Siemens office.  

http://www.siemens.com/sinumerik�
http://www.siemens.com/automation/service&support�
http://www.siemens.com/automation/service&support�
http://www.siemens.com/automation/service&support
http://www.siemens.com/automation/service&support
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Introduction 1
1.1 Commissioning manuals for SINUMERIK 840D sl 

Steps for commissioning SINUMERIK 840D sl 
Commissioning a SINUMERIK 840D sl is performed in two basic steps: 

1. Step 1: Commissioning the NC, PLC, drive 

2. Step 2: Commissioning the NC functions, PLC user program, machine data 

The relevant manuals for commissioning SINUMERIK 840D sl are: 

● Commissioning Manual: CNC Commissioning: NC, PLC, Drive 

● Function manuals: Basic functions, extension functions, special functions, synchronized 
actions 

● List manuals: Machine data and interface signals 



Introduction  
1.1 Commissioning manuals for SINUMERIK 840D sl 

 CNC Commissioning: NC, PLC, Drive 
12 Commissioning Manual, 03/2013, 6FC5397-2AP40-3BA1 

The following figure is a schematic representation of the commissioning steps that are 
described in Step 1 and in Step 2: 

 
Figure 1-1 Commissioning overview  

References 
The commissioning of SINUMERIK 840D sl with Safety Integrated is described in the 
SINUMERIK 840D sl Safety Integrated Function Manual.  
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1.2 Configuration of SINUMERIK 840D sl and components and I/O 

Introduction 
In principle, an NCU contains the following components: 

● NCK 

● PLC 

● Drive 

● HMI 

● CP 

The following figure is a schematic representation of the NCU: 

 
Figure 1-2 Schematic representation of NCU 
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Commissioning the components  
The PG/PC required for commissioning is connected to the X127 service interface or access 
is made via the company network to X130. The following software tools are also required:  

● The commissioning tool on the PG/PC is needed for commissioning the drive. 

● For commissioning the PLC, a PG/PC with SIMATIC STEP7 Version 5.5 SP1 is required 
as well as the toolbox for SINUMERIK 840D sl for the current CNC software version. 

● A network switch is required to connect several communication partners to X120. 

SINUMERIK Operate on the NCU is running under the Linux operating system. In addition, a 
PCU can be connected to each NCU on which SINUMERIK Operate is running under 
Windows XP or Windows 7 with the following general conditions: 

● PCU 50.3 with Windows XP 

● PCU 50.5 with Windows XP or Windows 7 

  Note 

For the operation of SINUMERIK Operate on the PCU without TCU, the "HMI" subsystem 
must be switched off for SINUMERIK Operate on the NCU. 
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NCU 7x0.3 PN configuration with SINAMICS S120 Booksize 
The following diagram shows an example configuration of an NCU 7x0.3 PN with SINAMICS 
S120 Booksize:  

Main spindle motor Servo motors

SINUMERIK 
840D slwith 

SINAMICS S120

G
_N

C
01

_D
E

_0
03

45
c

SINUMERIK operator panel front with TCU

Power supply

PROFIBUS I/Os

Industrial Ethernet 

SIMATIC
ET 200pro

SINAMICS S120 NX15

• • •

• • •

DRIVE-CLiQ

SINUMERIK
HT 8

SINUMERIK
PCU 50.3

 
Figure 1-3 Example: SINUMERIK 840D sl configuration with SINAMICS S120 Booksize  
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NCU 710.3 PN configuration with SINAMICS S120 Combi 
The following figure shows a typical configuration of the NCU 710.3 PN with SINAMICS 
S120 Combi:  

Feed 
motors 

1FK7

Feed 
motors 
1FK7

G
_N

C
01

_D
E

_0
04

40

SINUMERIK
operator panel front with TCU

Power supply

SINAMICS S120
Motor Module in 
booksize compact 
format 

1PH8 spindle 
motor

Industrial Ethernet 

SIMATIC
ET 200pro

DRIVE-CLiQ

SINUMERIK
HT 8

SINUMERIK
PCU 50.3

PP 72/48D PN/
PP 72/48D 2/2A PN 

SINUMERIK 
840D sl

NCU 710.3 PN  

SINAMICS S120 
Combi

PROFINET

 
Figure 1-4 Example: SINUMERIK 840D sl configuration with SINAMICS S120 Combi  

 

 Note 
SINAMICS S120 Combi 

The configuration with SINAMICS S120 Combi is permissible only on an NCU 710.3 PN. 
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1.3 Initial commissioning procedure 

Introduction 
The mechanical and electrical installation of the system must be completed.  

The following is important when starting commissioning: 

● The controller with its components boots error-free. 

● The EMC guidelines were carefully maintained when configuring the system. 

Commissioning options depending on the CNC software on the CompactFlash card 
When commissioning the system for the first time, the following dependencies to the CNC 
software on the CompactFlash card are considered: 

● CompactFlash card with the current CNC software. 

● CompactFlash card without CNC software. 

● CompactFlash card with older CNC software. 

Commissioning steps 
The commissioning steps depending on the CNC software on the CompactFlash card are 
listed in the following table. The order is recommended but not mandatory: 

 
Commissioning steps With current 

CNC software
(first commis-
sioning) 

Without 
CNC soft-
ware (re-
installation 
and initial 
commis-
sioning) 

With older 
CNC software 
(upgrade) 

See chapter 

Install the CNC software on the CompactFlash card 
using one of the following media: 
 Bootable USB-FlashDrive 
 WinSCP on PC/PG 
 VNC viewer on PC/PG 
 
Note: 
Upgrade the controller: New installation/upgrading 
(Page 343)  

 1.  Automatic installation 
of the CNC software 
using USB-FlashDrive 
(Page 344)  
Installation of the CNC 
software using 
WinSCP on PC/PG 
(Page 348)  
Installation of the CNC 
software using VNC 
Viewer on PC/PG 
(Page 349)  

Archive the NCK, PLC, HMI and drive data   1. Saving data 
(Page 319)  
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Commissioning steps With current 
CNC software
(first commis-
sioning) 

Without 
CNC soft-
ware (re-
installation 
and initial 
commis-
sioning) 

With older 
CNC software 
(upgrade) 

See chapter 

Upgrade the CNC software using one of the 
following media: 
 Bootable USB-FlashDrive 
 WinSCP on PC/PG 
 VNC viewer on PC/PG 

  2. Automatic upgrade of 
the CNC software 
using USB-FlashDrive 
(Page 354)  
Upgrading the CNC 
software using 
WinSCP on PC/PG 
(Page 358)  
Upgrading the CNC 
software using VNC 
Viewer on PC/PG 
(Page 359)  

Load the archived NCK, PLC, HMI and drive data   3. Saving data 
(Page 319)  

Boot the SINUMERIK 840D sl with NCK/PLC 
general reset 

1. 2.  NCK and PLC general 
reset (Page 26)  

Make a communication connection to the PLC 2. 3.  Setting up the 
communication 
(Page 33)  

PLC commissioning 3. 4.  PLC commissioning  
(Page 33)  

Commission the SINAMICS drive system 4. 5.  Commissioning NC-
controlled drives 
(Page 67)  

NCK ↔ drive communication 5. 6.  Communication 
between the NC and 
the drive (Page 155)  

NCK commissioning 
 Assign the NCK machine data for 

communication 
 Scale the machine data 
 Parameterize the axis data 
 Parameterize the spindle data 
 Parameterize the measuring systems 

6. 7.  Commissioning the 
NC (Page 165)  

Drive Optimization 7. 8.  Optimize the drive 
(Page 241)  

 
 



 

CNC Commissioning: NC, PLC, Drive 
Commissioning Manual, 03/2013, 6FC5397-2AP40-3BA1 19 

Safety information 2
2.1 Danger notices 

The following notices are intended firstly for your personal safety and secondly to prevent 
damage occurring to the product described or any connected devices and machines. Non-
observance of the warnings can result in severe personal injury or property damage. 

 

DANGER  
Only appropriately qualified personnel may commission/start-up SINUMERIK equipment. 

The personnel must take into account the information provided in the technical customer 
documentation for the product, and be familiar with and observe the specified danger and 
warning notices. 

When electrical equipment and motors are operated, the electrical circuits automatically 
conduct a dangerous voltage. 

When the system is operating, dangerous axis movements may occur throughout the entire 
work area. 

A potential fire hazard exists due to the energy being transferred in the equipment and the 
work materials used. 

All work on the electrical system must be performed after the system has been switched off 
and disconnected from the power supply. 

 

DANGER  
Proper transportation, expert storage, installation and mounting, as well as careful 
operation and maintenance are essential for this SINUMERIK device to operate correctly 
and reliably.  

The details in the catalogs and proposals also apply to the design of special equipment 
versions. 

In addition to the danger and warning information provided in the technical customer 
documentation, the applicable national, local, and system-specific regulations and 
requirements must be taken into account. 

Only protective extra-low voltages (PELVs) that comply with EN 61800-5-1 can be 
connected to all connections and terminals between 0 and 48 V.  

Should it be necessary to test or take measurements on live equipment, then the 
specifications and procedural instructions defined in Accident Prevention Regulation BGV 
A2 must be adhered to, in particular § 8 "Permissible deviations when working on live 
components". Suitable electric tools should be used. 
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WARNING  
Power cables and signal lines should be installed in such a way that inductive and 
capacitive interference does not in any way impair the automation and safety functions. 

 

WARNING  
Repairs to devices that have been supplied by our company may only be carried out by 
Siemens customer service or by repair centers authorized by Siemens. When replacing 
parts or components, only use those parts that are included in the spare parts list. 

Before opening the device, always disconnect the power supply. 

Emergency stop/off devices which comply with EN 60204 / IEC 60204 (VDE 0113-1) must 
remain effective in all automation equipment operating modes. The act of releasing the 
emergency stop/off device must not cause an uncontrolled or undefined hot restart. 

Additional external measures must be taken, or devices must be created that enforce a 
safe operational state even when there is a fault (e.g. using independent limit value 
switches, mechanical locks, etc.) at any location in the automation equipment where faults 
might cause major material damage or even physical injury, in other words, where faults 
could be dangerous. 
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2.2 ESD notices 
 

 Note 
Handling ESDS modules: 

The modules contain electrostatically sensitive devices. Discharge yourself of electrostatic 
energy before touching the components. The easiest way to do this is to touch a conductive, 
grounded object immediately beforehand (for example, bare metal parts of the control 
cabinet or the protective ground contact of a socket outlet). 
 When handling electrostatically sensitive devices, make sure that operator, workplace 

and packing material are properly grounded. 
 Generally, electronic modules must not be touched unless work has to be carried out on 

them. When handling PC boards make absolutely sure that you do not touch component 
pins or printed conductors. 

 Components may only be touched under the following conditions: 
– You are permanently grounded by means of an ESD armband. 
– You are wearing ESD shoes or ESD shoe grounding strips if there is an ESD floor. 

 Modules must only be placed on conductive surfaces (table with ESD surface, conductive 
ESD foam, ESD packaging, ESD transport container). 

 Keep modules away from visual display units, monitors or TV sets (minimum distance 
from screen 10 cm). 

 Do not bring electrostatically-sensitive modules into contact with chargeable and highly-
insulating materials, such as plastic, insulating table tops or clothing made of synthetic 
materials. 

 Measurements may only be carried out on modules under the following conditions: 
– The measuring device is grounded (via a protective conductor). 
– When floating measuring equipment is used, the probe is briefly discharged before 

making measurements (e.g. a bare-metal controller housing is touched). 
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Requirements for commissioning 3
3.1 General prerequisites 

Prerequirements for components involved 
The complete system is connected mechanically and electrically, and has been verified in 
the following points: 

● All ESD measures are observed for the design of the components. 

● All screws are tightened with their prescribed torque. 

● All connectors are plugged correctly and locked/screwed. 

● All components are grounded and connected to shields. 

● The load capacity of the central power supply is taken into account. 

Limit values 
All components are dimensioned for defined mechanical, climatic and electrical 
environmental conditions. No limit value may be exceeded, neither during operation, nor 
during transportation. 

Special attention must be paid to the limit values: 

● Power supply conditions 

● Pollution burden 

● Function-impairing gases 

● Ambient environmental conditions 

● Storage/transport 

● Shock stressing 

● Vibration stressing 

● Ambient temperature 

References 
You can find further details in the following manuals:  

● Installing the SINAMICS S120 drive components: SINAMICS S120 manuals 

● Connecting the interfaces: NCU Equipment Manual 

● Operator Components and Networking Manual, "Networking" chapter 



Requirements for commissioning  
3.2 Requirements for hardware and software 

 CNC Commissioning: NC, PLC, Drive 
24 Commissioning Manual, 03/2013, 6FC5397-2AP40-3BA1 

3.2 Requirements for hardware and software 

Preconditions 
For the commissioning of SINUMERIK 840D sl, the following points are required: 

● Hardware requirements 

– NCU 73x0.3 PN 

– CompactFlash card (8 GB, empty, MLFB: 6FC5313-6AG00-0AA0) 

– Dual fan / battery module (MLFB: 6FC5348-0AA02-0AA0) for NCU 

– PCU 50.5 (basic software V5XP1.3) or PCU 50.3 (basic software V8.6 SP3) 

  Note 

Please dispose of used batteries in the specially provided collection points on site. 
This will ensure they are reused in the correct manner or treated as special waste. 

● Connection to NCU 

– Network switch to X120 

– Ethernet connection from PG/PC to X120 or X127 for commissioning the PLC 

– Ethernet machine control panel to socket X120 

– Ethernet connection from the TCU to the Ethernet machine control panel 

– Ethernet connection from the PCU to the Ethernet machine control panel 

● Software requirements 

– CNC software with SINUMERIK Operate, NCK, PLC and drive 

– SINUMERIK Operate for operation on the PCU 

– Commissioning tool on PG/PC V7.6 SP3 for commissioning the drive 

– SIMATIC STEP 7 V5.5 SP3 on PG/PC (SIMATIC Manager) 

– SINUMERIK 840D sl Toolbox for STEP 7 package  

– GSD file (Toolbox) 

  Note 

The order numbers (MLFB) of the SINAMICS drives, encoders, and motors should be 
available for parameterization.  
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3.3 Position of the interfaces 

Interfaces on the NCU   
The NCU has the following interfaces:  

 
X100 ... X105 DRIVE-CLiQ for SINAMICS drive components 
X124 +24 V DC external power supply 
X125, X135 USB only for commissioning and servicing 
X120 Industrial Ethernet for connection to a system network  

(TCU and/or PCU) 
X130 Industrial Ethernet for connection to a company network 
X127 Industrial Ethernet service interface for PG/PC 
X136 PROFIBUS DP / MPI  
X126 PROFIBUS DP PROFIBUS DP (for example for PLC axes) 
X150-1, X150-2 PROFINET IO for PROFINET components 
X122, X132, X142 Based on PROFINET Digital inputs/outputs for I/O devices 

Figure 3-1 Position of the interfaces  
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3.4 Power-On and boot-up 

3.4.1 NCK and PLC general reset 

SVC/NCK and PLC rotary switches  
The NCU has two rotary switches in the lower section of the front panel.  

 
 
NCK commissioning switch 
 
 
 
PLC mode selector 

 

The settings on the SVC/NCK switch have the following meaning:  

 
Switch position NC operating mode 

0 NC normal boot-up 
1 NC boot-up with default values (= memory reset) 
2 The NC (and PLC) boots up with the data that was saved at the last shutdown 
7 Debug mode (NC is not started) 
8 IP address of the NCU is displayed on the seven-segment display 

All others Not relevant  

The settings on the PLC switch have the same meaning as for a SIMATIC S7-CPU:  

 
Switch position Operating mode of the PLC 

0 RUN  
1 RUN (protected mode) 
2 STOP 
3 Memory reset (MRES) 

All others Not relevant 
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Initial commissioning 
In order to achieve a defined initial state of the complete system, for the initial commissioning 
of the NCU, a general reset of the NC and the PLC must be performed.  

 

 Note 

In the following cases, a general PLC reset must always be performed: 
 Initial commissioning 
 Module replacement 
 General reset request by the PLC 
 Upgrading the PLC 

 

Procedure:  

1. Set the rotary switch of the NCU to the following settings: 

– NCK commissioning switch: Switch position "1" 

– PLC mode selector switch: Switch position "3" 

2. Initiate a power-on reset by switching-off the control and switching-on again – or by 
pressing the Reset button on the front of the NCU. The NCU is terminated and with the 
request for a general reset is restarted. 

Effect: 

– The "STOP" LED flashes. 

– The "SF" LED illuminates continuously. 

3. Within approx. three seconds, turn the PLC mode selector switch to the positions  
"2" → "3" → "2". 

Effect: 

– The "STOP" LED first flashes with about 2 Hz and then illuminates continuously. 

4. Turn the PLC mode selector switch back to the "0" position. 

Effect: 

– The "STOP" LED extinguishes. 

– The "RUN" LED flashes initially and then illuminates green continuously. 

5. Turn the NCK commissioning selector switch back to the "0" position. 
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Result 
The NCU has now been generally reset and is in the following state: 

● NC 

– The user data is deleted. 

– The system data is initialized 

– The standard machine data is loaded 

● PLC 

The general reset places the PLC in a defined initial state: 

– The user data has been deleted (data and program blocks). 

– The system data blocks (SDB) have been deleted. 

– The diagnostics buffer and the MPI parameters have been reset. 

The "RUN" LED illuminates. NC and PLC are in cyclic operation. 
 

 Note 
PLC general reset 

If a general PLC reset is performed using a power-on reset, then the user data must again 
be transferred to the PLC, e.g. via a programming device (PG). 

 

After the PLC general reset, no PLC start is performed and at least the following alarm 
issued: 

● Alarm: "2001 PLC not booted" 

These alarms have no influence on the next steps. 

3.4.2 Separate NCK and PLC general reset 

NCK general reset 
Carry out the following actions to perform an NCK general reset: 

1. Turn the NCK commissioning switch on the front of the NCU to position "1". 

2. Initiate a power on reset by switching-off the controller and switching-on again - or by 
pressing the Reset button on the front of the NCU (labeled "RESET").  
The NCU is terminated and with the request for a general NCK reset is restarted. 

3. After the NCU has booted, turn the NCK commissioning switch back to position "0". 

Effect: 

– The number "6" and a flashing point are output on the status display (7-segment 
display) on the front of the NCU 

– "RUN" LED is lit 
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The NCU is in the following state after an error-free boot-up: 

● The static memory of the NCU is deleted. 

● The machine data is preassigned standard values. 

● The NCK is in cyclic operation. 

Alternatives 
A PLC general reset can be performed with or without power-on reset. Depending on this, 
various states result for the PLC user program.  

PLC general reset without power-on reset  
Perform the following operator actions for a PLC general reset without power-on reset: 

1. Turn the PLC mode selector switch on the front of the NCU to position "2" (STOP). 

Effect: 

– The PLC goes into the "STOP" mode. 

– The "STOP" LED illuminates. 

2. Turn the PLC mode selector switch to position "3" (MRES) 

Effect:  

– The "STOP" LED goes dark and after approx. three seconds illuminates again. 

3. Within approx. three seconds, turn the PLC mode selector switch to the positions 
"2" → "3" → "2" 

Effect: 

– The "STOP" LED first flashes with about 2 Hz and then illuminates continuously. 

4. Turn the PLC mode selector switch back to the "0" position. 

Effect: 

– The "STOP" LED extinguishes. 

– The "RUN" LED illuminates. 

A general reset has now been performed for the PLC and it is in cyclic transmission with the 
following properties: 

● The time of day and the operating hours counter have not been reset. 

● The diagnostics buffer and the MPI parameters have not been reset. 
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PLC general reset with power-on reset 
Perform the following operator actions for a PLC general reset with power-on reset: 

1. Turn the PLC mode selector on the front of the NCU to position "3" (MRES). 

2. Initiate a power-on reset by switching-off the control and switching-on again – or by 
pressing the Reset button on the front of the NCU. The NCU is terminated and with the 
request for a general reset is restarted. 

Effect: 

– The "STOP" LED flashes. 

– The "SF" LED illuminates continuously. 

3. Within approx. three seconds, turn the PLC mode selector switch to the positions 
"2" → "3" → "2". 

Effect: 

– The "STOP" LED first flashes with about 2 Hz and then illuminates continuously. 

4. Turn the PLC mode selector switch back to the "0" position. 

Effect: 

– The "STOP" LED extinguishes. 

– The "RUN" LED flashes initially and then illuminates green continuously. 

The general reset places the PLC in a defined initial state: 

● The user data has been deleted (data and program blocks). 

● The system data blocks (SDB) have been deleted. 

● The diagnostics buffer and the MPI parameters have been reset. 

 

 Note 

For the general reset without power-on reset, the most recently loaded blocks from the PLC 
user program are reimported.  

 

Boot completed without error 
After an error-free boot of the NCU, the following status is displayed: 

● The number "6" and a flashing point 

● The "RUN" LED illuminates green continuously. 

In the following step, commissioning of the PLC is done with the SIMATIC Manager. 
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3.5 Access levels 

Access to functions and machine data   
The access concept controls access to functions and data areas. Access levels 0 to 7 are 
available, where 0 represents the highest level and 7 the lowest level. Access levels 0 to 3 
are locked using a password and 4 to 7 using the appropriate key-operated switch settings. 

 
Access level Locked by  Area Data class 

0 --- (reserved) --- 
1 Password: SUNRISE Manufacturer Manufacturer (M) 
2 Password: EVENING Service Individual (I) 
3 Password: CUSTOMER User User (U) 
4 Key-operated switch setting 3 Programmer, machine setter User (U) 
5 Key-operated switch setting 2 Qualified operator User (U) 
6 Key-operated switch setting 1 Trained operator User (U) 
7 Key-operated switch setting 0 Semi-skilled operator User (U) 

 

The password remains valid until it is reset with the "Delete Password" softkey. The 
passwords can be changed after activation.  

If, for example, the passwords are no longer known, reinitialization (boot-up with 
"NCK default data") must be carried out. This resets all passwords to the default (see table). 
POWER ON does not reset the password. 

Key-operated switch 
Access levels 4 to 7 require a corresponding key-operated switch setting on the machine 
control panel. Three keys of different colors are provided for this purpose. Each of these 
keys provides access only to certain areas.  

Meaning of the key-operated switch settings:  

 
Access level Switch position Key color 

4-7 0 to 3 red 
5-7 0 to 2 green 
6-7 0 and 1 black 
7 0 = Key removal position No key inserted 

The key-operated switch setting must always be edited from the PLC user program and applied to the 
interface accordingly. 
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Set password 
To change the access level, select the "Start-up" operating area:  

1. Press the "Password" softkey. 

2. Press the "Set password" softkey to open the following dialog: 

 
Figure 3-2 Set password 

3. Enter a password and confirm this with "OK" or with the <Input> key. 

A valid password is acknowledged as set and the currently applicable access level is 
displayed. Invalid passwords will be rejected.  

4. You must delete the old password before activating a password for a lower access level 
than the one activated. 

The last valid password is deleted by pressing the "Delete password" softkey. Then the 
current key-operated switch setting is valid.  

Change password 
To change the password:  

1. Press the "Change password" softkey to open the following dialog: 

 
Figure 3-3 Change password 

2. Enter the new password in both fields and then confirm with the "OK" softkey. If both 
passwords match, the new password becomes valid and is adopted by the system. 
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PLC commissioning 4
4.1 Connect PG/PC with the PLC 

4.1.1 Setting up the communication 

Introduction  
SIMATIC Manager is a GUI for online/offline editing of S7 objects (projects, user programs, 
blocks, hardware stations and tools). 

You can perform the following actions with the SIMATIC Manager: 

● Manage projects and libraries 

● Call STEP 7 tools 

● Establish an online connection to the PLC 

A corresponding editing tool is started up when you open the relevant objects. The program 
editor starts by double-clicking a program block. The block can be processed. 

Starting SIMATIC Manager   
After installation, the SIMATIC Manager icon appears on the Windows desktop, and in the 
Start menu a "SIMATIC Manager" program item appears under "SIMATIC". 

● Start the SIMATIC Manager by double-clicking the link on the Windows desktop or from 
the Start menu. 

● The online help for the active window is always called by pressing the <F1> function key. 
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Establishing a communications connection to the PLC  
To load the configuration into the PLC, the communications connection (Ethernet) from the 
PG/PC to the PLC required for the loading must be secured. 

Procedure: 

1. Select menu command: "Extras" > "Set PG/PC interface..." 

2. Under the "Access mode" tab, look for the interface used in the "Interface 
parameterization used" selection field, for instance: "TCP/IP → Realtek RTL8139/810x 
F…" 

3. Confirm the parameterization with "OK". 

  Note 

Parameterization of the PG/PC interface can be performed or changed from the SIMATIC 
Manager at any time. 
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4.2 Creating a SIMATIC S7 project 

4.2.1 SIMATIC S7 project overview 

Steps to be taken  
It is necessary to create a SIMATIC S7 project for the basic commissioning of the PLC, the 
Ethernet and PROFIBUS communication as well as the input/output data areas of the NCK. 
To do this, perform the following steps:  

● Create a project 

● Insert a SIMATIC station 300 

● Insert an NCU to the hardware configuration 

● Configure the network interfaces 

● Insert the machine control panel and hand wheel 

What do you need to be aware of? 
Loading the PLC via network interface X130 is also possible if the IP address of the Ethernet 
interface is known. Loading an archive may always be carried out if the communication 
HMI↔NCK is available. 

 

 Note 

Loading the PLC (CP840) is essential for the configuration of the data path for 
saving/restoring the drive data.  

 

References 
The PLC interface signals are described in:  

● "NC Variables and Interface Signals" List Manual 

● Function Manual, Basic Functions; Section "NC/PLC Interface Signals (Z1)" 
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Operating sequence 
You have started the SIMATIC Manager. 

1. To create a new project, select the "File" → "New" menu command in the SIMATIC 
Manager. 

2. Enter the project data: 

– Name (for example: SINU_840Dsl) 

– Storage location (path) 

– Type 

3. Confirm the dialog with "OK". 

The project window is displayed showing an empty S7 project structure. 

4.2.2 Inserting SINUMERIK NCU to the HW Config 

Overview 
Insert the necessary hardware in the following order in the S7 project: 

● Insert a SIMATIC station 300 

● Start the hardware configuration 

● Insert a SINUMERIK NCU 
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Operating sequence 
Procedure: 

1. Select via the context menu (right-click) "Insert new object" > "SIMATIC 300 station". 

 
2. Double-click the <SIMATIC 300> symbol. 

3. Double-click the <Hardware> symbol. 

The HW Config for introducing required hardware is started. 
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4. In the menu, select "View" > "Catalog". The catalog with the modules is displayed. 

 
① Station window: 
② Details 
③ Hardware catalog 

The user interface of the "HW Config" hardware configuration shows the following details:  

– Station window: 

The station window is split. The upper part displays the structure of the station 
graphically, and the lower part provides a detailed view of the selected module.  

– Hardware catalog 

This catalog also contains the SINUMERIK NCU that you need for configuring the 
hardware.  
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Inserting a SINUMERIK NCU    
With the operating sequence described below, you insert the NCU 720.3 PN as example:  

1. Select "View" > "Catalog". 

2. Search for the module in the catalog under "SIMATIC 300" → "SINUMERIK" → "840D sl" > 
"NCU 720.3 PN". 

 
3. Select "NCU 720.3 PN" with the left mouse button and drag it to the "Station design" 

station window while keeping the mouse button pressed. 

After you release the mouse button, configure in the dialog the properties of the interfaces of 
the CP 840D sl processor present on the NCU 720.3 PN.  
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4.2.3 Configure the network interfaces 

Introduction 
Configure the following network interfaces in the STEP 7 project over which you want to 
reach the NCU: 

● Ethernet 

● Integrated PROFIBUS 

● PROFIBUS DP, only with machine control panel for PROFIBUS (see Configure 
PROFIBUS components (Page 389)) 

When creating a new project using the catalog, the configuration of the PROFIBUS interface 
is called automatically. 

PROFIBUS DP operating sequence 
1. You used the left mouse button to select an NCU and while holding down the mouse 

button you dragged it to the "Station design" station window. 

2. After you release the mouse button, configure the properties of the PROFIBUS DP 
interface for socket X126 (machine control panel) in the dialog. 

 
3. This is an Ethernet machine control panel that does not require configuration. Select 

"Cancel". 

4. The NCU module with SINAMICS S120 is inserted into the HW Config. 
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  Note 

With the <F4> key and confirmation of the prompt regarding "Reorganize", you can 
reorganize the display in the station window. 

 
Next, specify the properties for the Ethernet interface. 

Operating sequence for Ethernet interface 
 

 Note 

Use the X127 service interface for commissioning the PLC. No configuration of the Ethernet 
interface is required for this. This interface is already initialized with the IP address 
192.168.215.1 

 

For the initial commissioning with a PG/PC, it is necessary to configure an Ethernet 
interface. In our example, this involves the interface to socket X120. 
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1. Double-click "CP 840D sl" in the basic rack of the NCU. The "Properties - CP 840D sl" 
dialog opens. 

 
2. After clicking the "Properties" button, a new Ethernet interface can be created. 

 
3. For socket X120, enter the IP address "192.168.214.1" and the Subnet screen form 

"255.255.255.0". 

4. Create the Ethernet interface using "New" and then "OK". 

5. Click "OK" twice. 

As the next step, configure the Web browser of the PLC. 

See also 
Configuring the communication to the drive (Page 157) 
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4.2.4 Configuring the Web browser 

Operating sequence 
1. Click the SINUMERIK module in the hardware configuration. 

The following dialog opens: 

 
2. Select the "Web" tab. 

3. Select the option: "Enable the Web server on this module". 

If the checkbox is selected, after loading the configuration data, the Web server of the 
CPU is started and information can be read from the PLC via a Web browser.  

4. Select the language for language-dependent texts to be loaded into the CPU. 

The number of available languages is CPU-dependent. Examples of language-dependent 
texts are diagnostics buffer entries or messages. 

  Note 
Available languages 

The languages you select here must be installed in the S7 project. You can install the 
languages for the project in the SIMATIC Manager from "Extras" → "Language for display 
devices ... "  

If the languages you select in the SIMATIC Manager have not been installed previously, 
the Web server can only display texts in the set default language.  

5. Activate the "Automatic update" if you want the Web pages to be updated automatically. 
The "Identification" Web page is excluded from the automatic update. 
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Telegram lengths and I/O addresses  
The telegram lengths and I/O addresses for communication between the PLC and the drive 
(can be viewed via the object properties of the integrated SINAMICS) have already been 
pre-assigned correctly and do not need to be configured.  

As the next step insert an NX component. 

4.2.5 Inserting an NX to the hardware configuration 

Introduction 
The NX must be wired to the NCU via the DRIVE-CLiQ. A fixed DRIVE-CLiQ socket is 
provided for the relevant address. The following table contains the wiring: 

 
Address on the integrated 
PROFIBUS 

DRIVE-CLiQ interfaces 
NCU 720.3 PN / 730.3 PN 

DRIVE-CLiQ interfaces 
NCU 710.3 PN 

10 X100 X100 
11 X101 X101 
12 X102 X102 
13 X103 X103 
14 X104 --  
15 X105 -- 

Operating sequence 
An NX component is contained in the example configuration, for the axis to control the 
spindle. This component must be integrated in the hardware configuration also when 
creating the STEP 7 project:  

1. Search for the NX module NX15.3 in the hardware catalog under 
"PROFIBUS DP" > "SINAMICS" > "SINUMERIK NX…". 

2. Left-click to select the "SINUMERIK NX ..." module and drag it to the "PROFIBUS 
Integrated DP master system" bus in the "Station design" station window. 
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3. The "DP Slave Properties" dialog box opens. 

 
Enter the address for the integrated PROFIBUS in this dialog. "15" is proposed for the 
first NX in a configuration.  

4. Enter the address and click "OK". 

 
5. Confirm the wiring notification with "OK". 



PLC commissioning  
4.2 Creating a SIMATIC S7 project 

 CNC Commissioning: NC, PLC, Drive 
46 Commissioning Manual, 03/2013, 6FC5397-2AP40-3BA1 

6. After releasing the mouse key, you have inserted the NX module: 

 
When deleting and re-inserting NX modules in the hardware configuration, new slot 
addresses are assigned during the address assignment. In order to create a clear and 
transparent configuration that is always the same, we recommend that addresses are 
allocated as shown in the following table: 

 
Address on the 
integrated PROFIBUS 

DRIVE-CLiQ interface, 
e.g. NCU 720.3 PN 

Start address of first 
controller slot 

Start address of last 
controller slot 

10 X100 5540 5740 
11 X101 5300 5500 
12 X102 5060 5260 
13 X103 4820 5020 
14 X104 4580 4780 
15 X105 4340 4540 
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4.2.6 End the hardware configuration and load it to the PLC 

End the hardware configuration and load the to the PLC 
To end the overall configuration and generate the system data for the PLC, the project must 
be saved and compiled. 

1. Select the "Station" > "Save and compile" menu. 

2. Click the "Load in module" button to load the configuration to the PLC. 

The "Select target module" dialog automatically displays both configured communication 
partners. 

 
3. Confirm with OK to load into these two modules. 

4. Confirm the dialog boxes displayed subsequently with "OK" or "No" for the query 
"…Should the module be started now (restart)?". 

  Note 

You can test the communication interface at "Target system > Diagnosis > Operating 
mode". 

5. Close the "HW Config" window. 

The next step is to create the PLC program. 
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4.3 Creating a PLC program 

Introduction 
The PLC program is constructed modularly. It comprises the two parts: 

● PLC basic program 

The PLC basic program organizes the exchange of signals and data between the PLC 
user program and the NCK, HMI, and machine control panel components. The PLC basic 
program is a part of the Toolbox delivered with the SINUMERIK 840D sl. 

● PLC user program 

The PLC user program is the user-specific part of the PLC program by which the PLC 
basic program has been added to or extended. 

FB 1 (start-up block of the PLC program) must be assigned variables. A precise description 
of the variables and options for modifying their parameterization can be found in: 

Literature 
Function Manual, Basic Functions, PLC Basic Program (P3) 

Cyclical mode (OB 1) 
From a chronological viewpoint, the basic program runs ahead of the PLC user program. 
The complete processing of the NCKPLC interface is carried out in cyclic mode. A cyclic 
monitoring function is activated between PLC and NCK once boot-up and the first OB1 cycle 
have been completed. A PLC failure produces alarm ”2000 Sign-of-life monitoring PLC”. 

PLC user program 
The following organization blocks of the basic program contain the entry points for the 
appropriate parts of the PLC user program:  

● OB100 (cold restart) 

● OB1 (cyclic processing) 

● OB40 (process alarm) 
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The following figure illustrates the structure of the PLC program: 

 
Figure 4-1 Structure of the PLC program 

PLC status 
The PLC always starts up in RESTART mode, i.e. the PLC operating system runs OB100 
after initialization and starts cyclic operation at the beginning of OB1. No return is made to 
the interruption point (for example, in the event of a power failure). 
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Start-up behavior of the PLC 
There are both remanent and non-remanent areas for the markers, timers and counters. The 
areas are continuous and are divided by a parameterizable limit, where the area with the 
higher-value address range is defined as the non-remanent area. Data blocks are always 
remanent. 

Start-up mode COLD RESTART (OB 100) 
If the remanent area has no battery backup (backup battery is empty) start-up is prevented. 
The following operations are performed during a cold restart: 

● UStack, BStack and non-retentive flags, timers and counters are deleted 

● The process output image (POI) is deleted 

● Process and diagnostics alarms are canceled 

● The system status list is updated 

● Parameterization objects of modules (from SD100 onwards) are evaluated or default 
parameters are output to all modules in single-processor mode 

● Execute cold restart (OB100) 

● Read in process input image (PII) 

● Cancel command ouptput inhibit (BASP) 

4.3.1 Preconditions for creating the PLC user program 

Software and hardware preconditions 
The following conditions must be met for creating a PLC user program: 

● SIMATIC STEP 7 V5.5 SP1 

● SIMATIC STEP 7 is installed on the PG/PC 

● Installing the toolbox (PLC basic program, slave OEM, GSD files) 

● Editing the blocks in the PLC basic program 

● Installing the PLC basic program library 

To be able to use the blocks of the PLC basic program (OBs, FBs, DBs) in a SIMATIC S7 
project, the library must first be installed in the SIMATIC Manager.  

Editing the blocks in the PLC basic program 
The operating sequence for the creation of a PLC program describes how to create a basic 
program. The SIMATIC STEP 7 documentation describes how to modify and extend a user 
program.  
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The individual blocks in the PLC basic program can be processed as follows in the SIMATIC 
Manager: 

● Select the appropriate block, e.g. OB 100, in the folder blocks of the corresponding 
module 

● Use the "Edit" > "Open object" menu command to open the block or double-click the 
block with the left mouse button 

● Edit the block using the LAD/STL/CSF editor. Switch over to the block display using the 
"View" > "LAD" or STL or CSF menu command 

4.3.2 Insert PLC basic program 

Introduction 
You have performed the hardware configuration, have saved and compiled the project and 
have created the system data for the PLC. You have installed the Toolbox software that also 
contains the libraries for the PLC basic program of an NCU. 

Operating sequence to open the library and copy sources, symbols and blocks 
You are on the main screen of the SIMATIC Manager:  

1. Select the "File" → "Open" menu and then click the "Libraries" tab. 
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2. Select the library of the PLC basic program, e.g. "bp7x0_45" and confirm the dialog with 
"OK". 

You have inserted the library and selected the PLC program from "SINU_840Dsl" > 
"SINUMERIK" → "PLC 317 2DP" → "S7 program".  

 
3. Copy the sources, modules and symbols to the PLC program. 

Overwrite OB1 
Inserting blocks overwrites the existing organization block OB1. Confirm the query as to 
whether you want to overwrite the block with "Yes". 

You have now created the PLC basic program. 

In the next section you will modify some of the data for the machine control panel in OB100. 

4.3.3 Modifying machine control panel in OB100 

Introduction 
The PLC base program transfers the signals from the machine control panel. To ensure that 
the signals are transferred correctly to and from the machine control panel, enter the 
following parameters in the OB100 on the FB1. 

Double-click OB100 the editor to configure the machine control panel below "Blocks". 

Example: MCP1 is connected via Industrial Ethernet (IE). 

Another example for the connection of the machine control panel via PROFIBUS DP can be 
found at:  
Modifying PROFIBUS machine control panel in OB100 (Page 395) 
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Configuring the machine control panel 
 
OB100  

CALL "RUN_UP" , "gp_par"     FB1 / DB7 -- Startup Baseprogram/ Parameters for 
Baseprogram 

 MCPNum :=1 // An MCP is present 

 MCP1In :=P#E 0.0 

 MCP1Out :=P#A 0.0 

 MCP1StatSend :=P#A 8.0 

 MCP1StatRec := 

 

 MCP1BusAdr :=192 

 MCP1Timeout := 

 MCP1Cycl := 

 MCP2In := 

 MCP2Out := 

 MCP2StatSend := 

 MCP2StatRec := 

// IP address: 192.168.214.192 - this 
address must also be set on the DIPFIX 
switch of the MCP. 

 MCP2BusAdr := 

 MCP2Timeout := 

 MCP2Cycl := 

 MCPMPI :=FALSE 

 MCP1Stop :=FALSE 

 MCP2Stop := 

 MCP1NotSend :=FALSE 

 MCP2NotSend := 

 MCPSDB210 := 

 MCPCopyDB77 := 

 

 MCPBusType :=B#16#05 // Parameter [5] := ETHERNET 

 

 BHG := 

 BHGIn := 

 BHGOut := 

    

... 

    

 UDInt := 

 UDHex := 

 UDReal := 

 IdentMcpType := 

 IdentMcpLengthIn := 

 IdentMcpLengthOut:= 

 

//Insert User program from here 

...  
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Result 
You have completed the configuration of the PLC base program. In the next step, you will 
load the project to the PLC. 

References 
You can find additional information about the connection of components:  
Function Manual, Basic Functions (P3), Section "Structure and functions of the base 
program" 

Machine control panel with handwheel 
If you have an Ethernet machine control panel with Ethernet handwheel, you must set the 
following machine data for the handwheel: 

MD11350[0] $MN_HANDWHEEL_SEGMENT = 7Ethernet 

 

The following are true for a PROFINET machine control panel with handwheel:  

MD11350[0] = 5 PROFIBUS/PROFINET 
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4.4 Download the project to the PLC 

Introduction 
For loading the configured PLC project, the following prerequisites must be fulfilled: 

Precondition 
● An Ethernet network connection exists between STEP7 and the PLC. 

● The configuration to be loaded corresponds to the actual station configuration. 

● The NCU is active: 

– NCK is in cyclic mode. 

– PLC in RUN or STOP mode. 

Supplementary condition 
The following supplementary conditions regarding the system data blocks must be observed 
when the configuration is loaded: 

● HW Config 

When loading the configuration via HW Config, only the system modules and their 
associated system data blocks selected in HW Config are loaded into the module. 
However, global data defined in SDB 210 is not loaded from the HW Config, for example. 

You have loaded the HW Config to the module in the previous "End the hardware 
configuration and load to the PLC" chapter. 

● SIMATIC Manager 

When loading the configuration via the SIMATIC Manager all the system data blocks are 
loaded into the module.  

  Note 

When the PLC program is loaded in the "RUN" mode, each block loaded becomes active 
immediately. This can result in inconsistencies when executing the active PLC program. It 
is therefore advised to place the PLC in the "STOP" mode before loading the 
configuration, if this has not already been done. 
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Operating sequence for loading system blocks into the module 
1. To load the configuration of the system blocks change to the SIMATIC Manager. 

2. In the SIMATIC Manager in the PLC directory, select the directory "Blocks" > right mouse 
button > "Target system" > "Load" (see figure below), or the "Load" symbol. 

 
Figure 4-2 Loading system blocks  

3. If there is no connection to the target system, you must confirm in sequence the following 
dialog requests with: 

– "OK" for "Check the required sequence of blocks for correct functioning" 

– "Yes" for "Do you want to load system data?" 

– "Yes" for "Must system data be deleted on the module and replaced by off-line system 
data?" 

– "No" for "The module is in STOP mode. Do you want to start the module (cold restart)?" 

You have loaded the PLC program to the PLC; the PLC is in "STOP" mode. 
 

 Note 

If the PLC is stopped via the SIMATIC Manager, then it also has to be started via the 
SIMATIC Manager. Starting via the PLC mode selector is also possible. 
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4.5 Loading PLC symbols to the controller 

Preconditions 
You require the SIMATIC STEP 7 software and the "PLC Symbols Generator" program that 
is provided in the toolbox. 

For blocks that already have a symbolic name, these symbols cannot be overwritten by other 
user-defined designations. Only those symbols are transferred from the blocks to the control 
without preassigned symbols. 

Generating PLC symbols 
To edit PLC blocks via symbolic names, you can generate the symbols of the STEP 7 project 
for SINUMERIK Operate and store them on the CompactFlash card on the control.  

Procedure: 

1. Open the "PLC Symbols Generator" program and navigate to the corresponding PLC 
project. 

2. To start the generation, first select the required language. 

3. Save the "PlcSym.snh" and "PlcSym_xx.snt" files. xx is the language code specified when 
creating the file. The generation is then started. 

4. Create the following directory on the CompactFlash card and store the generated files 
(PlcSym_xx.snt, PlcSym.snh) under the following path: /oem/sinumerik/plc/symbols 

5. After restarting SINUMERIK Operate, the symbol tables are loaded when booting. Select 
the "Insert variables" softkey to display the imported symbols in the table of the "NC/PLC 
variables". 

 

 Note 

The notation (upper/lower case) of the file name that the program created is mandatory and 
must not be changed. 

 

Transmission protocol  
For the generation and transfer of the symbols, a transfer log is created and stored under the 
following path: ../log/symbolimport.log   

Example: 

... 
Error importing PLC symbols: skip vdi on 840d: Symbol number 16956 
... 
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4.6 First commissioning of the PLC completed 

Initial commissioning of the PLC completed 
 

 Note 

A reset (warm restart) of the NCK is required for PLC-NCK synchronization. 

See also: Triggering a reset (warm restart) for NCK and drive system  (Page 76)  
 

The PLC and NCK are in the following state after a reset (warm restart): 

● RUN LED illuminates GREEN continuously. 

● Status display shows a "6" with a flashing point. 

⇒ PLC and NCK are in cyclic operation. 

You have completed the initial commissioning of the PLC.  

Continue with the steps for "Guided commissioning" of SINAMICS drives.  

You start with Reset (warm restart) for the NCK and drive system. 
 

 Note 
Response of the PLC in the case of an NCK stop 

For a stop of the NCK, the PLC normally continues to run and the type of stop response is 
the user's responsibility depending on the machine situation. In this special case, the NCK 
can no longer switch the outputs to zero and the current status is retained because the PLC 
is still running.  

In order to switch off the outputs or to force a PLC stop, for example, the "NC READY" signal 
is evaluated in the PLC user program. 
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4.7 Configuring a network (NetPro) for PG/PC 

4.7.1 Integrating PG/PC into NetPro 

Preconditions 
The following preconditions for integrating a PG/PC must be met: 

● The NCU is inserted in the S7 project with the HW Config Inserting SINUMERIK NCU to 
the HW Config (Page 36). 

● The properties of the network interfaces are configured Configure the network interfaces 
(Page 40). 

● The PLC communication to the drive is configured. 

● The machine control panel is inserted Modifying machine control panel in OB100 
(Page 52). 

● The configuration is saved and compiled End the hardware configuration and load it to 
the PLC (Page 47). 

● A PLC program has been created. 

Operating sequence for integrating the PG/PC in the S7 project 
To carry out routing functions, it is necessary to integrate a PG/PC in the SIMATIC Manager 
under NetPro and to configure the interfaces. 

To enable the communication between PG/PC ↔ HMI via Ethernet, the PG/PC should be 
included in the network configuration.  

Procedure: 

1. To integrate a PG/PC, open the S7 project in the SIMATIC Manager. 

2. Select "Extras" → "Configure the network" in the menu or click the following button to start 
"NetPro": 
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3. Insert the PG/PC with drag&drop under "Stations" from the catalog into the network 
configuration. 

 
The inserted "PG/PC" station does not yet contain any interfaces. These are configured in 
the next step.  

4.7.2 PG/PC interface configuration 

Introduction 
Under NetPro, configure the interfaces required for commissioning at the PG/PC. These may 
include the following interfaces: 

● Industrial Ethernet for communication via the service interface X127 on the NCU. 

● PROFIBUS 
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Operating sequence for configuring interfaces 
1. Highlight the symbol "PG/PC" under NetPro. 

2. Select "Object properties" <right-click>. 

3. In the displayed "Properties - PG/PC" dialog, select the "Interfaces" tab to configure the 
required interfaces. 

 

Operating sequence for configuring interfaces at the PG/PC 
1. Click "New…" to configure the Ethernet interface first. 

2. In the selection field, select "Industrial Ethernet". 

 
3. Click "OK". 
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4. Select the subnet "Ethernet(1)" and enter the following IP address and subnet mask for 
the PG/PC: 

– IP address 192.168.215.2 

– Subnet mask 255.255.255.224 

 
5. Deactivate the option "Set MAC address/Use ISO protocol" and confirm with "OK". 

6. You can configure additional interfaces via "New". 

7. If you have configured the interfaces, all the configured interfaces are visible under the 
"Interface" tab: 

 
The configured interfaces must be assigned in a device-specific manner to the available 
hardware interfaces on the PG/PC. The sequence steps are laid out in the following section. 
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4.7.3 Assigning interfaces 

Introduction 
The interfaces configured in the previous chapter must now be assigned in a device-specific 
manner to the available hardware interfaces on the PG/PC. 

Operating sequence for assigning an Ethernet interface 
1. Select the "Assign" tab. 

2. Select "Ethernet interface(1)" in the selection field "Configured interfaces". 

3. Select in the "Interface parameter assignments in the PG/PC" selection field, the "TCP/IP 
-> Realtek RTL8139/810xF…" network card installed on the PG/PC. 
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4. Click "Assign" and confirm the subsequent message on processing object properties with 
"OK". The assigned interfaces are deleted from the "Configured interfaces" field and 
these assigned interfaces are displayed in the "Assigned" field. 

 
5. Now assign the remaining configured interfaces (PROFIBUS). 

From those interfaces assigned, one must be marked as "active". 

6. Select "Ethernet interface" in the "Assigned" field and mark the field next to it as "active". 
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7. Click "OK" to end the dialog "Properties - PG/PC". 

In NetPro, the PG/PC interface declared as "active" has a yellow background. 

 
8. Select "Save and compile → Save and check all" and confirm the process with "OK". 

The next described operating sequence explains how to load this hardware configuration to 
the NCU. 
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4.7.4 Loading the HW config to NCU 

Introduction 
The newly created network configuration PG/PC must be introduced to the NCU. 

You have established a connection to the Ethernet interface (X120 or X127) and you now 
load this configuration from the PG/PC to the NCU. 

Operating sequence for loading HW config to the NCU 
1. Change from "NetPro" to "HW Config". 

2. Click the "Download to module" button. 

The target module interactive screen form automatically displays both configured 
communication peers.  

3. Confirm the load into the module with "OK". 

4. Confirm the dialog boxes displayed subsequently with "OK" or "No" for the query 
"…Should the module be started now (restart)?". 

  Note 

Loading the HW config to the NCU is only possible via the Ethernet interface. 
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Commissioning NC-controlled drives 5
 

Overview   
You have the following options when commissioning NC-controlled SINAMICS drives: 

● Guided commissioning 

For "Guided commissioning", you are guided through the configuration / parameterization 
of the units, infeed(s) and drives (SERVO).  

  Note 

We recommend that "Guided commissioning" is used when commissioning a drive 
system for the first time. 

● Manual commissioning 

For "Manual commissioning", you can select the steps of "Guided commissioning" in any 
sequence. You perform additional optional functions that are not part of "Guided 
commissioning" (e.g. PROFIBUS connection). 

  Note 

"Manually commissioning" is recommended for experienced commissioning engineers. 

The closed-loop drive control for SINAMICS S120 is integrated in the NCU. The drives 
connected to the internal virtual PROFIBUS can only be assigned to NC axes.  

The assignment is realized using the axis machine data: 

● MD30110 $MA_CTRLOUT_MODULE_NR (setpoint channel) 

● MD30220 $MA_ENC_MODUL_NR (actual value channel) 

● MD30130 $MA_CTRLOUT_TYPE (type of output setpoint) 

● MD30240 $MA_ENC_TYPE (acquisition of actual value) 

● MD13050 $MN_DRIVE_LOGIC_ADDRESS (axis address) 

The logical I/O addresses ≥ 4100 are determined in this machine data. 

The NC axis assignment is also made using the above-mentioned machine data with the 
modified logical I/O address ≤ 4095.  

  Note 

A drive that can be assigned to an NC axis must be a standard slave according to the 
PROFIdrive profile version 4.1. 
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5.1 Configuration examples 

5.1.1 Example: Configuration of the drive components 

Configuration overview 
The commissioning described in this manual is orientated on the following example 
configuration of the SINAMICS drive line-up.  

● NCU 720.3 PN with: 

– A Single Motor Module for a motor with SMI (Sensor Module Integrated) 

– A Double Motor Module for two motors each with an SMC20 (Sensor Module Cabinet). 

● NX 15.3 with: 

– A Single Motor Module for a motor with two SMC20 units for the encoders. 

● Infeed (Active Line Module) 

 
Figure 5-1 SINAMICS S120 example configuration 

Literature 
Additional DRIVE-CLiQ components of the SINAMICS drive line-up can be found in: 
SINAMICS S120 Equipment Manual for "Control Units and Additional System Components" 
/GH1/ 
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5.1.2 Example: Parallel connection with TM120 

Application: Four motors connected in parallel 
Sample topology:  

 
M1 ... M4 Motor 1 ... motor 4 
 One KTY and three PTC in series are connected for each motor. 
SMx Sensor Module (motor encoder) 
ALM Active Line Module 
DMM Double Motor Module 
SMM Single Motor Module 
TM120 Terminal Module  

The shown topology requires four KTY sensors and four PTC sensors:  

● Each primary section has one KTY sensor (Temp-F) and three series-connected PTC 
sensors (Temp-S). 

Two TM120s are required:  

● A TM120 is interconnected automatically in series between the Motor Module and the 
SMx sensor module. 

● A TM120 is directly inserted into a Line Module: This requires a manual interconnection 
by the commissioning engineer. 
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Measures for the TM120:  

1. TM120 between the Motor Module and the SMx Sensor Module 

This TM120 evaluates four KTYs => sensor types must be selected by Servo-p4610/TM-
p4100. The associated temperature is output by servo-r4620/TM120-r4105. 

2. TM120 directly on the Line Module 

This TM120 evaluates four PTCs => sensor types must be selected by TM-p4100. The 
associated temperature is output by servo-r4105.  

Setting the threshold values in the PTC context:  

– TM120-p4102[x]=251 => evaluation Off 

– TM120-p4102[x]=120 => evaluation On 

Assignment of the TM120 response using fault propagation on the drive => setting of 
the propagation by servo-p0609=BICO:<object number>TM120:4105.0 

Assignment of the alarms to the motor 
The occurring error messages are assigned to the motors as follows:  

● Temperature channel on the TM120 in series connection with motor modules and 
encoders: 

Alarm 207015 <location>drive: Motor temperature sensor warning 

Alarm 207016 <location>drive: Motor temperature sensor fault 

Alarm 235920 <location>TM: Temperature sensor channel 0 error 

In this case, the output message with reference to the motor and to the temperature 
component shows the relevant motor. 

● Temperature channel on the TM120 directly to the line module: 

Alarm 235207 <location>TM: Temperature fault/alarm threshold channel 0 exceeded 

Special feature with PTC: 

TM120-r4105 = -50 temperature is below the nominal response temperature 

TM120-r4105 = 250 temperature is above the nominal response temperature 

In this case, a message is output only with reference to the temperature component. 

The affected motor can be determined from the information concerning the TM120. 
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5.2 Terminal assignment 

5.2.1 NCU 7x0.3 PN terminal assignment 
The SINAMICS device configuration (Page 78) occupies the following terminals on an NCU 
7x0.3 PN: 

● X122 

● X132 

● X142 

The following table lists the terminal assignments for the X122, X132 and X142 terminal 
blocks of the NCU.  

5.2.2 X122 terminal assignment 
 
Terminal Signal name Function   Pre-

assignment 
X122.1 DI 0 Input ON/OFF1 infeed (if one infeed with a DRIVE-

CLiQ connection is operated at the NCU) 
x 

X122.2 DI 1 Input 2nd operating condition OFF3 drives 
"OFF3 rapid stop" 
Braking with a configurable OFF3 ramp (p1135, 
p1136, p1137); thereafter, pulse suppression and 
switching on inhibited. The drive stops controlled. The 
braking response can be set separately for each 
SERVO. 

x 

X122.3 DI 2 Selection safe standstill group 1 
SH/SBC - Group 1 SINAMICS Safety Integrated (SH = 
p9601 release) 

--- 

X122.4 DI 3 Selection safe standstill group 2 
SH/SBC - Group 2 SINAMICS Safety Integrated (SH = 
p9601 release) 

--- 

X122.5 DI16 Freely available --- 
X122.6 DI17 Freely available --- 
X122.7 Ground for terminals 1...6  
X122.8 Ground for terminals 9, 10, 12, 13  
X122.9 DI/DO 8 Status safe standstill group 1 

SH/SBC - Group 1 
SINAMICS Safety Integrated 

--- 

X122.10 DI/DO 9 Status safe standstill group 2 
SH/SBC - Group 2  
SINAMICS Safety Integrated 

--- 

X122.11 Ground for terminals 9, 10, 12, 13 --- 
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Terminal Signal name Function   Pre-
assignment 

X122.12 DI/DO 10 Input, external zero mark 
Bero 1 – "equivalent zero mark" 

--- 

Input probe 1 - central measurement  
(Check that MD13210 = 0) 

x X122.13 DI/DO 11 

Input probe 1 - distributed measurement  
(Check that MD13210 = 1) 

--- 

X122.14 Ground for terminals 9, 10, 12, 13  

In the "pre-assignment" column, the signals for which the associated SINAMICS parameters are set 
when configuring a SINAMICS device are marked with "x". 

5.2.3 X132 terminal assignment 
 
Terminal Signal name Function   Pre-

assignment 
X132.1 DI 4 Freely available --- 
X132.2 DI 5 Freely available --- 
X132.3 DI 6 Freely available --- 
X132.4 DI 7 Infeed line contactor feedback signal (if one infeed is 

operated with a DRIVE-CLiQ connection at the NCU) 
--- 

X132.5 DI20 Freely available --- 
X132.6 DI21 Freely available --- 
X132.7 Ground for terminals 1...6  
X132.8 Ground for terminals 9, 10, 12, 13  

Output: Infeed operation (if one infeed is operated with 
a DRIVE-CLiQ connection at the NCU) 

x X132.9 DI/DO 12 

Input 2nd operating condition OFF2 drives --- 
Output: Status, infeed ready to start (if one infeed is 
operated at the NCU with a DRIVE-CLiQ connection) 

x 

Input 2nd operating condition OFF2 drives --- 
Input, external zero mark 2 --- 
Input probe 2 - central measurement  --- 

X132.10 DI/DO 13 

Input probe 2 - distributed measurement  --- 
X132.11 Ground for terminals 9, 10, 12, 13  

Input 2nd operating condition OFF2 drives --- 
Input, external zero mark 3 --- 
Input probe 2 - central measurement --- 
Input probe 2 - distributed measurement --- 

X132.12 DI/DO 14 

Infeed, control line contactor --- 
X132.13 DI/DO 15 Input 2nd operating condition OFF2 drives --- 
  Input, external zero mark 4 --- 
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Terminal Signal name Function   Pre-
assignment 

  Input probe 2 - central measurement --- 
  Input probe 2 - distributed measurement --- 
X132.14 Ground for terminals 9, 10, 12, 13  

In the "pre-assigned" column, the signals for which the associated SINAMICS parameters are set 
when configuring a SINAMICS device are marked with "x". 

5.2.4 X142 terminal assignment 
 
Terminal Signal name Function   Pre-assignment 
X142.1 --- reserved --- 
X142.2 --- reserved --- 
X142.3 DI0 NC input $A_IN[1] fixed 
X142.4 DI1 NC input $A_IN[2] fixed 
X142.5 Ground for terminals X142.3, 4, 6, 7, 9, 10, 12, 13 --- 
X142.6 DI2 NC input  $A_IN[3] fixed 
X142.7 DI3 NC input $A_IN[4] fixed 
X142.8 Power supply --- 
X142.9 DO4 NC output  $A_OUT[1] fixed 
X142.10 DO5 NC output $A_OUT[2] fixed 
X142.11 Ground for terminals X142.3, 4, 6, 7, 9, 10, 12, 13 --- 
X142.12 DO6 NC output  $A_OUT[3] fixed 
X142.13 DO7 NC output $A_OUT[4] fixed 
X142.14 Ground for terminals X142.3, 4, 6, 7, 9, 10, 12, 13 --- 

5.2.5 NX 1x.3 terminal assignment 
The table lists the assignments of the terminals on an NX 1x.3 for the X122 terminal strip.  

The SINAMICS device configuration sets the following preassignment:   

 
Number Function Signal Pre-

assignment 
Input ON/OFF1 infeed (if one infeed with a DRIVE-CLiQ 
connection is operated at the NX) 

x X122.1 DI 0 

Input infeed operation - "infeed ready signal" (if no infeed 
with DRIVE-CLiQ connection is operated at the NX) 

x 

Input 2nd operating condition OFF3 drives x X122.2 DI 1 
Freely available  -- 



Commissioning NC-controlled drives  
5.2 Terminal assignment 

 CNC Commissioning: NC, PLC, Drive 
74 Commissioning Manual, 03/2013, 6FC5397-2AP40-3BA1 

Number Function Signal Pre-
assignment 

X122.3 DI 2 Selection safe standstill group 1 
SH/SBC - Group 1 SINAMICS Safety Integrated (SH = 
p9601 release) 

-- 

X122.4 DI 3 Selection safe standstill group 2 
SH/SBC - Group 2 SINAMICS Safety Integrated (SH = 
p9601 release) 

-- 

X122.5 DI 16 Freely available -- 
X122.6 DI 17 Freely available -- 
X122.7 Reference potential for terminals 1…6  
X122.8 Mass   
X122.9 DI/DO 8 Status safe standstill group 1 

SH/SBC - Group 1  
SINAMICS Safety Integrated 

- 

X122.10 DI/DO 9 Status safe standstill group 2 
SH/SBC - Group 2  
SINAMICS Safety Integrated 

-- 

X122.11 Mass   
X122.12 DI/DO 10 Input, external zero mark 

BERO 1 – "equivalent zero mark" 
-- 

Input, external zero mark 2/1 -- X122.13 DI/DO 11 
Input 2nd operating condition OFF2 drives -- 

X122.14 Mass   

Those signals for which the associated SINAMICS parameters are set for the SINAMICS device 
configuration are marked with "x" in the "Pre-assigned" column. 

See also 
Automatic device configuration (Page 78) 
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5.2.6 Support for the terminal assignment 

Support for terminal assignment  
The following overview shows the terminal assignment of those drive units (NCU, NX) 
involved on the SINAMICS drive line-up, in the commissioning tool V7.7. 

"Commissioning" > "Drive system" > "Drive units" > "Inputs/outputs" menu:  

 
Figure 5-2 Interconnections of the digital inputs/outputs 
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5.3 Guided commissioning of SINAMICS drives 

5.3.1 Triggering a reset (warm restart) for NCK and drive system 

Introduction 
After booting the system you will find yourself in the "Machine" operating area: 

 
In the previous step before loading the project to the PLC  (Page 55), this was brought into 
the STOP state. The NCK interprets this STOP state, with a corresponding alarm response, 
as failure of the PLC. 

Alarm response 
A "Reset (po)" (warm restart) is required for the PLC-NCK synchronization. This can cause 
alarm responses. The output of all alarms in form list can be found in the "Diagnostics" → 
"Alarms" operating area. Additional support for the diagnosis of the drive system is described 
in Section Drive system diagnostics (Page 123).  
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Operating sequence for initiating an NCK reset 
1. Press the <MENU SELECT> key and select the "Commissioning" operating area. 

 
The commissioning operating area is displayed without password: 

 
2. Press "Password...". 

3. Press "Set password". 

4. Enter the password for the "Manufacturer" access level. 
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5. Confirm with "OK". 

 
6. Press the "Reset (po)" softkey. 

7. Acknowledge the "Do you want to trigger a reset (warm restart) for the NCK and the 
entire drive system (all drive units)?" prompt with the "Yes" softkey. 

The PLC goes to RUN mode. Guided commissioning of the SINAMICS drives is then started. 
Continue with the steps described in the following chapter. 

5.3.2 Automatic device configuration 

Automatic device configuration   
Procedure: 

You have set the password for manufacturer and initiated a reset (warm restart). The 
following alarm is initiated:  

"120402 ... SINAMICS initial commissioning required! ". 
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1. Once the complete drive system has powered-up, the following dialog for the automatic 
device configuration is displayed: 

 
2. Press "OK". 

If you press "Cancel", then you can manually perform the commissioning (see Chapter 
Manual commissioning of SINAMICS drives (Page 101)). 

3. The individual steps for automatic device configuration are displayed one after the other 
in the following dialog box: 
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4. The following dialog box is displayed after the device has been configured: 

 
5. Press "Yes". 

The following notes are displayed during the NCK power on reset:   
– "Wait for communication with the NC" 
– "Wait for communication to the drive" 
– "Wait until communication is restored" 
After the automatic device configuration, an automatic check is made which infeeds and 
drives (SERVO) still need to be parameterized/commissioned. Commissioning guides you 
using the following dialog box to the individual drive objects that have still not been 
commissioned. 

 
6. Press the "Infeeds" softkey to continue with the parameterization of the infeed in the 

following section. 
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5.3.3 Parameterization of infeed 

Operating sequence 
The system detects that the infeed has not been commissioned and that a commissioning is 
required: 

1. Select the "Commissioning" > "Drive system" > "Infeeds" menu. 

 
2. The commissioning is performed with the "Change" vertical softkey. 

The wizard guides you step-by-step through the commissioning when you press the "Next 
step" softkey.  
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3. Select the net filter: In this example, a Broadband Line Filter (16 kW) is available. 

 
4. Accept the default setting (see also: Check the power system data of the infeed 

(Page 147)). 
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5. Select the terminal wiring. 

 
Check the configuration in the summary. You have now completed configuring the infeed. 
Optionally, you can save the configuration data in a text file.  

6. Press the "Finish >" softkey. 

 
7. Press "Yes" to save the data to the non-volatile memory. 
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8. After commissioning the infeed, an automatic check is made for which drives (SERVO) 
still need to be commissioned. The following dialog appears: 

 
9. Press the "OK" softkey to continue with the steps to commission the drives (see also: 

Parameterization of the drives (Page 85)). 

The overview screen of the infeed is displayed if "Cancel" was pressed: 

 
Figure 5-3 Infeeds\overview (page 1) 
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Figure 5-4 Infeeds\overview (page 2) 

 

 Note 

The "Guided commissioning" ends here. Using " Manual commissioning (Page 101) " you 
can now perform additional commissioning steps. 

 

5.3.4 Parameterization of the drives 

Introduction 
The following components are parameterize/configured with the drive wizard: 

● Motor 

● encoder 

● Interface signals 

Parameterizing/configuring 
Guided commissioning navigates you through the commissioning of SINAMICS drives with 
motors without SMI (Sensor Module Integrated). 
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For motors without SMI, when parameterizing/configuring, a distinction is made between the 
following motor types: 

● Catalog motors (standard motors, listed with associated motor data) (Page 86) 

● Third-party motors (Page 93) 

  Note 

Motors with SMI (DRIVE-CLiQ) are automatically configured by the drive unit during the 
device configuration with a drive data set (DDS), but only with the motor measuring 
system; i.e. motors with SMI only have to be configured with the drive wizard when more 
than one drive/motor data set (DDS/MDS) or a second (direct) measuring system is 
required. 

 

5.3.4.1 Commissioning of listed motor and encoder via SMC 

Operating sequence   
In our example a power section is to be configured with a listed motor and encoder. You are 
in the "Commissioning" → "Drive system" → "Drives" menu:  

1. The system detects that the drive object has not been commissioned and that an initial 
commissioning is required: 
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2. Press the "Change" vertical softkey. 

 
3. The motor module type is detected and output. Activate the available function modules. 

 
4. Select the "Select standard motor from list" option. 

5. Select the motor with the "Cursor up / Cursor down" keys. 
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6. Press "Next step >". 

 
7. You can select brake control in the "Configuration - motor holding brake" dialog. If a 

connected brake is detected during the unit configuration, the system will automatically 
activate the brake control and will by default display "Brake control according to 
procedural control" here. 

8. Press "Next step >". 

 
An identification of the selected encoders is triggered (Encoder 1). 
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The drive unit can identify encoders with EnDat protocol. These encoders are selected in 
the encoder list in the follow-up dialog boxes ("Configuration - Encoder 1" menu).  

 
The entry "No encoder" is selected in the encoder list for encoders that the drive unit 
cannot identify. The connected encoder must be configured. 

 
9. Select the motor encoder from the list: Select the encoder with the "Cursor up / Cursor 

down" keys. Alternatively, the encoder system can be parameterized manually using the 
"Enter data" softkey. 
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10. Press "Enter data". 

 
Check the encoder data of the connected encoder and confirm with "OK".  

– Encoder type 

– Incremental tracks 

– Zero marks 

– Synchronization 

11. Press "Next step >". 

 
12. Set the number of required drive data sets (DDS). The default setting is one drive data 

set. 
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13. You can change the settings for the control mode and the PROFIBUS telegram type. 

The control mode and the PROFIBUS telegram are generally correctly pre-assigned by 
the drive wizards.   

14. Press "Next step >". 

 
15. You can select the 2nd operating condition Input 2nd OFF2 (Page 71) (external input for 

pulse cancellation) 

16. Press "Next step >". 

 
17. The configuration of a drive with listed motor has completed. You can check the 

configuration in the summary. 
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18. Press the "Finish >" softkey. 

 
19. Confirm the query with "Yes". 

20. The next section describes how you can configure a drive with a third-party motor and a 
second encoder. 
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5.3.4.2 Commissioning a third-party motor with encoder via SMC 

Operating sequence   
In our example a power section is to be configured with third-party motor and encoder. You 
are in the "Commissioning" → "Drive system" → "Drives" menu:  

1. The system detects that the drive object has not been commissioned and that an initial 
commissioning is required: 

 
2. Press the "Change" vertical softkey. 

The power section (motor module) will be identified:  
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3. Press "Next step >". 

 
4. Select the "Enter motor data" option to select the motor type. 

5. Press "Next step >" to select the type of the brake control in the next dialog. 

 
If a connected brake is detected during the unit configuration, the system will 
automatically activate the brake control and displays "Brake control according to 
procedural control". 
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6. Press "Next step >". 

 
7. Enter the data for the connected motor. 

8. If you have activated the "Replacement circuit diagram data" option, press "Next step >" 
to open the following dialog: 

 
9. You can enter additional motor data here. 



Commissioning NC-controlled drives  
5.3 Guided commissioning of SINAMICS drives 

 CNC Commissioning: NC, PLC, Drive 
96 Commissioning Manual, 03/2013, 6FC5397-2AP40-3BA1 

10. Press "Next step >". 

 
11. Press "Next step >". 

 
If more than one encoder has been selected, press "Next step >" successively to 
parameterize each individual encoder:  
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12. Press "Next step >". 

An identification of the selected encoders is triggered (Encoder 1). 

The drive unit can identify encoders with EnDat protocol. Select other encoders in the 
encoder list:  

 
13. Press the "Input data" softkey to check or modify the encoder data. 
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14. Confirm with "OK" and press "Next step >" to continue the commissioning. 

 
The control mode and the PROFIBUS telegram are generally correctly pre-assigned by 
the drive wizards. 

15. Set the number of required drive data sets (DDS). The default setting: 1 DDS can be 
accepted in most cases. 

16. Press "Next step >". 

 
You can select the 2nd operating condition Input 2nd OFF2 (Page 71) (external input for 
pulse cancellation) 
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17. Press "Next step >". 

 
The configuration of the drive (SERVO) with third-party motor is completed. You can 
check the configuration in the summary. 

18. Press the "Finish >" softkey. 

 
19. Confirm the query with "Yes". 

If the system detects additional drive objects that have not yet been commissioned, you will 
be prompted to commission the next SERVO. Otherwise, the initial commissioning is 
complete. 
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5.3.5 First commissioning of SINAMICS drive ended 

Initial commissioning of the drives completed 
The initial commissioning of the SINAMICS S120 drives is completed. 

The unit configuration and parameterization has been completed successfully: 

● All upper LEDs of the drives (SERVO) illuminate green. 

● The lower LEDs of the drives (SERVO) always continue to light yellow. 

Continue with the steps for commissioning the NC.  

See also 
Communication between the NC and the drive (Page 155) 
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5.4 Manual commissioning of SINAMICS drives 

5.4.1 Introduction to commissioning of SINAMICS drives 

Machine configuration 
 

 Note 

"Manually commissioning" is recommended for experienced commissioning engineers. 
 

Procedure: 

1. Press the <MENU SELECT> key. 

 
2. Select the "Commissioning" operating area. 
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3. Press the "Drive system" softkey. 

 

See also 
The following functions for commissioning the SINAMICS drives can be performed manually: 

● Restore the factory settings (Page 102) 

● Update the component firmware (Page 104) 

● Configure the infeed and drives 

● Check and configure the PROFIBUS connection (Page 106) 

5.4.2 Activate the factory settings 

Introduction 
After the commissioning, the "Factory setting >" function can be used reset the drive system 
to the factory settings. 

 

NOTICE  
Check the voltage 

Before restoring the factory settings, ensure that the EP terminal (Enable Pulses) of the 
infeed (booksize: X21, chassis: X41) is de-energized. 
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Loading the factory settings   
Procedure: 

1. You are in the "Commissioning" > "Drive system" operating area. 

 
2. Press the "Factory settings >" softkey. 

 
3. Press the "Drive system" softkey for this example to load the factory settings for all drive 

units used in the system (the NCU and NX module). 

You must explicitly confirm another prompt with "OK" or "Cancel". 
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4. Switch the system (de-energized drive system) off and on again. Wait until 
communication has been established again with the NC. 

 
5. A message appears that an initial commissioning is required (Alarm 120402). 

You have the following options in this dialog: 

– If you press "OK", the "Guided commissioning" (Page 76) of the SINAMICS drives 
starts. 

– Press "Cancel" to continue the "Manual commissioning". 

5.4.3 Firmware update of the drive components 

Precondition 
All NCU/NX components are connected via DRIVE-CLiQ.  

 

 Note 
Automatic firmware update  

As of SINAMICS V2.5, an automatic firmware update is undertaken when powering up the 
drive system if required.  

The correct firmware update of the SINAMICS components is performed ONLY if ALL were 
inserted in the switched-off state. The subsequent insertion of components may ONLY be 
performed in the switched-off state. 
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Loading firmware for the entire drive system  
Procedure:  

1. Switch on the system. 

During run-up, it will be detected that an older firmware version is present. This causes 
the update to start automatically and the firmware is loaded from the CompactFlash card 
to all DRIVE-CLiQ components of the drive system (NCU and NX). 

  Note 

Depending on the configuration of the SINAMICS drive line-up, a complete update of the 
component firmware takes approximately 10 minutes. The firmware component currently 
being updated is indicated with a flashing LED. 

2. While the firmware update is running, a progress bar informs you about the current 
process. In this case, the following messages are output: 

Notice! 

The process should not be interrupted! Please wait until the automatic firmware update 
completes! 

A firmware update is performed for the following drive units of the DRIVE-CLiQ 
components:  

CU_I_3.3:1           ... 39% 

CU_NX_3.15:1     ... 50% 

3. The following messages are output when the firmware update completes: 

Firmware update of the DRIVE-CLiQ components completed. 

Notice! 

Switch the control system and the entire drive system (all hardware components) off and 
then on again to activate the firmware.  

Then commissioning can be continued. 

CU_I_3.3:1           ... 100% 

CU_NX_3.15:1     ... 100% 

4. Follow this prompt. You can then continue the commissioning of the drive components 
(infeed, motor modules, encoders). 

  Note 
Loading firmware for individual components  

If only certain components of the drive system have an older firmware version, the update 
also starts automatically and needs correspondingly less time.  
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5.4.4 Automatic device configuration 

Introduction 
The following unit configuration is performed during the initial commissioning of the drive 
units:  

● Transfer of the DRIVE-CLiQ topology to the drive unit. 

With the transfer of the topology, all components connected on the DRIVE-CLiQ are 
detected and the drive-internal data traffic is initialized. 

● Drive-object assignment for PROFIBUS connection. 

The PROFIBUS connection via the relevant telegrams has been specified with the 
configuration in the HW Config. 

Operating sequence 
The drive unit is in the initial commissioning state. 

1. Press the "Drive units" softkey in the "Commissioning" > "Drive system" menu. 

 
You are reminded that the drive unit is in the initial commissioning state and that a unit 
configuration must be performed for the drive system. 
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2. Confirm with "OK". 

During the unit configuration, a succession of messages containing information on the 
respective configuration of the individual drive components is displayed. 

Depending on the size of the drive system, this can take several minutes.  

Before the configuration is completed, you must confirm the following prompt: 

 
3. Press "Yes" to perform an NCK power on reset (warm restart). 

 
The unit configuration for the drive units and drive components of the NCU has been 
completed.  
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4. Press "OK". 

This means that you continue commissioning in the actual dialog box "Drive system" → 
"Drive units" → "Configuration". The associated components of the selected drive unit are 
displayed:  

 
5. If necessary, check and correct the settings in the "PROFIBUS" dialog. 
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6. Press "Drive unit +". 

If you have selected the NX, then the components belonging to the NX are displayed. 

 
If necessary, you can correct or change the settings in the "PROFIBUS" dialog.  

7. Press "PROFIBUS" → "Change>". 
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8. Press "Cancel" to exit the dialog. 

9. Press the menu back key. 

 
  

5.4.5 Commissioning using a drive wizard 

Introduction 
Perform the drive configuration with a drive wizard. The following drive components are to be 
configured: 

● Active Line Module (infeed) 

● Motor Module, motor and encoders (drives) 
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Operating sequence for drive configuration  
To start the drive configuration, select the "Commission" → "Drive system" operating area:  

 
Procedure: 

1. Press the corresponding softkey for the drive object to be configured. 

– "Infeeds" 

– "Drives" for the corresponding drive object (SERVO) 

Configuration is performed in the following sequence: 

2. Select the component with the "Infeed+/Infeed-" or "Drive+/Drive-" vertical softkey. 

3. Press the "Change" vertical softkey and follow the drive wizard with the "Next step >" 
horizontal softkey. 

4. Parameterize the appropriate configuration in the following dialogs. 

5. Check the network data of the infeed with the "Network data (Page 147)" softkey. 

See also 
The individual dialogs are described at:  

● "Parameterization of infeed (Page 81)" 

● "Parameterization of the drives (Page 85)" 
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5.5 Configuring data sets 

Precondition 
 

 Note 

The particular drives must have been already commissioned. 
 

Data sets 
The data sets are configured in the "Commissioning" → Drive system" → "Drives" → "Data 
sets" operating area. The following prompts lead you through the sequences:  

● "Add data set" 

● "Remove data set" if an additional data set has already been created 

● "Modify data set" 

Number of configurable data sets:     

● Motor data set → MDS0...3 (max. 4) 

● Drive data set → DDS0...31 (max. 8 per MDS) 

● Encoder data sets → EDS0...2 (max. 3) 

References 
You can find additional information in:  

SINUMERIK 840D sl/828D Basic Functions Function Manual, various NC/PLC interface 
signals and functions (A2) 
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5.5.1 Adding a data set 

Adding a data set operating sequence   
The default factory setting specifies an MDS0 motor data set with a DDS0 drive data set and 
an EDS0 encoder data set:  

 
1. Press "Add data set". In the example, the maximum number of four MDSes are created. 
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2. Press "Next step >". 

In the first step, the DDS1 to DDS7 drive data sets are created in the MDS0.  

 
3. Press "Next step >". The MDS1 motor data set is created. 
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4. Press "Next step >". The MDS2 motor data set is created. 

 
5. Press "Next step >". The MDS3 motor data set is created. 
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6. Press "Next step >". You need to create a complete MDS as shown in the following 
diagram, or as an option, enter the number of DDS for the MDSx: 

 
7. Press "Next step >" to check in the summary the changes to be performed. 
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8. Press "Finish >" to accept the changes. 

 
9. Confirm with "OK" to save the data in non-volatile memory. 

The saving/writing of the parameters can take several minutes. 

10. The "Drives" → "Overview" dialog of the drive object is displayed. The "Select MDS >" 
softkey is now available. Press "Select MDS...". 

 
In the direct selection, select the motor data set, e.g. in this case MDS1.   
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11. Press "OK" to display the new motor data set for the drive object. 

 
The drive is now operational. 

5.5.2 Modify data set 

Precondition 
If more than one encoder is assigned to the drive object (SERVO), additional encoder data 
sets (EDS0 ... 2) will be created.  
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Modify data set  
To change the assignment of these encoder data sets for the associated encoder, select the 
"Modify data sets" softkey:  

 
This activates the edit function in order to subsequently modify the assignment of EDSes to 
the encoders:  
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5.5.3 Remove data set 

Precondition 
To remove data sets, the following conditions must be met:  

● Number of DDS > 1 in the MDS ⇒ DDSes can be removed. 

● Number of MDS > 1 ⇒ MDSes can be removed. 

Operating sequence to remove a data set   
1. Select "Remove data set": 

 
In the first column, select the MDS to be removed by marking the row with a check mark. 
Several data sets can also be selected. 
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2. Press "Next step >". 

 
As an option, you can remove the remaining DDSes from MDS2 by entering the number 
of DDS drive data sets that should remain in the MDS: By entering 3 DDS in MDS, five 
DDSes are removed.  

3. Press "Next step >". 

 
"Cancel" terminates this process and the data set overview with MDS0 ... MDS3 is 
displayed. 
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4. Press "Finish >" to accept the changes. 

The data is written to the parameters. The results are then displayed: 

 
When you exit this dialog, press "Yes" to confirm the prompt to save the data to the non-
volatile memory. 
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5.6 Drive system diagnostics 

Operating sequence   
1. To check warnings and faults of the drive, select the "Diagnostics" → "Drive system" 

operating area: 

 
2. Select the relevant drive component with the cursor in the overview of the drive states. 

3. Press the "Details" softkey: 
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4. Press "Warnings". The warnings for this drive component are listed.  

 
5. Press "Faults": No faults are present for this drive component.  

 

See also 
Adding components (Page 141) 

Check topology (Page 132) 
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Warnings/faults 
SINAMICS alarms can be the warning (A) or fault (F) type. 

● Pending warnings are indicated by parameter r2122 of the relevant drive components. 

● The number of warnings that have occurred after the last reset is available in parameter 
p2111 of the drive components. 

p2111 = 0 This results in the deletion of all existing warnings of this component and 
updates the current warnings still pending. This parameter is reset to zero at POWER 
ON. 

● The parameter r0945 shows the numbers of faults that have occurred. 

● To activate the fault and warning buffer output for SINAMICS, set 
MD13150 $MN_SINAMICS_ALARM_MASK to the hexadecimal value "D0D". This 
automatically outputs the pending warnings/faults of the SINAMICS S120 in the message 
line. 
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5.7 Modular machine 

5.7.1 What does "modular machine" mean? 

Modular machine   
The modular machine concept is based on a maximum target topology created offline. The 
maximum design of a particular machine type is referred to as the maximum configuration in 
which all the machine components that may be used are pre-configured in the target 
topology. By deactivating/deleting drive objects (p0105 = 2), sections of the maximum 
configuration can be removed. 

If a component fails, the sub-topology can also be used to allow a machine to continue 
running until the spare part is available. In this case, however, no BICO source must be 
interconnected from this drive object to other drive objects.  

 

NOTICE  
Data backup 

To prevent data loss, save the drive data in a commissioning archive (Page 319), before 
you make any changes! 

 

Drive unit - Configuration   
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The "Commissioning" → "Drive system" → "Drive unit" operating area provides the following 
functions under "Configuration":  

● "Configuration" > "Change >" (Page 130) 

– Change the name of the drive object 

– Change the name of the component 

– Change the comparison level 

● "Configuration" > "Sort >": (Page 130) 

● "Configuration" → "Display options >": 
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Drive unit - topology   

 
The "Commissioning" → "Drive system" → "Drive unit" operating area provides the following 
functions under "Topology":  

● "Topology" → "Change >" 

– Delete a drive object 

– Delete the component 

– Enable/disable drive objects 

– Drive object: Change name/number 

– Component: Change name/number 

● "Topology" > "Add component >" (Page 141) 
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● "Topology" → "Display options >": 

 
Example: Select filter "off" to also display the components that are not connected via 
DRIVE-CLiQ:  

 

  Note 

No initial commissioning is required after changing the topology. 
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5.7.2 Modify configuration 

Drive unit - Configuration "Change >"   
Procedure: 

1. Press the "Change > " softkey to change the configuration. 

"Cancel" can be used backup the drive data if it does not yet exist.  

 
2. If a data backup is available, confirm with "OK". 

3. Navigate with the arrow keys to the drive object / component that is to be changed. 
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4. Press the "INSERT" key to enter the new designation. 

 

Drive unit - Configuration "Sort >"   
Procedure: 

1. Press the "Sort >" softkey to open the display of the sort criteria. 
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2. Select one of the following sort criteria for the display from: 

– Drive object: The display is sorted according to the drive object number. 

– Wiring: The display is sorted according to wiring of the drive components in the drive 
system. 

– Component number: The display is sorted according to the component number. 

– Axis number: The display is sorted according to the axis number. 

5.7.3 Check topology 

Comparing topologies   
Once you have parameterized the drive components, you can check the topology:  

1. Select "Commissioning" → "Drive system" → "Drive unit" → "Topology" in the operating 
area. 

2. Set the actual/reference topology comparison for "Display options". 

The topology of individual drive components is displayed:  

 
3. This means you are supported during the check whether the displayed reference 

topology matches the actual topology of the system. 

  Note 

You will need the component numbers in order to configure direct measuring systems 
manually. 
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See also 
Drive system diagnostics (Page 123) 

5.7.4 Changing topology 

Drive unit - Topology "Change >"  
Procedure: 

1. Press the "Change > " softkey to change the topology. 

"Cancel" can be used to backup the drive data if it does not yet exist.  

 
2. If a data backup is available, confirm with "OK". 
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3. Navigate with the arrow keys to the drive object / component that is to be changed. 

4. Press the "INSERT" key to enter the new designation. 

In the example, the drive object is changed from "number "3" to number "30". 

 
 

  Note 
Effect  

The change of the name and number is applied to the data in the reference and actual 
topologies of the drive software. Changing the comparison level affects the topology 
comparison in the drive software. 
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5.7.5 Activating or deactivating a drive object 

Activating/deactivating drive objects   
Operating sequence:  
1. Select with the arrow keys a drive object. 

2. Press the "Activate/deactivate drive object" softkey 

 
3. Follow the instructions in the information text. 
4. Once successfully deactivated, the drive object and the associated components are 

grayed out. 

 
5. If you want to reactivate the drive object, press the "Activate/deactivate drive object" 

softkey and follow the instructions in the information text.  
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Example series commissioning 
When commissioning several machines (series) of the same type, a drive object that is not 
present is marked with p0105 = 0. This creates a commissioning archive that is transferred 
to the next machine.  

To avoid triggering the alarm 201416, the serial number of this component must be deleted 
and the p0105 = 2 parameter of this component must be set to "Deactivate drive object and 
not present". 

 

 Note 

General conditions for deactivating:  
 If a component is deactivated, only the component with the correct serial number or none 

may be inserted. 
 If a component with a different serial number is inserted, this is by definition a different 

component. If no other component remains, it must certainly be an excess component. 
This component is marked as an additional component and alarm 201416 triggered. 
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5.7.6 Deleting a drive object 

Deleting a drive object   
Procedure: 

1. Navigate with the arrow keys to the drive object that is to be deleted. 

2. Press the "Delete drive" softkey. 

A security prompt follows to delete the drive object. 

 
3. If a data backup is available, confirm with "OK". 

The drive object is deleted from the reference topology.  
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4. To see the change in the topology, the "Actual/reference topology comparison" display 
options must be set: 

 
Result: The module can now be removed. 
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5.7.7 Delete the component 

Delete the component   
Procedure: 

1. You are in the "Topology" dialog and have selected the "Change" mode: 

 
2. Navigate with the arrow keys to the component to be deleted. 

 
If you select a component, the "Delete component" softkey is active.  
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3. Press the "Delete component" softkey, in this example: Sensor SM_14 (sin/cos). 

A security prompt follows to delete the component. 

 
4. If you are sure, confirm with "OK". The component is deleted from the reference topology. 

 
If the component is not yet available in the actual topology, i.e. still connected, an alarm is 
output and the component highlighted in red. To see the change in the topology, the 
"Actual/reference topology comparison" display options must be set. 

5. Remove the module. 
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5.7.8 Adding components 

Adding components 
If you connect a new component (e.g. SMC20) via DRIVE-CLiQ to the drive system, 
SINAMICS detects the change in the actual topology and displays the actual/reference 
topology difference. The new component must then be configured and assigned to a drive 
object (Motor Module) using the drive wizard. 

Operating sequence: 

1. Select "Commissioning" → "Drive system" → "Drive unit" → "Topology" in the operating 
area. In the "Topology" dialog, start at an actual state. 

The component has not been connected yet. Connect a new DRIVE-CLiQ component 
(e.g. SMC20) to a Motor Module. 

  Note 

Only plug in (connect) components when the drive unit is switched off. 

 
SINAMICS recognizes the change in the actual topology and displays the 
actual/reference topology difference:  

– GRAY: Desired state, drive object/component not plugged in and/or deactivated in the 
drive system. Use the cursor keys to select the required line. The state is indicated in 
the bottom part of the window. 

– RED: Actual state, drive object/component present in the actual topology. 

New components that have not yet been commissioned have a component 
number > "200"; in this example, the number "210". 
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2. Navigate with the arrow keys to the component to be deleted. Press "Add component >". 

 
The system recognizes the new component and outputs a message. 

3. Press "OK" as confirmation to configure and accept this component. 

Determining the device configuration may take several minutes. Depending on the device 
configuration, you will be prompted to perform further actions or to cancel:  

To match the cyclic data traffic between the NCK and SINAMICS to the configuration of 
the SINAMICS, an NCK and drive reset should be performed.  

Should an NCK and drive system reset be performed? 
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4. Press "OK" to confirm that an NCK and drive system reset should be performed. The 
following message will then appear: 

 
The unit configuration is finished. The component has been accepted. 

5. Press "OK" to include the component in the topology again although it is not yet assigned 
to any drive: 

– Select "Drive unit" to open the drive wizard. Select the drive and assign the new 
encoder in the encoder configuration (Page 85) to the drive. 

– Press "OK" to assign this component to the drive later. 

5.7.9 Replacing SINAMICS S120 components 

Preconditions 
There are two procedures for replacing components:  

1. Replacing an existing Motor Module with a more powerful Motor Module. 

2. Replacing SMI or SMx motor components. 

The following preconditions are satisfied: 

● The motor modules are of the same type. 

● The serial number is different: ⇒ No further configuration is needed. 

● The order number (MLFB) differs, for example, 9 A instead of 5 A. 
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Replacing an existing Motor Module with a more powerful Motor Module 
Operating sequence:  

 

 Note 
Do not make a permanent change in the drive system. 

Before you replace the DRIVE-CLiQ component, change the comparison level. 
 

1. Select the "Commissioning" → "Machine data" → "Control unit MD" dialog. 

2. Change parameters p9907 (component number) and p9908 (comparison level of a 
component). 

3. Save the changed drive data before switching off (power OFF). 

4. Switch off the drive system: Power OFF. 

5. Replace the component with a more powerful Motor Module. 

6. Switch on the drive system: Power ON. 

7. No further configuration is required because the Motor Module has been replaced in the 
switched-off status of the system. The new configuration and topology data is exported 
and the display refreshed. 

Permanently replacing a Motor Module 
Operating sequence:  

1. Select the "Commissioning" → "Machine data" → "Control unit MD" dialog. 

2. Set the "Device configuration" parameter to control unit: p0009 = 1 

3. Transfer the new component: Control Unit: p9905 = 2 

4. Wait until p9905 = 0 is automatically set again. 

5. Set the "Device configuration" parameter to control unit: p0009 = 0 

6. Save "All": set p977 = 1. 

7. Ensure that you wait until p977 is automatically set to "0" again. This can take as long as 
40 seconds. 

The replacement of a single SINAMICS component is automatically acknowledged by the 
system. 
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Replacing SMI or SMx motor components 
 

 Note 

The new SMI/SMx motor component must not yet be inserted! 
 

Operating sequence:  

1. You have removed the previous SMI or SMx motor component. 

This motor component is missing in the actual topology. SINAMICS indicates this in the 
form of a topology error alarm.  

The "Commissioning" → "Drive system" → "Drive units" → "Topology" dialog shows the 
previous motor component to be replaced "gray", i.e. present only in the reference 
topology. 

2. In the "Commissioning" → "Drive system" → "Drive units" → "Topology" → "Change..." 
dialog, remove the SMI/SMx motor component awaiting replacement from the reference 
topology using the "Delete component" (Page 139) dialog. 

  Note 

Save the changed drive data before switching off (power OFF). 

3. Switch the drive system off and on (power OFF→ON). 

4. In the "Commissioning" → "Drive system" → "Drive units" → "Topology" dialog, check 
whether the SMI/SMx motor component has been removed from the reference topology: 

– The alarm topology error is no longer pending. 

– The "Commissioning" → "Drive system" → "Drive units" → "Topology" dialog no longer 
shows any differences. 

5. Switch off the drive system. 

6. Plug in the new SMI/SMx motor component. 

7. Switch on the drive system. 

8. Add the new SMI/SMx motor component using the "Commissioning" → "Drive system" → 
"Drive units" → "Topology" → "Add component" (Page 141) dialog to the reference 
topology. 

9. Assign the added SMI/SMx motor component via the "Commissioning" → "Drive system" 
→ "Drives" (Page 85) drive wizard. 
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5.8 Tips for commissioning the SINAMICS drives 

5.8.1 Firmware version display of drive components 

Firmware version of the drive components  
The versions of the drive components are output from "Commissioning" → "Drive system" → 
"Drive units" → Configuration" in the "FW version" column. 

Example: 4503000 ⇒ Firmware version: 04.50.30.00 

 
Figure 5-5 "Drive units" - "Configuration" 

Using certain parameters from individual drive components, it is also possible to view the 
relevant firmware version for: 

● SINAMICS S120 system software in parameter r0018 

● Firmware version of the drive components in parameter r0975[2,10] 

● Firmware version of the Sensor Module in parameter r0148[0…2] 

System software SINAMICS S120   
The version of the SINAMICS S120 software available in the system can be found in the 
parameter r0018 for the Control Unit machine data:  

Example: r0018 = 45030000 ⇒ System software: 04.50.30.00 
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Firmware version of the drive components  
The firmware version of all individual components can be individually fetched from the 
parameters r975[2] and r975[10] for each drive component (NCU, ALM, power section). 

Example: 

r0975[2] = 450, r0975[10] = 3000 -⇒ Firmware version: 04.50.30.00 

Firmware version of all Sensor Modules   
The firmware version of all Sensor Modules can be fetched from the parameter r0148[0…2] 
on the associated Motor Module.  

Example: r0148[0] = 45030000 ⇒ Firmware version: 04.50.30.00 of the connected Sensor 
Module. 

5.8.2 Check the power system data of the infeed 

Introduction 
The power supply data settings must be checked and possibly set in SINAMICS during 
commissioning. 

Checking and setting the power supply data   
The "Power supply data" softkey is active in the "Commissioning" → "Drive units" → "Infeed" 
operating area if the infeed has already been commissioned and the data has been saved in 
non-volatile memory:  
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The following supply system data is configured:  

● When the checkbox is selected, the supply system / DC-link identification is activated 
once the infeed pulse has been enabled (p3410). The infeed then switches to operational 
mode. 

  Note 
DC-link identification    

If the line supply environment changes or the components on the intermediate circuit 
change (e.g. after setting up the equipment at the customer site or after expanding the 
drive group), the checkbox must be set again: Hence the "Supply system data" softkey in 
the overview in order to restart the supply system / DC-link circuit identification. 

If P3410 = 5 is saved in the commissioning archive then the supply system / DC-link 
identification starts automatically once the drive data is input into the archive. 

Only then can it be guaranteed that the infeed operates with the optimum controller 
settings. 

● Enter the device connection voltage: This is the basis for monitoring the supply voltage 
(p0281 - p0283), whereby an alarm is triggered in the case of an overshoot or 
undershoot. (Alarm threshold and shutdown threshold). The actual supply voltage is 
determined automatically and the adjustment is made based on this value. 

● The actual network frequency for the infeed is determined automatically. 

Set in parameter p0284, p0285 a threshold from which an alarm is triggered (default 
setting of the monitoring: 45 Hz to 65 Hz). 

5.8.3 Identifying the infeed automatically or manually 

Introduction 
The control optimization in the ALM is also performed with the identification of the ALM. 
Here, the inductance and capacity of the DC link are determined and the optimum control 
data determined for the set-up converter. 

Identification can only be performed after the controller and the drive have been put into 
operation. 

Procedure for the automatic identification of the ALM   
The identification of the ALM is performed automatically by the system in the current 
SINAMICS versions as soon as the first drive has been commissioned and the X122.1 
enable terminal activated. This automatically starts an internal optimization sequence that 
takes approx. 20 seconds to complete.  

During this optimization sequence, enable terminal X122.1 should not be deactivated; 
otherwise the optimization would be aborted. If optimization is aborted, identification may be 
carried out manually at a later stage by the user. 
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Procedure for the manual identification of the ALM 
The identification of the ALM is performed as follows: 

1. Disconnect release (AUS1) ALM (X122.1) by the commissioning engineer. 

2. Select machine data for the infeed (ALM) in the "Commissioning" > "Machine data" > 
"Infeed MD" menu. 

3. Initiate identification on the ALM: p3410 = 5. 

4. Connect ALM enable (the enable must remain pending during the execution of the first 
step of the identification). 

5. The ALM controller data is reset automatically and power supply identification starts. 

6. After a successful identification, p3410 is automatically set to 0 and the values for the 
controller data of the ALM are saved automatically. Check: p3402 = 9 (Release has to 
remain during the execution of this step of the identification!). 

7. Disconnect ALM enable (X122.1) by the commissioning engineer. 

8. The optimized infeed data is saved automatically. The data does not need to be saved 
manually (p0977 = 1). 

5.8.4 Topology rules for SMC40 

Use of the SMC40 
The SMC40 Sensor Module Cabinet-Mounted is used to convert encoder signals from 
absolute encoders with EnDat 2.2 to DRIVE-CLiQ. Two encoder systems with EnDat 2.2 can 
be connected to the SMC40. Their signals are converted independent of each other on two 
DRIVE-CLiQ encoder signals. 

Connection conditions 
To ensure that the SMC40 Sensor Module Cabinet-Mounted is integrated into the topology 
during the initial commissioning, you must absolutely observe the following rules: 

● Connect at least one of the DRIVE-CLiQ interfaces X500/1 or X500/2 on the SMC40 
using DRIVE-CLiQ. 

● Connect one EnDat encoder to the corresponding encoder interface X520/1 (to X500/1) 
or X520/2 (to X500/2). 

● Operate the SMC40 only in a star topology. The DRIVE-CLiQ X500/1 and X500/2 sockets 
cannot be used for a series connection. 
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NOTICE  
Display in the "Topology" dialog 

The SMC40 can be integrated in the actual topology only when the DRIVE-CLiQ X500/x 
interfaces and the corresponding encoder interfaces X520/x are assigned.  

Without a connected encoder, it is also not possible to subsequently integrate the SMC40 
in the topology. 

 

5.8.5 Drive (SERVO) parameter RESET, individual 

Operating sequence 
 

 Note 

Not just the motor and encoder data are reset. All the configured BICO logic operations 
(enable signals, probe signals) and message frame type are also deleted. 

 

The factory setting (parameter RESET) may be set for each drive (SERVO) individually: 

1. Set the factory settings on the selected drive: p0010 = 30 

2. Activate the factory settings on this drive: p0970 = 1 

3. Device automatically carries out RESET of all parameters on this drive. 

4. Save drive-specific: Set p0971 = 1 

OR:  

Save "All": Set p0977 = 1. 

5. Wait until p0977/p0971 is automatically set to " 0" again; this can take up to 40 seconds. 

5.8.6 Drive-object assignment for PROFIBUS connection 

Introduction 
PROFIBUS telegrams (internal PROFIBUS, HW Config) are used to specify the process 
data to be exchanged between the NC and the drives. The sequence of the drive objects 
(configurable/configured using HW Config) involved in PROFIBUS process-data exchange is 
defined via a drive-object list.  
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List of drive objects 
You usually configure eight drive objects: If you insert a drive object in HW Config, this is the 
default setting.  

The drive objects have drive-object numbers and are entered in p0978[0…9] as a list of drive 
objects:  

 
p0978[0] = 3 Motor Module 1 
p0978[1] = 4 Motor Module 2 
p0978[2] = 5 Motor Module 3 
p0978[3] = 6 Motor Module 4 
p0978[4] = 7 Motor Module 5 
p0978[5] = 8 Motor Module 6 
p0978[6] = 1 Control Unit 
p0978[7] = 2 Infeed (ALM) 
p0978[8] = 0  
p0978[n] = 0  

PROFIBUS telegram 370 for the infeed (ALM) is not supported by SINUMERIK. However, 
according to the SINAMICS rule, all DO from parameter p0101 have to be assigned in 
parameter p0978. For this reason, the DO number of the infeed should be entered in index 9.  

 

 Note 

The list of DO involved in process-data exchange is completed by entering the value "0".  

The list of drive objects is already preassigned in the following sequence by the system upon 
initializing the drive (acceptance of topology): ALM, 1st Motor Module … n, CU; e.g. 2-3-4-5-1.

Components that do not communicate via PROFIBUS automatically have "255" preassigned 
to them.  

 

Drive-object numbers 
The drive-object numbers (DO numbers) can be viewed under "Commissioning > Machine 
data > Control Unit MD/Infeed MD/Drive MD" in the component name line. An example of a 
Control Unit name might be: "DP3.Slave3:CU_003 (1)". The DO number appears inside the 
brackets "(…)". 
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Assigning drive objects  
Using an example of an SINAMICS S120 component structure, the following table illustrates 
the drive object assignment for the drive parameters:  

● One Control Unit (CU) 

● One Active Line Module (ALM) 

● Three Motor Modules 

Assignment p0978[0…9] for supply with DRIVE-CLiQ connection:  
 
Component Index p0978  List of drive objects  
1st Motor Module 0 3 
2nd Motor Module 1 4 
3rd Motor Module 2 5 
not found 3 2551) 
not found 4 2551) 
not found 5 2551) 
CU 6 1 
ALM, only if protocol 370 is available 7 2551) 
not found 8 02) 
ALM (Standard for SINUMERIK) 9 2 

1) Not active 
2) End of exchange of PZD 
 
The following table describes the assignment of the drive objects in p0978[0…9] for an 
infeed without DRIVE-CLiQ connection. This assignment is also done for a drive group with 
NX module.  

Assignment of p0978[0…9] for infeed without DRIVE-CLiQ connection:  
 
Component Index p0978  List of drive objects  
1st Motor Module 0 2 
2nd Motor Module 1 3 
3rd Motor Module 2 4 
not found 3 2551) 
not found 4 2551) 
not found 5 2551) 
CU 6 1 
ALM, only if protocol 370 is available 7 2551) 
not found 8 02) 
not found 9 0 

1) Not active 
2) End of exchange of PZD 

See also 
Configuring the I/O address and telegram (Page 159) 



 Commissioning NC-controlled drives 
 5.8 Tips for commissioning the SINAMICS drives 

CNC Commissioning: NC, PLC, Drive 
Commissioning Manual, 03/2013, 6FC5397-2AP40-3BA1 153 

5.8.7 Adjusting speed and brake behavior 

Introduction 
You can adjust the following parameters in the "Commissioning" → "Machine data" → "Drive 
MD" operating area for the purpose of drive optimization.  

Speed adjustment   
● Spindle drive: 

p0500 = 102, speed setpoint in p0322 corresponds to setpoint 4000 0000hex 

● Feed drive: 

p0500 = 101, speed setpoint in p0311 corresponds to setpoint 4000 0000hex 

The speed setpoint can be diagnosed in the relevant drive in r2050[1+2] and r2060[1]. 

Brake behavior OFF3   
Depending on the requirements, the brake behavior for each drive can be adjusted to the 
signal 2nd OFF3.  

Default setting p1135 = 0  brake with maximum current.  

Using drive-specific parameterization, a flatter braking ramp can be set with the parameters 
p1135, p1136, p1137 .  

Maximum braking ramp setting: 600 seconds. 
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Communication between the NC and the drive 6
6.1 Overview of NC and drive communication 

What will be configured next? 
The initial commissioning of the PLC and SINAMICS drives is completed.  

The machine data that communicates with the drive is: 

● General machine data 

General machine data required for communication with the drive via PROFIBUS that has 
been preset with default values. These values can be taken over during the initial 
commissioning:  

– The telegram type for transfer 

– The logical addresses for the PLC 

● Axis-specific machine data 

The axis component for transfer of the setpoints and actual values for the relevant axis, is 
set in the axis machine data. 

Assignment of machine data  
Using the example of a SINAMICS S120 module structure (one NCU, one ALM, three Motor 
Modules (MM)), the following table illustrates the assignment of the machine data for input 
address/output address/telegram/setpoint/actual value. 
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SINAMICS 
S120 

STEP 7 (HW Config)  
DP slave properties 

General machine data Axis machine data2) 

Component Message frame 
type and length 

I/O 
address1) 

MD13120[0] 
I/O 
address1) 

MD13050 
[0...5] I/O 
address1) 

MD13060 
[0...5] 
message 
frame type 

MD30110/
MD30220 
setpoint / 
actual value 
assignment 

MD30130 
Type of 
output 
Setpoint 

MM1 136 - PZD-11/19 4100  4100 136 1 1 
MM2 136 - PZD-11/19 4140  4140 136 2 1 
MM3 136 - PZD-11/19 4180  4180 136 3 1 
Not available 136 - PZD-11/19 4220  4220 136 -- 0 
Not available 136 - PZD-11/19 4260  4260 136 -- 0 
Not available 136 - PZD-11/19 4300  4300 136 -- 0 
CU 391 - PZD-3/7 6500 6500     
ALM 370 - PZD-1/1 6514      

1)  Do not change preassignment. 
2)  The axis-specific machine data for the configuration of the setpoints and actual values is pre-assigned using the "Assign 

axis" function. 
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6.2 Configuring the communication to the drive 

Default settings 
The telegram length in the hardware configuration is preassigned with the associated I/O 
addresses. This pre-assignment for SINAMICS corresponds to the following telegrams with 
the maximum possible telegram length:  

● Telegram 136: for the axes 

● Telegram 391: for the NCU 

● Telegram 370: for the ALM 

This ensures that all telegrams can be supplied without change.  

Operating sequence for telegram length and I/O addresses 
Procedure: 

1. To view this configuration, click in the HW Config on the module "SINAMICS Integrated" 
and select "Object properties", using the <right mouse button>. 

2. Select the "Configuration" tab and select the "Overview" tab to display the lengths of the 
preassigned telegrams. 

The figure shows the default setting of the telegrams for six axes:  

 
3. Click "OK" to close the dialog. 
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Example 
You can view the address areas in the station window in the detail view by clicking 
"SINAMICS Integrated". Here, for example, address 4100 corresponds to the address 
entered in MD13050 $MN_DRIVE-LOGIC_ADRESS[0]. The addresses have a gap of 40 
bytes. The following example shows the assignment of the pre-assignment of the I/O 
addresses of the PLC configuration to MD13050 $MN_DRIVE-LOGIC_ADRESS[ 0 … 5]:  

 
Default setting in the NCK:  
MD13050 $MN_DRIVE_LOGIC_ADRESS[0] = 4100 For the 1st axis 
MD13050 $MN_DRIVE_LOGIC_ADRESS[1] = 4140 For the 2nd axis 
MD13050 $MN_DRIVE_LOGIC_ADRESS[2] = 4180 For the 3rd axis 
MD13050 $MN_DRIVE_LOGIC_ADRESS[3] = 4220 For the 4th axis ... etc. 

Figure 6-1 Telegram lengths and I/O addresses 
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6.3 Configuring the I/O address and telegram 

PROFIBUS connection  
The following general machine data is also set by default for the PROFIBUS connection of 
the axes to the drive: 

● MD13050 $MN_DRIVE_LOGIC_ADDRESS (axis address) 

● MD13060 $MN_DRIVE_TELEGRAM_TYPE (telegram type) 

● MD13120 $MN_CONTROL_UNIT_LOGIC_ADDRESS (CU address) 

The connection of the relevant axes to the drive via PROFIBUS is displayed in the 
"Commissioning" → "Drive system" → "Drive units" → "PROFIBUS" operating area.  

Example for the connection of relevant axis to the drive:  

 
Figure 6-2 Drive units - PROFIBUS 
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To change the assignment, press the "Change >" softkey. Then use the arrow softkeys for 
the new assignment: 

 
Figure 6-3 Change assignment 

 

 Note 
Communication with the drive 

To ensure the communication with the drive, the I/O addresses and telegram types set here 
must match the settings in the STEP 7 hardware configuration. 
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6.4 Configuring the setpoint / actual value 

Introduction 
The axis component for transfer of the setpoints and actual values for the relevant axis, is 
set in the axis machine data. The following axis machine data must be adapted for each 
axis: 

● MD30110 $MA_CTRLOUT_MODULE_NR (setpoint channel) 

● MD30220 $MA_ENC_MODUL_NR (actual value channel) 

● MD30130 $MA_CTRLOUT_TYPE (type of output setpoint) 

● MD30240 $MA_ENC_TYPE (acquisition of actual value) 

The axis/machine data can be automatically adapted using the "Assign axis" function or 
directly using the "Axis MD" function.  

Assigning setpoints and actual values  
Procedure: 

1. Select the "Axis MD" softkey in the "Commissioning > Machine data" in the operating 
area. 

2. Select the corresponding axis using "Axis+". 

3. For the setpoint channel, search for MD30110 $MA_CTRLOUT_MODULE_NR. 

4. Enter the drive number. 

5. For the actual value channel, search for MD30220 $MA_ENC_MODUL_NR. 

6. Enter the drive number. 

7. For the output setpoint, search for MD30130 $MA_CTRLOUT_TYPE. 

8. Enter "1". 

9. For the actual-value acquisition, search for MD30240 $MA_ENC_TYPE. 

10. Enter "1" for incremental encoder or "4" for absolute value encoder. 

11. Select the next axis in each case with Axis+ and continue with Step 3 for the next drive. 
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6.5 Assigning axes 

Operating sequence in the "Assign axis" menu   
Procedure: 

1. Select the "Commissioning" > "Drive system" > "Drives" menu. 

 
Figure 6-4 "Commissioning" > "Drive system" > "Drives" menu 

  Note 

The "Assign axis" function can also be activated in the "Commissioning > Drive system" 
function using the vertical softkey bar. You must have selected a servo drive before doing 
this. 

2. Press the "Assign axis" horizontal softkey 

 
Figure 6-5 Assignment of setpoints and actual values for axes to drive 

3. Use "Drive +"/"Drive -"/"Direct selection" to select the corresponding servo. 
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4. Press "Change". 

 
Figure 6-6 "Assign axis" > "Change" menu 

5. Use the cursor keys to select the selection boxes for the setpoint or actual value. 

6. Use the <INPUT> key to open the selection box. 

7. Use the cursor keys to select the component. 

8. Press "Transfer". 
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6.6 Ending the communications commissioning 

Machine installed 
You have commissioned the following components: 

● PLC 

● SINAMICS drives 

● NC ↔ PLC communication 

The commissioning is completed. You can now traverse the axes. 

The next "NC commissioning" section describes the parameterization of the NC with regard 
to the connected machine by setting system variables. 
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Commissioning the NC 7
7.1 Machine and setting data 

Parameterizing the NCK 
Adaptation of the control at the machine is performed using the machine and setting data. 

● The machine data (MD) is divided into the following areas: 

– General machine data 

– Channel-specific machine data 

– Axis-specific machine data 

– Machine data for control unit 

– Machine data for infeed 

– Machine data for drives 

● The setting data (SD) is divided into the following areas: 

– General setting data 

– Channel-specific setting data 

– Axis-specific setting data 

The following table provides an overview of the machine data and setting data areas:  

 
Range Name 
from 9000 to 9999 Display machine data 
from 10000 to 18999 General NC machine data 
from 19000 to 19999 Reserved 
from 20000 to 28999 Channel-specific machine data 
from 29000 to 29999 Reserved 
from 30000 to 38999 Axis-specific machine data 
from 39000 to 39999 Reserved 
from 41000 to 41999 General setting data 
from 42000 to 42999 Channel-specific setting data 
from 43000 to 43999 Axis-specific setting data 
from 51000 to 51299 General configuration machine data 
from 51300 to 51999 General cycle machine data 
from 52000 to 52299 Channel-specific configuration machine data 
from 52300 to 52999 Channel-specific cycle machine data 
from 53000 to 53299 Axis-specific configuration machine data 
from 53300 to 53999 Axis-specific cycle machine data 
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Effectiveness 
The effectiveness of a machine data item specifies when the change becomes active:  

● POWER ON (po) NCK RESET 

● NEWCONF (cf) 

– "Set MD to active" softkey 

– <RESET> key on the MSTT 

– It is possible to modify block limits during program operation 

● RESET (re) 

– At end of program M2/M30 or 

–  <RESET> key on the MSTT 

● IMMEDIATE (so) 

– After the input of a value 

Changes to the setting data always take effect immediately. 

References 
You find a description of the machine data and the setting data in: 

● Online help (context-related) 

● SINUMERIK 840D sl List Manual "Lists 1" /LIS1/ 
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7.2 Parameter sets of axis/spindle 

Introduction     
Six parameter sets are available for each machine axis:  

● For an axis, the parameter sets are used to adapt the own dynamic response to another 
machine axis, e.g. when tapping or thread cutting on the relevant spindle. 

● For a spindle, the parameter sets are used to adapt the position control to the modified 
properties of the machine during operation, e.g. when switching the gearbox. 

Tapping, thread cutting    
The following applies to axes:  

● For machine axes that are not involved in tapping or thread cutting, the first set of 
parameters (index=0) is active in all cases. The further parameter sets need not be 
considered. 

● For machine axes involved in tapping or thread cutting: the parameter set is activated in 
accordance with the current gear stage. All parameter sets must be parameterized in 
accordance with the gear stages of the spindle. 

The following applies to spindles: 

● With spindles, each gear stage is assigned a parameter set of its own. 

For example, gear stage 1 - parameter set 2 (index 1). Spindles in axis operation (DB31, 
... DBX60.0 = 0) use Parameter set 1 (Index 0). The active gearbox step can be read in 
the PLC via the signals DB31, ... DBX82.0-2 (gearbox step setpoint). The parameter set 
is selected from the PLC using the interface signal DB31, ... DBX16.0 - 16.2 (actual gear 
stage). All parameter sets must be parameterized in accordance with the gear stages of 
the spindle. 

Validity of parameter sets for axis and spindle modes   
The active parameter set of a machine axis is displayed under "Service axis" in the 
"Diagnostics" operating area. The active parameter set can be read in the PLC via the 
signals DB31, ... DBX69.0-2 (Controller parameter set)." 

 



Commissioning the NC  
7.2 Parameter sets of axis/spindle 

 CNC Commissioning: NC, PLC, Drive 
168 Commissioning Manual, 03/2013, 6FC5397-2AP40-3BA1 

Parameter set 
number 

Axis Spindle Spindle gear stage 

0 Standard Axis mode Depending on the 
manufacturer's 
specification 

1 Axis interpolates with spindle 
(G33) 

Spindle mode 1. 

2 Axis interpolates with spindle 
(G33) 

Spindle mode 2. 

3 Axis interpolates with spindle 
(G33) 

Spindle mode 3. 

4 Axis interpolates with spindle 
(G33) 

Spindle mode 4. 

5 Axis interpolates with spindle 
(G33) 

Spindle mode 5. 

Remarks on the "Axis" column: The switchover applies to G33 as well as for G34, G35, 
G331 and G332. 

Parameter-set-dependent machine data 
The following machine data of an axis depends on the parameter set: 

 
MD Name Meaning 
31050 $MA_DRIVE_AX_RATIO_DENOM[n] Denominator load gearbox 
31060 $MA_DRIVE_AX_RATIO_NUMERA[n] Numerator load gearbox 
32200 $MA_POSCTRL_GAIN[n] KV factor 
32810 $MA_EQUIV_SPEEDCTRL_TIME[n] Equivalent time constant speed control 

loop for feedforward control 
32910 $MA_DYN_MATCH_TIME[n] Time constant for dynamic matching 
35110 $MA_GEAR_STEP_MAX_VELO[n] Maximum speed for gear stage change 
35120 $MA_GEAR_STEP_MIN_VELO[n] Minimum speed for gear stage change 
35130 $MA_GEAR_STEP_MAX_VELO_LIMIT[n] Maximum speed of gear stage 
35140 $MA_GEAR_STEP_MIN_VELO_LIMIT[n] Minimum speed of gear stage 
35200 $MA_GEAR_STEP_SPEEDCTRL_ACCEL[n] Acceleration in speed control mode 
35210 $MA_GEAR_STEP_POSCTRL_ACCEL[n] Acceleration in position-control mode 
36200 $MA_AX_VELO_LIMIT[n] Threshold value for velocity monitoring 

n = parameter set number (0 ... 5) 
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7.3 Parameterize axis data 

7.3.1 Parameterizing the incremental-rotary measuring system 

Rotary measuring system     
The diagrams below show the general possibilities for arranging a rotary incremental 
measuring system with regard to motor and load, as well as the resulting values for the 
appropriate machine data. 

The figures equally apply to rotary axes, modulo axis and spindles:  

● Linear axis with encoder on the machine 

 
Figure 7-1 Linear axis with encoder on motor   

● Linear axis with encoder on load 

 
Figure 7-2 Linear axis with encoder on load   
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● Rotary axis with encoder on motor 

 
Figure 7-3 Rotary axis with encoder on motor   

● Linear axis with encoder on the machine 

 
Figure 7-4 Linear axis with encoder on the machine   

Machine data for incremental measuring systems 
 
MD Identifier Comment 
30240 $MA_ENC_TYPE[n] Actual-value acquisition modes: 

1 = incremental raw signal generator 
30242 $MA_ENC_IS_INDEPENDENT[n] Encoder is independent 
30300 $MA_IS_ROT_AX Rotary axis 
31000 $MA_ENC_IS_LINEAR[n] Direct measuring system (linear scale) 
31020 $MA_ENC_RESOL[n] Encoder pulses per revolution 
31030 $MA_LEADSCREW_PITCH Leadscrew pitch 
31040 $MA_ENC_IS_DIRECT[n] Encoder is connected directly to the machine 
31050 $MA_DRIVE_AX_RATIO_DENOM[n] Denominator load gearbox 
31060 $MA_DRIVE_AX_RATIO_NUMERA[n] Numerator load gearbox 
31070 $MA_DRIVE_ENC_RATIO_DENOM[n] Denominator of resolver gearbox 
31080 $MA_DRIVE_ENC_RATIO_NUMERA[n] Numerator of resolver gearbox 
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7.3.2 Parameterizing the incremental-linear measuring system 

Linear measuring system    
The diagram below shows the general possibilities for arranging a linear incremental 
measuring system with regard to motor and load, as well as the resulting values for the 
respective machine data.  

The representation applies equally to rotary axes, modulo axis and spindles:  

 
Figure 7-5 Linear axis with linear scale   

Machine data for linear measuring systems 
 
MD Identifier Comment 
30240 $MA_ENC_TYPE[n] Actual-value acquisition modes 

1 = incremental raw signal generator 
30242 $MA_ENC_IS_INDEPENDENT[n] Encoder is independent 
30300 $MA_IS_ROT_AX Rotary axis 
31000 $MA_ENC_IS_LINEAR[n] Direct measuring system (linear scale) 
31010 $MA_ENC_GRID_POINT_DIST[n] Distance between reference marks on linear 

scales 
31030 $MA_LEADSCREW_PITCH Leadscrew pitch 
31040 $MA_ENC_IS_DIRECT[n] Encoder is connected directly to the machine 
31050 $MA_DRIVE_AX_RATIO_DENOM[n] Denominator load gearbox 
31060 $MA_DRIVE_AX_RATIO_NUMERA[n] Numerator load gearbox 
32110 $MA_ENC_FEEDBACK_POL[n] Sign actual value (feedback polarity) 
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7.3.3 Parameterizing the absolute measuring system 

Encoder types     
The following encoder types with EnDat protocol and incremental sinusoidal encoder signals 
A and B are currently supported:  

● Single-turn absolute value encoder 

● Multi-turn absolute value encoder 

The absolute value encoder EQN 1325 from Heidenhain has the following properties:  

● EnDat protocol 

● PPR count: 2048 = 211 (encoder fine resolution) 

● Positions/revolution: 8192 (13 bits) 

● Differentiable revolutions: 4096 (12 bits) 

● Encoder signals A/B: 1Vpp sin/cos 
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Calibration   
Convergence of the measuring system with the machine positions is performed by 
calibration of the absolute value encoder in absolute measuring systems.  

● Linear axis with absolute value encoder on motor 

 
Figure 7-6 Linear axis with absolute value encoder on motor 

● Rotary axis, modulo axis and spindle with absolute value encoder on motor 

 
Figure 7-7 Rotary axis, modulo axis and spindle with absolute value encoder on motor 

Machine data for absolute measuring systems 
 
MD Identifier Comment 
30240 $MA_ENC_TYPE[n] Actual-value acquisition modes 
30242 $MA_ENC_IS_INDEPENDENT[n] Encoder is independent 
30260 $MA_ABS_INC_RATION[n] Encoder fine resolution (absolute value 

encoder) 
30300 $MA_IS_ROT_AX[n] Rotary axis 
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MD Identifier Comment 
31000 $MA_ENC_IS_LINEAR[n] Direct measuring system (linear scale) 
31030 $MA_LEADSCREW_PITCH[n] Leadscrew pitch 
31040 $MA_ENC_IS_DIRECT[n] Encoder is connected directly to the machine 
31050 $MA_DRIVE_AX_RATIO_DENOM[n] Denominator load gearbox 
31060 $MA_DRIVE_AX_RATIO_NUMERA[n] Numerator load gearbox 
31070 $MA_DRIVE_ENC_RATIO_DENOM[n] Measuring gearbox denominator 
31080 $MA_DRIVE_ENC_RATIO_NUMERA[n] Measuring gearbox numerator 
34200 $MA_ENC_REFP_MODE[n] Referencing mode 
34210 $MA_ENC_REFP_STATE[n] Status of absolute value encoder 
34220 $MA_ENC_ABS_TURNS_MODULO[n] Absolute value encoder range for rotary 

encoders (multi-turn resolution) 

See also 
For calibration of the absolute value encoder, see Chapter "Axis Homing" (Page 199). 

7.3.4 Setpoint/actual value channels 

Simulation axes    
In order to guarantee that the controller runs up reliably, all machine axes are declared as 
simulation axes (without hardware). 

● MD30130 $MA_CTRLOUT_TYPE (output type of setpoint value) = 0 

● MD30240 $MA_ENC_TYPE (actual-value acquisition mode) = 0 

Traversing the axes is simulated in SERVO mode without speed setpoint output, and no 
hardware-specific alarms are output.  

The following machine data can be used to select whether the interface signals of a 
simulation axis are output at the NC/PLC interface (e.g. during program test, if there is no 
drive hardware, used in FC18 in PLC).  

● MD30350 $MA_SIMU_AX_VDI_OUTPUT (output of axis signals with simulation axes) 

Assignment of the setpoint / actual value channels    
For each machine axis to which a drive is assigned, the following must be parameterized:  

● A setpoint channel and 

● At least one actual-value channel 
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A second actual-value channel can be set up as an option. 
 

 Note 

The motor measuring system is always used for the speed control function. Motor and motor 
measuring system must therefore always be connected to the same drive (SERVO). 

 

In the following two axis-specific machine data, the logical drive number m of the drive is 
entered, which represents the machine axis: 

● MD30110 $MA_CTRLOUT_MODULE_NR[0] (setpoint assignment: Logical drive number) 

● MD30220 $MA_ENC_MODUL_NR[n] (actual value assignment: Logical drive number) 

With the logical drive number m, that drive is addressed whose I/O address is entered under 
the index n = (m - 1) in MD13050 $MN_DRIVE_LOGIC_ADDRESS[<n>] (see Chapter "Axis 
assignment (Page 376)"). 

Once the drive configuration and setpoint / actual value assignment have been 
parameterized, an NCK reset must be executed to initiate a warm restart of the NC. After the 
NC has powered up, the set configuration is effective.  

Measuring system switchover   
The following interface signals can be used to switch between the two position measuring 
systems of a machine axis from the PLC:  

● DB31, ... DBX1.5 (position measuring system 1 selected) 

● DB31, ... DBX1.6 (position measuring system 2 selected) 

Machine data 
 
MD Identifier Remark 
30110 $MA_CTRLOUT_MODULE_NR Setpoint assignment: Logical drive number 
30130 $MA_CTRLOUT_TYPE Output of setpoint value 

0 = Simulation 
1 = Output of speed setpoint 

30200 $MA_NUM_ENCS Number of measuring channels 
1 = One position measuring system present 
2 = Two position measuring systems present 

30220 $MA_ENC_MODULE_NR[0] Actual value assignment: Logical drive number for 
position measuring system 1 

30220 $MA_ENC_MODULE_NR[1] Actual value assignment: Logical drive number for 
position measuring system 2 

30230 $MA_ENC_INPUT_NR[0] Actual value assignment: Position measuring system 1 
1 = G1_XIST encoder 1 position actual value 1 
2 = G2_XIST encoder 1 position actual value 2 



Commissioning the NC  
7.3 Parameterize axis data 

 CNC Commissioning: NC, PLC, Drive 
176 Commissioning Manual, 03/2013, 6FC5397-2AP40-3BA1 

MD Identifier Remark 
30230 $MA_ENC_INPUT_NR[1] Actual value assignment: Position measuring system 2 

1 = G1_XIST encoder 2 position actual value 1 
2 = G2_XIST encoder 2 position actual value 2 

30240 $MA_ENC_TYPE[0] Type of actual value recording 
0 = Simulation 
1 = Incremental encoder 
4 = Absolute encoder with EnDat interface 

References 
Basic Functions Function Manual; Various Interface Signals (A2) 

7.3.5 Dynamic Servo Control (DSC) 

Overview    
The DSC function eliminates the deadtime that necessarily exists at the speed-setpoint 
interface normally used between the NCK and drive due to relocation of the position 
controller into the drive.  

This results in the following advantages for an axis operated with DSC: 

● Considerably improved fault response/stability of the position control loop 

● Improved command behavior (contour precision) if the loop gain (KV factor) that can be 
set higher in conjunction with DSC is used. 

● A reduction of the cyclic communication load on the PROFIBUS, if the position controller 
cycle/PROFIBUS cycle is reduced by adjusting the above parameters, even if the control 
loop performance is the same. 

  Note 

The speed feedforward control can be used in conjunction with DSC. 

Speed setpoint filter 
If you use DSC, a speed setpoint filter for rounding the speed setpoint steps is no longer 
necessary. The speed setpoint filter is then only of any use with differential connection to 
support the position controller, for example, to suppress resonance. 

Preconditions 
Before you can activate DSC mode, the following preconditions must be fulfilled: 

● DSC-capable drive 

● A DSC-capable telegram type has been parameterized in the S7 project for the drive. 
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Switch ON/OFF 
The DSC function is switched ON via the following axis-specific machine data: 

● MD32640 $MA_STIFFNESS_CONTROL_ENABLE (dynamic stiffness control) 

If the DSC operation is switched ON or OFF, it might be necessary to adjust the following 
machine data: 

● MD32200 $MA_POSCRTL_GAIN (KV factor) 

● MD32610 $MA_VELO_FFW_WEIGHT (Feedforward control factor) 

● MD32810 $MA_EQUIV_SPEEDCTRL_TIME (Equivalent time constant of the closed 
speed control loop) 

NOTICE  
 

Stability of the position control loop 

Before you can switch off DSC operation you might have to adapt (reduce) the KV factor 
of the axis. Otherwise, instability of the position control loop might result. 

Actual value inversion during DSC operation  
 

 Note 

Actual value inversion during DSC operation (MD32640=1) is undertaken as follows: 
 Set the p0410 parameter (encoder inversion actual value) in the drive. 
 In the NC in the machine data, set MD32110 $MA_ENC_FEEDBACK_POL = 0 or 1 (no 

inversion!). 
Actual value inversion via MD32110=-1 is not possible while DSC operation is active. 
If MD32110=-1 is to be set, the "26017 axis%1 machine data 32110 value not permitted" 
alarm is output when DSC operation is activated. 
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Machine data 
 
MD Identifier Name 
32640 $MA_STIFFNESS_CONTROL_ENABLE Dyn. stiffness control 
32200 $MA_POSCRTL_GAIN KV factor 
32642 $MA_STIFFNESS_CONTROL_CONFIG The dynamic stiffness control is configured:

0: DSC in the drive operates with an 
indirect measuring system (default setting) 
1: DSC in drive operating with direct 
measuring system 

 

7.3.6 Rotary axes 

Rotary axes   
A machine axis is parameterized as a rotary axis in  

● MD30300 $MA_IS_ROT_AX (rotary axis) = 1 

The machine data is a scaling machine data. A change results in a conversion of all machine 
data of the machine axis with length-related units. 

For the recommended procedure with respect to scaling machine data, please refer to 
Section "Modifying Scaling Machine Data". 

Modulo display   

The display of the rotary axis position modulo 360 degrees is displayed via the following 
machine data:  

● MD30320 $MA_DISPLAY_IS_MODULO (modulo 360 degrees display for rotary axes) 

Endlessly rotating rotary axis / modulo axis  

The traversing of the rotary axis modulo 360 degrees is displayed via the following machine data:  

● MD30310 $MA_ROT_IS_MODULO (modulo conversion for rotary axis) 

The limit switches are not monitored during this process. The rotary axis can thus rotate 
endlessly.   

The limit switch monitoring can be activated by the PLC interface. 

Machine data 
 
MD Identifier Name 
10210 $MN_INT_INCR_PER_DEG Computational resolution for angular positions 
30300 $MA_IS_ROT_AX Axis is rotary axis 
30310 $MA_ROT_IS_MODULO Modulo conversion for rotary axis  
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MD Identifier Name 
30320 $MA_DISPLAY_IS_MODULO Actual value display modulo 
36100 $MA_POS_LIMIT_MINUS Minus software limit switch 
36110 $MA_POS_LIMIT_PLUS Plus software limit switch  

Literature 
Function Manual, Extended Functions; Rotary Axes (R2) 

7.3.7 Positioning axes 

Positioning axes   
Positioning axes are channel axes traversing parallel to the path axes without interpolating 
with them. Positioning axes can be traversed either from the part program or from the PLC. 

A channel axis is defined as neutral with the following machine data. As a result no REORG 
takes place if the axis/spindle is traversed by the PLC (FC18) or by synchronous actions. 

● MD30450 $MA_IS_CONCURRENT_POS_AX (neutral axis / channel axis) = 1 

Positioning axis feedrate 
If a positioning axis is programmed in the part program without specifying an axis-specific 
feedrate, the feedrate entered in the following machine data is automatically applicable to 
this axis: 

● MD32060 $MA_POS_AX_VELO (initial setting for positioning axis velocity) 

This feedrate applies until an axis-specific feedrate is programmed in the part program for 
this axis. 

Machine data 
 
MD Identifier Name 
22240 $MC_AUXFU_F_SYNC_TYPE Output timing of F functions 
30450 $MA_IS_CONCURRENT_POS_AX Neutral axis or channel axis 
32060 $MA_POS_AX_VELO Initial setting for positioning-axis velocity 

Literature 
Function Manual, Extended Functions; Positioning Axes (P2) 
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7.3.8 Indexed axes/"Hirth" axes 

Indexing axis    
Indexing axes are rotary or linear axes, which can be traversed to indexing positions by part 
program instructions. These indexing positions are approached in JOG mode. In "normal" 
positioning, every position can be approached.  

 

 Note 

Traversing to indexing positions using the part program or manually is only effective if the 
corresponding machine axis has been successfully referenced. 

 

Hirth axes are indexing axes with Hirth tooth system. These axes are rotary or linear axes, 
which may only be traversed to defined positions, the indexing positions, within the 
traversing range (MD30505  $MA_HIRTH_IS_ACTIVE). The indexing positions are stored in 
tables.  

The following machine data assigns the machine axis the relevant table of indexing positions 
and also defines the machine axis as an indexing axis: 

● MD30500 $MA_INDEX_AX_ASSIGN_POS_TAB[n] (axis is an indexing axis) 

Indexing position tables   
The indexing positions are stored in one of the two tables.  

● MD10900 $MN_INDEX_AX_LENGTH_POS_TAB_1 (number of positions of indexing axis 
table 1) 

● MD10910 $MN_INDEX_AX_POS_TAB_1 [n] (indexing position table 1) 

● MD10920 $MN_INDEX_AX_LENGTH_POS_TAB_2 (number of positions of indexing axis 
table 2) 

● MD10930 $MN_INDEX_AX_POS_TAB_2 [n] (indexing position table 2) 

Machine data 
 
MD Identifier Comment 
10260 $MN_CONVERT_SCALING_SYSTEM Basic system switchover active 
10270 $MN_POS_TAB_SCALING_SYSTEM Measuring system of position tables 
10900 $MN_INDEX_AX_LENGTH_POS_TAB_1 Number of indexing positions used in table 1 
10910 $MN_INDEX_AX_POS_TAB_1[n] Indexing position table 1 
10920 $MN_INDEX_AX_LENGTH_POS_TAB_2 Number of indexing positions used in table 2 
10930 $MN_INDEX_AX_POS_TAB_2[n] Indexing position table 2 
30300 $MA_IS_ROT_AX Rotary axis 
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MD Identifier Comment 
30310 $MA_ROT_IS_MODULO Modulo conversion for rotary axis 
30320 $MA_DISPLAY_IS_MODULO Position display is modulo 360 degrees 
30500 $MA_INDEX_AX_ASSIGN_POS_TAB Axis is indexing axis 
30501 $MA_INDEX_AX_NUMERATOR Numerator for indexing axes with equidistant 

positions 
30505 $MA_HIRTH_IS_ACTIVE Axis is an indexing axis with Hirth toothing 

Literature 
Function Manual Expanded Functions; Indexing Axes (T1) 

7.3.9 Position controller 

Control loops 
The closed-loop control of a machine axis consists of the cascaded closed-loop control 
circuits of current controller, speed controller and position controller.  

 
Figure 7-8 Control loops 

Travel direction  
If the axis does not traverse into the desired direction, the appropriate adaptation is made in 
the following machine data:  

● MD32100 $MA_AX_MOTION_DIR (travel direction) 

The value "-1" reverses the direction of motion. 
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Control direction  
If the control direction of the position measuring system is incorrect, it can be adjusted with 
the following machine data:  

● MD32110 $MA_ENC_FEEDBACK_POL (sign of actual value) 

  Note 

When DSC is activated on the incorrect position measuring system, the control direction 
must also be adjusted in SINAMICS parameter p410. 

Servo gain  
To obtain high contour accuracy, a high loop gain (KV factor) of the position controller is 
required. However, an excessively high KV factor causes overshoot, instability and 
impermissibly high machine loads.  

The maximum permissible KV factor is dependent on the dynamic response and the use of 
the feedforward control or DSC, of the drive and the mechanical system of the machine. 

 

 Note 

The initial commissioning is performed without feedforward control. 
 

A KV factor of "0" leads to the position controller being cut. 

Definition of KV factor  

The KV factor is defined as the ratio of velocity in m/min and the resulting following error in 
mm  

 
This means for a KV factor of 1 that at a velocity of 1m/min, a following error of 1mm results. 

The KV factor of the machine axis is entered via the following machine data: 

● MD32200 $MA_POSCTRL_GAIN (servo gain factor) 

  Note 

To adapt the input/output unit of the KV factor selected by default to the internal unit [1/s], 
the following machine data is pre-assigned: 
 MD10230 $MN_SCALING_FACTORS_USER_DEF[9] = 16.666667 
 MD10220 $MN_SCALING_USER_DEF_MASK = 'H200'; (bit 9 as hex value) 

When entering the KV factor it is important to note that the gain factor of the whole position 
control loop is still dependent on other parameters of the controlled system (speed setpoint 
alignment). 
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These factors include, among others: 

● MD32260 $MA_RATED_VELO 

● MD32250 $MA_RATED_OUTVAL 

● Automatic interface alignment (SINAMICS parameter "Reference speed" p2000) 

For drive optimization, see also: Adjusting speed and brake behavior (Page 153)  
 

 Note 
Interpolation of axes 

Machine axes that interpolate one with another must have the same dynamic response at 
the same velocities. 

This can be achieved by setting the same KV factor or dynamic response adaptation in the 
following machine data: 
 MD32900 $MA_DYN_MATCH_ENABLE 
 MD32910 $MA_DYN_MATCH_TIME 

The real KV factor can be checked with the following error in the service display. 
"Diagnostics" operating area → Menu forward key → "Axis diagnostics" → "Service axis". 

 

Checking the loop gain   

If a KV factor is already known for a machine type in question, this can be set and checked. 
To ensure that the drive does not reach its current limit during acceleration and deceleration, 
the acceleration is reduced for checking via the following machine data:  

● MD32300 $MA_MAX_AX_ACCEL (axis acceleration) 

The KV factor must also be checked for high speeds of the rotary axis and spindle (e.g. for 
spindle positioning, tapping). 

The approach behavior at various speeds can be checked by means of the HMI-Advanced 
servo trace software. The speed setpoint is recorded for this purpose. 

 
Figure 7-9 Speed setpoint characteristic 

No overshoots may occur while the drive is approaching the static states; this applies to all 
speed ranges. 
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Overshoot in the position control loop   

The reasons for an overshoot in the control loop can be:  

● Acceleration too high (current limit is reached) 

● Rise time too long (re-optimization necessary) 

● Mechanical backlash 

● Mechanical components canted 

For safety reasons, set the KV factor for each axis to a little less than the maximum possible 
value. 

● MD32900 $MA_DYN_MATCH_ENABLE[n] 

● MD32910 $MA_DYN_MATCH_TIME[n] 

For axes interpolating with each other, the same KV-factor should be set. Normally it is the 
KV factor of the weakest interpolating axis.  

Contour monitoring must be set subsequently (MD36400 $MA_CONTROL_TOL). 

Acceleration  
In the following machine data, machine axes are accelerated and decelerated with the 
values entered.  

● MD32300 $MA_MAX_AX_ACCEL (axis acceleration) 

This value should allow the axes to be accelerated and positioned fast and accurately, while 
ensuring that the machine is not loaded unduly.  

Checking the acceleration  

The sign of a properly adjusted acceleration of a machine axis is acceleration and 
positioning free from overshoot at rapid traverse rate and maximum load (max. external 
moment of inertia).  

After the acceleration has been entered, the axis is traversed rapidly and the actual current 
values and current setpoint are recorded. 

This recording shows whether the drive reaches the current limit. Here, the current limit can 
be reached for a short time. 

The current must be well below the current limit, however, before the rapid traverse velocity 
or the final position is reached. 

Load changes during the machining should not result in the current limit being reached, as 
they may result in contour errors. For this reason, the acceleration value should be a little 
less than the maximum acceleration value. 

Machine axes can have different acceleration values, even if they interpolate with each 
other. 
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Axial jerk  
The following should be noted for the axis jerk: 

● For part program instructions (SOFT), the following machine data must be set for the 
axial jerk: 

– MD32431 $MA_MAX_AX_JERK   (Maximum jerk) 

– MD32402 $MA_AX_JERK_MODE   (Filter type) 

– MD32890 $MA_DESVAL_DELAY_ENABLE   (Axial phase filter setpoint) 

– MD32895 $MA_DESVAL_DELAY_TIME 

● For JOG and positioning axes the following machine data should be supplemented: 

– MD32420 $MA_JOG_AND_POS_JERK_ENABLE 

– MD32430 $MA_JOG_AND_POS_MAX_JERK   (Axial jerk) 

Example 
MD32890 $MA_DESVAL_DELAY_ENABLE = TRUE 

MD32895 $MA_DESVAL_DELAY_TIME = 0.002 s 

Position control cycle setting: 2 ms 

The phase filter is active and the input values are delayed by one position control cycle. 

Machine data for the closed-loop position control  
 
MD Name Meaning 
32100 $MA_AX_MOTION_DIR[n] Travel direction 
32110 $MA_ENC_FEEDBACK_POL[n] Actual value sign 
32200 $MA_POSCTRL_GAIN[n] Servo gain factor 
32300 $MA_MAX_AX_ACCEL[n] Axis acceleration 
32890 $MA_DESVAL_DELAY_ENABLE Axial phase filter setpoint 
32895 $MA_DESVAL_DELAY_TIME Time constant for the axial phase filter 

setpoint 
32402 MD32402 $MA_AX_JERK_MODE Filter type for axial jerk limitation 
32420 $MA_JOG_AND_POS_JERK_ENABLE Enabling jerk limitation 
32430 $MA_JOG_AND_POS_MAX_JERK Axial jerk 
32431 $MA_MAX_AX_JERK Maximum axial jerk when traversing along the 

path 
32900 $MA_DYN_MATCH_ENABLE[n] Dynamic response adaptation 
32910 $MA_DYN_MATCH_TIME[n] Time constant for dynamic matching 
36400 $MA_CONTROL_TOL Contour monitoring 
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References 
● Function Manual, Basic Functions; Velocities, Setpoint / Actual Value Systems, Closed-

Loop Control (G2) 

● Function Manual, Basic Functions; Acceleration (B2) 

● Extended Functions Function Manual; Compensation (K3) 

7.3.10 Speed setpoint matching 

Overview 
In the case of speed setpoint comparison, the NC is informed which speed setpoint 
corresponds to which motor speed in the drive, for parameterizing the axial control and 
monitoring. Speed setpoint matching can be performed automatically or manually.  

Automatic adjustment   
It is possible to perform automatic speed setpoint adjustment if the drive supports acyclic 
services on the PROFIBUS DP (default for SINAMICS). 

Acyclic services on the PROFIBUS DP are supported if the value "0" is entered in the 
following machine data: 

● MD32250 $MA_RATED_OUTVAL (rated output voltage) [%] 

During start-up of the NCK, speed setpoint matching between the NCK and the drive is 
then performed automatically. 

WARNING  
 

No axis release 

The "Reference speed" p2000 parameter may not be changed during operation of the 
controller with the drive.  

If automatic speed setpoint matching fails for one axis, the following message is output 
on a traverse request for this axis: "Wait, axis enable missing". This axis and any axes 
that interpolate with it are not traversed. 

Manual comparison 
The speed setpoint alignment (interface normalization) is specified in the following machine 
data: 

● MD32250 $MA_RATED_OUTVAL (rated output voltage) [%] 

● MD32260 $MA_RATED_VELO (rated motor speed) 
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If a value not equal to 0 is entered in the following machine data, a manual speed setpoint 
matching is performed:  

● MD32250 $MA_RATED_OUTVAL (rated output voltage) [%] 

  Note 

The maximum upper limit for the speed setpoint is predefined in the following machine 
data: 
 MD36210 $MA_CTRLOUT_LIMIT (maximum speed setpoint) [%] 

Calculation of the motor speed 
If the motor speed required for speed setpoint matching is not known directly, it can be 
calculated as follows with reference to the required axis velocity (linear axis) or load speed 
(rotary axis/spindle): 

● Motor speed for linear axis: 

 
● Motor speed for rotary axis/spindle: 

 
vAxis [mm/min]  
nMotor [rpm] Motor speed 
nLoad [rpm] Load speed 
MD31060 $MA_DRIVE_RATIO_NUMERA Numerator load gearbox 
MD31050 $MA_DRIVE_RATIO_DENOM Denominator load gearbox 
MD31030 $MA_LEADSCREW_PITCH Pitch of the ball screw [mm/rev] 



Commissioning the NC  
7.3 Parameterize axis data 

 CNC Commissioning: NC, PLC, Drive 
188 Commissioning Manual, 03/2013, 6FC5397-2AP40-3BA1 

Checking the trim 
Incorrect speed setpoint matching has a negative impact on the real loop gain of the axis. To 
check speed setpoint matching it is necessary for a defined traverse velocity to compare the 
actual following error with the desired following error that should be set if speed setpoint 
matching is correct. 

 
[mm] Desired following error 
[m/min] Traverse rate 
MD32200 $MA_POSCTRL_GAIN KV factor in [(m/min)/mm] 

The actual following error is displayed in the "Diagnosis" operating area → Menu forward key 
→ "Axis diagnostics" → "Service axis". 

Machine data 
 
MD Identifier Remark 
32250 $MA_RATED_OUTVAL  Rated output voltage [%] 
32260 $MA_RATED_VELO Rated motor speed 

References 
Function Manual, Basic Functions; Velocities, Setpoint-Actual Value Systems, Closed-Loop 
Control (G2) 

7.3.11 Velocity matching (axis) 

Maximum axis velocity    
The value entered in the following machine data is the limit velocity up to which a machine 
axis can accelerate (rapid traverse limiting). It depends on the machine and drive dynamics 
and the limit frequency of actual-value acquisition.  

● MD32000 $MA_MAX_AX_VELO[n] (max. axis velocity) 

The max. axis velocity is used for traversing in the part program when rapid traverse (G00) is 
programmed. The maximum linear or rotary axis velocity should be entered in the machine 
data in accordance with MD30300 $MA_IS_ROT_AX[n]. 

Rapid traverse in jog mode   
The value entered in the following machine data is the velocity at which the machine axis 
traverses in JOG mode with the rapid traverse override key actuated and with an axial feed 
override of 100%.  
● MD32010 $MA_JOG_VELO_RAPID[n] (rapid traverse in JOG mode) or 
● MD32040 $MA_JOG_REV_VELO_RAPID[n] (revolutional feedrate in JOG mode with 

rapid traverse override) 
The entered value may not exceed the max. permissible axis velocity. 

This machine data will not be used for the programmed rapid traverse G00. 
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JOG axis velocity   
The value entered in this machine data is the velocity at which the machine axis traverses in 
JOG mode with an axial feed override of 100%:  

● MD32020 $MA_JOG_VELO[n] (axis velocity in JOG mode) or 

● MD32050 $MA_JOG_REV_VELO[n] (revolutional feedrate in JOG mode) 

The velocity from MD32020 JOG_VELO[n] or MD32050 JOG_REV_VELO[n] is used only in 
the following cases:  

● For linear axes: SD41110 $SN_JOG_SET_VELO = 0 

● For rotary axes: SD41130 $SN_JOG_ROT_AX_SET_VELO = 0 

● For reverse feed: SD41120 $SN_JOG_REV_SET_VELO = 0 

If the above-mentioned setting data is not equal 0, this produces the following JOG velocity: 

1. SD41100 $SN_JOG_REV_IS_ACTIVE (revolutional feedrate in JOG mode) = 0 

=> Linear feedrate (G94) 

– Linear axes: 

JOG velocity = SD41110 $SN_JOG_SET_VELO (JOG velocity for G94) 

– Rotary axes: 

JOG velocity = SD41130 $SN_JOG_ROT_AX_SET_VELO (JOG velocity for rotary axes) 

2. SD41100 $SN_JOG_REV_IS_ACTIVE (revolutional feedrate in JOG mode) = 1 

– JOG velocity = SD41120 $SN_JOG_REV_SET_VELO (JOG velocity for G95) 

The entered values may not exceed the maximum permissible axis velocity. 
 

 Note 

Depending on MD30300 $MA_IS_ROT_AX[n] , the speeds must be entered in mm/min, 
inch/min or rpm. 

If the velocities are changed, MD36200 $MA_AX_VELO_LIMIT[n] (threshold value for 
velocity monitoring) must be adapted accordingly. 

 

Machine data 
 
MD Identifier Comment 
30300 $MA_IS_ROT_AX[n] Rotary axis 
32000 $MA_MAX_AX_VELO[n] Maximum axis velocity 
32010 $MA_JOG_VELO_RAPID[n] Rapid traverse in jog mode 
32020 $MA_JOG_VELO[n] JOG axis velocity 
32040 $MA_JOG_REV_VELO_RAPI

D[n] 
Revolutional feedrate in JOG mode with rapid traverse 
override 

32050 $MA_JOG_REV_VELO[n] Revolutional feedrate in JOG mode 
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MD Identifier Comment 
32060 $MA_POS_AX_VELO[n] Initial setting for positioning-axis velocity 
32250 $MA_RATED_OUTVAL  Rated output voltage 
32260 $MA_RATED_VELO[n] Rated motor speed 

Literature 
● Function Manual, Basic Functions; Velocities, Setpoint-Actual Value Systems, Closed-

Loop Control (G2) 

● Extended Functions Function Manual; Manual and Handwheel Travel (H1) 

7.3.12 Axis monitoring functions (static) 

Static monitoring functions 
The static monitoring functions with reference to a machine axis are:    

Exact stop coarse 

Window around the setpoint position within which exact stop coarse is detected.   

● MD36000 $MA_STOP_LIMIT_COARSE (exact stop coarse) 

● IS: DB31,... DBX60.6 (position reached with exact stop coarse) 

Exact stop fine 

Window around the setpoint position within which exact stop fine is detected.   

● MD36010 $MA_STOP_LIMIT_FINE (exact stop fine) 

● IS: DB31,... DBX60.7 (position reached with exact stop coarse) 

Delay time exact stop fine 

Delay time after which the actual value must have reached the tolerance window "Exact stop 
fine" when the setpoint position is reached. 

● MD36020 $MA_POSITIONING_TIME (delay time exact stop fine) 

● Alarm: "25080 Positioning monitoring" and follow-up mode 

Zero speed tolerance 

Position tolerance which a standing machine axis may not leave.   

● MD36030 $MA_STANDSTILL_POS_TOL (standstill tolerance) 

● Alarm: "25040 Zero speed control" and follow-up mode 



 Commissioning the NC 
 7.3 Parameterize axis data 

CNC Commissioning: NC, PLC, Drive 
Commissioning Manual, 03/2013, 6FC5397-2AP40-3BA1 191 

Delay time zero speed monitoring 

Delay time after which the actual value must have reached the tolerance window "zero 
speed tolerance" when the setpoint position is reached. 

● MD36040 $MA_STANDSTILL_DELAY_TIME (Zero-speed monitoring delay time) 

● Alarm: "25040 Zero speed control" and follow-up mode 

Clamping tolerance 

Tolerance window for a standing machine axis while the signal "Clamping active" is present 
at the PLC interface.   

● MD36050 $MA_CLAMP_POS_TOL (clamping tolerance) 

● IS: DB31,... DBX2.3 (clamping active) 

● Alarm: "26000 Clamping monitoring" 

 
Figure 7-10 Static monitoring functions 

Working area limitation 

The permissible working area of the machine axes can be adapted to the particular 
machining situation using the "dynamic" working area limitation.   

● SD43400 $SA_WORKAREA_PLUS_ENABLE (working area limitation active in the 
positive direction) 

● SD43410 $SA_WORKAREA_MINUS_ENABLE (working area limitation active in the 
negative direction) 

● SD43420 $SA_WORKAREA_LIMIT_PLUS (working area limitation plus) 

● SD43430 $SA_WORKAREA_LIMIT_MINUS (working area limitation minus) 
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● Alarm: "10630 Axis reaching operating range limit +/-" 

● Alarm: "10631 Axis is at operating range limit +/- (JOG)" 

● Alarm: "10730 Progr. end point is behind working area limitation +/-" 

Software limit switch   

Two software limit switch pairs are provided per machine axis. The active software limit 
switch pair is selected in the PLC.  

● MD36100 $MA_POS_LIMIT_MINUS (1st software limit switch minus) 

● MD36110 $MA_POS_LIMIT_PLUS (1st software limit switch plus) 

● MD36120 $MA_POS_LIMIT_MINUS2 (2nd software limit switch minus) 

● MD36130 $MA_POS_LIMIT_PLUS2 (2nd software limit switch plus) 

● IS: DB31,... DBX12.2 (2nd software limit switch minus) 

● IS: DB31,... DBX12.3 (2nd software limit switch plus) 

● Alarm: "10620 Axis reaching software limit switch +/-" 

● Alarm: "10621 Axis is at software limit switch +/- (JOG)" 

● Alarm: "10720 Progr. end point is behind software limit switch +/-" 

  Note 

All position monitoring functions are only active with valid reference point of the 
corresponding reference point of the machine axis. 

Hardware limit switch 

If the PLC signals that a hardware limit switch has been reached, the machine axis is 
stopped with the parameterized brake response.   

● IS: DB31, ... DBX12.1 (hardware limit switch plus) 

● IS: DB31, ... DBX12.0 (hardware limit switch minus) 



 Commissioning the NC 
 7.3 Parameterize axis data 

CNC Commissioning: NC, PLC, Drive 
Commissioning Manual, 03/2013, 6FC5397-2AP40-3BA1 193 

● MD36600 $MA_BRAKE_MODE_CHOICE (braking behavior on hardware limit switch) 

0 = Brake characteristic is complied with 

1 = Rapid deceleration with setpoint "0" 

● Alarm: "21614 Hardware limit switch [+/-]" 

 
Figure 7-11 Overview of end limitations 

Literature 
Function Manual Basic Functions; Axis monitoring: Protection zones (A3) 

7.3.13 Axis monitoring functions (dynamic) 

Dynamic monitoring functions 
The dynamic monitoring functions with reference to a machine axis are:  

Speed setpoint monitoring 
The speed-setpoint monitoring prevents that the max. admissible motor speed is exceeded. 

It must be set such that the max. velocity (rapid traverse) can be reached and, in addition, a 
certain control margin remains. 

● MD36210 $MA_CTRLOUT_LIMIT[n] (maximum speed setpoint as %) 
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Figure 7-12 Speed setpoint limitation 

The following machine data is used to define how long the speed setpoint may remain within 
the limits before the speed-setpoint monitoring responds. 

● MD36220 $MA_CTRLOUT_LIMIT_TIME[n] (delay time for speed-setpoint monitoring) 

Error response 

● Alarm: "25060 Speed-setpoint limiting" 

and stopping the machine axis using a speed-setpoint ramp whose characteristic is set in 

● MD36610 $MA_AX_EMERGENCY_STOP_TIME (braking ramp time when errors occur) 

  

Cause of errors / error handling 

● A measuring circuit error or drive error is present. 

● Setpoints are too high (accelerations, velocities, reducing factors). 

● Obstacle in the machining space (e.g. tool hits working table) => remove obstacle. 

The speed setpoint consists of the speed setpoint of the position controller and the 
feedforward control parameter (if feedforward control is active). 

 
Figure 7-13 Speed setpoint calculation 
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 Note 

The limitation of the speed setpoint will turn the control loop into a non-linear control loop. 

Generally, this will result in deviations from the contour and longer dwelling of the machine 
axis within the speed-setpoint limitation. 

 

Actual velocity monitoring 
Monitoring due to the actual velocity of the machine axis determined based on the encoder 
values  

● MD36020 $MA_AX_VELO_LIMIT (velocity-monitoring threshold) 

Error response 

● Alarm: "25030 Alarm limit of actual velocity" 

and stopping the machine axis using a speed-setpoint ramp whose characteristic is set in 

● MD36610 $MA_AX_EMERGENCY_STOP_TIME (braking ramp time when errors occur) 

Error correction 

● Check actual values 

● Check position control direction (control sense) 

● Threshold value for velocity monitoring is possibly too low. 

Contour monitoring 

Monitoring of the difference between the following error measured and the following error 
calculated from the position setpoint.  

● MD36400 CONTOUR_TOL (contour monitoring tolerance range) 

Error response 

● Alarm: "25050 Contour monitoring" 

and stopping the machine axis using a speed-setpoint ramp whose characteristic is set in 

● MD36610 $MA_AX_EMERGENCY_STOP_TIME (braking ramp time when errors occur) 
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Error correction 

Contour errors are caused by signal distortions in the position control loop.  

● Increase the tolerance band 

● Check the KV factor: 

The real KV factor must correspond to the desired KV factor, set via 
MD32200 $MA_POSCTRL_GAIN[n] (KV factor). 

"Diagnostics" operating area → Menu forward key → "Axis diagnostics" → "Service axis" 

● Check optimization of the speed controller 

● Check smooth running of the axes 

● Check machine data for traversing motions 

(feed override, acceleration, max. velocities, ... ) 

● For operation with feedforward control: 

MD32810 $MA_EQUIV_SPEEDCTRL_TIME (equivalent time constant of speed control 
loop for feedforward control) or if the machine data is imprecisely set, the MD36400 
$MA_CONTOUR_TOL must be enlarged. 

Encoder limit frequency monitoring  

Monitoring of the limit frequency of the encoder of a machine axis.  

● MD36300 $MA_ENC_FREQ_LIMIT (encoder limit frequency) 

Error response 

● Alarm: "21610 Encoder frequency exceeded" 

● IS: DB31, ... DBX60.2 "Encoder limit frequency exceeded 1" 

● IS: DB31, ... DBX60.3 "Encoder limit frequency exceeded 2" 

and stopping the machine axis using a speed-setpoint ramp whose characteristic is set in 

● MD36610 $MA_AX_EMERGENCY_STOP_TIME (braking ramp time when errors occur) 

Error correction 

After the axes have come to a stop, the position control is resumed after the alarm (RESET 
at the machine control panel) is acknowledged. 

 

 Note 

The relevant axis must be re-referenced. 
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Encoder zero-mark monitoring 
The zero-mark monitoring of the encoder of a machine axis checks whether pulses were lost 
between two zero mark passes.  

● MD36310 $MA_ENC_ZERO_MONITORING (zero-mark monitoring) 

is used to enter the number of detected zero-mark errors at which the monitoring is to 
respond. 

Special feature: A value of 100 will additionally disable the hardware monitoring of the 
encoder. 

Error response 

● Alarm: "25020 Zero-mark monitoring" 

and stopping the machine axes using a speed setpoint ramp whose characteristic is set in 

● MD36610 $MA_AX_EMERGENCY_STOP_TIME (braking ramp time when errors occur) 
is set 

Error causes 

● MD36300 $MA_ENC_FREQ_LIMIT [n] (encoder limit frequency) set too high 

● Encoder cable damaged 

● Encoder or encoder electronics defective 

Position tolerance when switching over the encoder 

It is possible to switch between the two encoders or position measuring systems of a 
machine axis at any time. The permissible position difference between the two position 
measuring systems when switching over is monitored.  

● MD36500 $MA_ENC_CHANGE_TOL (max. tolerance on actual position value 
switchover) 

Error response 

● Alarm: "25100 Measuring system cannot be switched over" 

The requested switchover to another encoder is not carried out. 

Error causes 

● The specified permissible tolerance is too small. 

● The position measuring system to which you want to switch over to is not referenced. 
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Cyclical monitoring of the encoder position tolerance 
The position difference between the two encoders or position measuring systems of a 
machine axis is monitored with:  

● MD36510 $MA_ENC_DIFF_TOL (measuring system synchronism tolerance) 

Error response 

● Alarm: "25105 Measuring systems are not synchronous" 

and stopping the machine axes using a speed setpoint ramp whose characteristic is set in 
the following machine data: 

● MD36610 $MA_AX_EMERGENCY_STOP_TIME (braking ramp time when errors occur) 

 
Figure 7-14 Monitoring for SINUMERIK 840D sl: 

 

 Note 
Braking ramp 

MD36620 $MA_SERVO_DISABLE_DELAY_TIME (switch-off delay controller enable) must 
always be selected greater than MD36610 $MA_AX_EMERGENCY_STOP_TIME (duration 
of the braking ramp for error states). 

If this is not the case, the braking ramp cannot be kept. 
 

References 
Function Manual Basic Functions; Axis monitoring: Protection zones (A3) 
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7.4 Axis homing 

Referencing 

When referencing a machine axis, the actual position value system of the machine axis is 
synchronized with the machine geometry. Depending on the encoder type used, the machine 
axis is referenced with or without traversing movements.  

Reference point approach 

For all machine axes which are not equipped with an encoder providing an absolute actual 
position value, referencing is carried out by traversing the machine axis to a reference point; 
this is called the reference point approach. 

The reference point approach can be carried out either manually in JOG mode, submode 
REF, or using a parts program.  

With the operating mode JOG and submode REF, reference point approach is started using 
traverse direction keys PLUS or MINUS (depending on the parameterized reference point 
approach direction). 

7.4.1 Incremental measuring system 

Incremental measuring systems 
With incremental measuring systems, referencing is carried out using a reference point 
approach divided into three phases: 

1. Traversing to the reference cam 

2. Synchronizing to the encoder zero mark 

3. Approach reference point 
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Figure 7-15 Signal chart: Referencing with an incremental measuring system (principle) 

Phase-independent data 
The following machine data and interface signals are relevant in each of the individual 
phases of the reference point approach: 

● MD11300 $MN_JOG_INC_MODE_LEVELTRIGGRD (INC/REF in jog mode) 

● MD34000 $MA_REFP_CAM_IS_ACTIVE (axis with reference cam) 

● MD34110 $MA_REFP_CYCLE_NR (axis sequence for channel-specific reference point 
approach) 

● MD30240 $MA_ENC_TYPE (encoder type) 

● MD34200 $MA_ENC_REFP_MODE (referencing mode) 

● IS: DB21, ... DBX1.0 ("Activate referencing") 

● IS: DB21, ... DBX33.0 ("Referencing active") 

Phase 1: Traversing to the reference cam 
The following machine data and interface signals are relevant: 

● MD34010 $MA_REFP_CAM_DIR_IS_MINUS (approach reference cam in minus 
direction) 

● MD34020 $MA_REFP_VELO_SEARCH_CAM (reference cam approach velocity) 

● MD34030 $MA_REFP_MAX_CAM_DIST (maximum distance to the reference cam) 

● MD34092 $MA_REFP_CAM_SHIFT (electr. cam offset, incremental measuring systems 
with equidistant zero marks) 
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● IS: DB21, ... DBX36.2 ("All axes with obligatory reference point are referenced") 

● IS: DB31, ... DBX4.7/DBX4.6 ("Traversing keys plus/minus") 

● IS: DB31, ... DBX12.7 ("Reference point approach delay") 

● IS: DB31, ... DBX60.4, DBX60.5 ("Referenced/synchronized 1, 2") 

Properties of phase 1: 

● The feed override (feedrate switch) is active. 

● The feed stop (channel-specific and axis-specific) is active. 

● The machine axis can be stopped and restarted with NC-stop/NC-start. 

● The machine axis traverses a distance specified in the following machine data from the 
starting position in the direction of the reference cam, without reaching the reference 
cam. 

– MD34030 $MA_REFP_MAX_CAM_DIST (max. distance to reference cam) 

● The following interface signal is set to "0". The axis stops, and alarm 20000 "Reference 
cam not reached" is output. 

– IS: DB31, ... DBX12.7 ("Reference point approach delay") = 0 

WARNING  
 

Setting the reference cam  

If the reference cam is not calibrated exactly, it is possible that a wrong zero mark is 
evaluated after the reference cam has been left. As a result, the control system will 
take a wrong machine zero.  

Software limit switches, protection areas and work area limits will thus also be active 
for the wrong positions. The difference is equivalent to one measuring system 
revolution in each case. 

Danger for man and machine exists. 

Phase 2: Synchronizing to the encoder zero mark 
The following machine data and interface signals are relevant: 

● MD34040 $MA_REFP_VELO_SEARCH_MARKER (creep velocity) 

● MD34050 $MA_REFP_SEARCH_MARKER_REVERSE (direction reversal on reference 
cam) 

● MD34060 $MA_REFP_MAX_MARKER_DIST (maximum distance from cam to reference 
mark) 
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Properties of phase 2: 

● Feed override (the feed override switch) is not active. 

If a feed override of 0% is selected via the feed override switch, the traverse motion is 
stopped. 

● Feed stop (channel-specific and axis-specific) is active. 

On a feed stop, the traverse motion is stopped and the alarm displayed: 20005 
"Reference point approach canceled" 

● NC-Stop/NC-Start is inactive. 

● With IS: DB31, ... DBX12.7 ("Reference point approach delay") = 0, the machine axis 
traverses a distance parameterized in the following machine data after leaving the 
reference cam: 

MD34060 $MA_REFP_MAX_MARKER_DIST (max. distance to the reference mark) 

Without the zero mark being detected, the machine axis stops and the following alarm is 
displayed: 20002 "Zero mark missing" 

Phase 3: Approach reference point 
The following machine data and interface signals are relevant: 

● MD34070 $MA_REFP_VELO_POS (reference point positioning velocity) 

● MD34080 $MA_REFP_MOVE_DIST (reference point distance to zero mark) 

● MD34090 $MA_REFP_MOVE_DIST_CORR (reference point offset, additive) 

● MD34100 $MA_REFP_SET_POS (reference point value) 

● IS: DB31, ... DBX2.4, 2.5, 2.6, 2.7 ("Reference point value 1...4") 

● IS: DB31, ... DBX60.4, DBX60.5 ("Referenced/synchronized 1, 2") 

Properties of phase 3: 

● Feed override (the feed override switch) is active. 

● Feed stop (channel-specific and axis-specific) is active. 

● NC-Stop/NC-Start is active. 

References 
Basic Functions Function Manual; Reference Point Travel (R1) 
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7.4.2 Distancecoded reference marks 

Distancecoded reference marks 
When dictance-coded reference marks are used, referencing is divided into two phases:   

1. Synchronize by overriding two reference marks 

2. Traverse to target point 

 
Figure 7-16 Signal chart: Distance-coded reference marks (principle) 

Phase-independent data 
The following machine data and interface signals are independent with respect to the 
individual phases of reference point approach: 

● MD11300 $MN_JOG_INC_MODE_LEVELTRIGGRD (INC/REF in jog mode) 

● MD34000 $MA_REFP_CAM_IS_ACTIVE (axis with reference cam) 

● MD34110 $MA REFP_CYCLE_NR (axis sequence for channel-specific reference point 
approach) 

● MD30240 $MA ENC_TYPE (encoder type) 

● MD34200 $MA ENC_REFP_MODE (referencing mode) 

● MD34310 $MA ENC_MARKER_INC (interval between two reference marks) 

● MD34320 $MA ENC_INVERS (inverse measuring system) 

● IS: DB21, ... DBX1.0 ("Activate referencing") 

● IS: DB21, ... DBX33.0 ("Referencing active") 
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Phase 1: Synchronize by overriding two reference marks 
The following machine data and interface signals are relevant: 

● MD34010 $MA REFP_CAM_DIR_IS_MINUS (approach reference cam in negative 
direction) 

● MD34040 $MA REFP_VELO_SEARCH_MARKER (referencing velocity) 

● MD34060 $MA REFP_MAX_MARKER_DIST (maximum distance between two reference 
marks) 

● MD34300 $MA ENC_REFP_MARKER_DIST (reference mark distance) 

● IS: DB21 .. 30, DBX36.2 ("All axes to be referenced are referenced") 

● IS: DB31, ... DBX4.7/DBX4.6 ("Traversing keys plus/minus") 

● IS: DB31, ... DBX12.7 ("Reference point approach delay") 

● IS: DB31, ... DBX60.4, DBX60.5 ("Referenced/synchronized 1, 2") 

Properties of phase 1: 

● If the machine axis travels from the initial position a distance defined in 

MD34300 $MA REFP_MARKER_DIST (max. distance to the reference mark) without two 
reference marks being overridden, then the machine axis stops and the system issues  

alarm 20004 "Reference mark missing". 

Phase 2: Traversing to the target point 
The following machine data and interface signals are relevant: 

● MD34070 $MA REFP_VELO_POS (target point positioning velocity) 

● MD34090 $MA REFP_MOVE_DIST_CORR (absolute offset) 

● MD34100 $MA REFP_SET_POS (target point) 

● MD34330 $MA REFP_STOP_AT_ABS_MARKER (with/without target point) 

● IS: DB31, ... DBX60.4, DBX60.5 ("Referenced/synchronized 1, 2") 

Properties of phase 2: 

● The feed override (feedrate switch) is active. 

● The feed stop (channel-specific and axis-specific) is active. 

● The machine axis can be stopped and restarted with NC-stop/NC-start. 
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Determining the absolute offset 

To determine the absolute offset between the measuring system zero point and the machine 
zero, the following procedure is recommended: 

1. Determine the actual position of the measuring system 

After two reference marks following one after the other (synchronized) have been 
overtraveled, the actual position of the length measuring system can be read on the user 
interface at "Actual position".  

The absolute offset must be zero at this time: 

● MD34090 $MA REFP_MOVE_DIST_CORR = 0 

1. Determine the absolute machine actual position 

Determining the absolute machine actual position, e.g. can be performed by traversing 
the machine axis to a known position (fixed stop). Alternatively, it can be measured at any 
position (laser interferometer). 

2. Calculate the absolute offset 

Linear measurement system non-inverse to machine system: 

Absolute offset = actual machine position + actual position of the measuring system 

Linear measuring system inverse to machine system: 

Absolute offset = actual machine position - actual position of the measuring system 

● MD34090 $MA REFP_MOVE_DIST_CORR (reference point / absolute offset) 

WARNING  
 

Machine measurement 

The position measuring system must be re-referenced after the absolute offset has been 
determined and entered in the following machine data:  
 MD34090 $MA REFP_MOVE_DIST_CORR (absolute offset) 

References 
Basic Functions Function Manual; Reference Point Travel (R1) 

7.4.3 Absolute encoder homing 

Machine axes with absolute encoders   
The advantage of machine axes with absolute encoders is that after a one-time adjustment 
process, the reference point approach necessary for incremental measuring systems (e.g. 
run-up of control, de-selection of "parking" of machine axes etc.) can be skipped and the 
actual value system of the machine axis can be immediately synchronized with the 
determined absolute position. 



Commissioning the NC  
7.4 Axis homing 

 CNC Commissioning: NC, PLC, Drive 
206 Commissioning Manual, 03/2013, 6FC5397-2AP40-3BA1 

Adjustment of absolute encoders   
To adjust an absolute encoder, the actual value of the encoder is harmonized with the 
machine zero point once and then enabled. 

The current status of an absolute encoder is displayed in the following axis-specific machine 
data of the machine axis to which it is connected: 

MD34210 $MA_ENC_REFP_STATE (status of absolute encoder)  

 
Value Meaning 
0 Encoder not adjusted 
1 Encoder adjustment released 
2 Encoder is adjusted 

Adjustment types 
The following adjustment types are supported: 

● Adjustment by entering the reference point offset 

● Adjustment by entering the reference point value 

● Automatic adjustment by means of a probe 

● Adjustment with BERO 

Readjustment 
Readjustment of the absolute encoder is required after: 

● Gear change between load and absolute encoder 

● Removal/installation of the absolute encoder 

● Removal/installation of the motor with the absolute encoder 

● Data loss in the static NC memory 

● Battery failure 

● Setting actual value (PRESETON) 

It is only during the following events that the controller can detect that a readjustment of the 
absolute encoder is required: 

● Gear change with change of transformation ratio 

● Response of the zero mark monitoring 

● New encoder serial number after change of the absolute encoder 

The controller then sets the status of the absolute encoder to "0":  
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● MD34210 $MA_ENC_REFP_STATE = 0 (encoder not adjusted) 

The following alarm is displayed: 

Alarm 25022 "Axis <axis identifier> encoder <number> warning 0" 

When the zero mark monitoring responds, the following alarm is also displayed: 

Alarm 25020 "Axis <axis identifier> zero mark monitoring of the active encoders" 

NOTICE  
 

Adjustment mandatory 

In all other cases (e.g. PRESETON), it is the sole responsibility of the user to carry out a 
readjustment by manually setting MD34210 to the value "0". 

WARNING  
 

Data backup 

During the backup of machine data of a machine A, the encoder status (MD34210) of 
the machine axes is also backed up. When this data record is loaded into a machine B 
of the same type, e.g. in the context of series-start-up or after a service case, the 
relevant machine axes will be automatically regarded as adjusted/referenced by the 
NCK.  

The machine manufacturer/user is specifically responsible for undertaking a 
readjustment in such cases. 

See also: MD30250 $MA_ACT_POS_ABS (Absolute encoder position at the time of 
switch-off)  

References 
Basic Functions Function Manual; Reference Point Travel (R1) 
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7.5 Parameterization of spindle data 

7.5.1 Setpoint/actual value channels of spindle 
Parameterization of the setpoint/actual value channels of a spindle is identical to 
parameterization of the setpoint and actual value channels of an axis. For this, see Section 
"Setpoint / actual value channels" (Page 174).   

7.5.2 Gear stages 

Enable 
The gear stage change is generally carried out in the following machine data:   

● MD35010 $MA_GEAR_STEP_CHANGE_ENABLE (gear stage change possible, spindle 
has several gear stages)  

If this machine data is not set, the system assumes that the spindle has no gear stages. 

Multiple gearbox steps 
If more than one gearbox step exists, the number of gearbox steps is entered into 
MD35090 $MA_NUM_GEAR_STEPS. 

Parameter sets 
In spindle mode of a spindle, the NC will select the parameter set that suits the current gear 
stage best.   

Gear stage x => parameter set (x+1) => index [x] 

In axis mode of a spindle, the NC always selects the 1st parameter set (index [0], 
independent of the current gear stage 

The machine data listed in the following are gear stage-dependent machine data of a 
spindle: 

● MD35110 $MA_GEAR_STEP_MAX_VELO[n] (nmax for gear stage change) 

● MD35120 $MA_GEAR_STEP_MIN_VELO[n] (nmin for gear stage change) 

● MD35130 $MA_GEAR_STEP_MAX_VELO_LIMIT[n] (nmax for gear stage) 

● MD35135 $MA_GEAR_STEP_PC_MAX_VELO_LIMIT (nmax for gearbox step with 
position-control) 

● MD35140 $MA_GEAR_STEP_MIN_VELO_LIMIT[n] (nmin for gear stage) 
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● MD35200 $MA_GEAR_STEP_SPEEDCTRL_ACCEL[n] (acceleration in speed-control 
mode) 

● MD35210 $MA_GEAR_STEP_POSCTRL_ACCEL[n] (acceleration in position control 
mode) 

For further information on parameter sets, see Section "Axis/spindle parameter sets" 
(Page 167). 

Literature 
Function Manual Basic Functions; Spindles: Gear stage change (S1) 

7.5.3 Spindle measuring systems 

Encoder matching    
When parameterizing the measuring systems of spindles, the same conditions apply as for 
parameterization of the measuring systems of rotary axes. This multiple is 2048.  

For incremental measuring systems see Section "Parameterization of incremental measuring 
systems" (Page 171). 

For absolute measuring systems see Section "Parameterization of absolute measuring 
systems" (Page 172). 

 

 Note 

If the motor encoder is used for actual-value sensing, the encoder matching must be entered 
in the machine data for each individual gear stage if there are several gear stages. 

 

Pulse multiplication   
The maximum multiplication of the appropriate drive is always used as the multiplication of 
the increments.  

Examples of encoder adaptation 

Example A: encoder on the spindle 

Suppose the following conditions are provided: 

● The incremental encoder is mounted on the spindle. 

● Encoder pulses = 500 [pulses/rev.] 

● Pulse multiplication = 128 

● Internal precision = 1000 [increment/degree] 
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● Sensor ratio = 1:1 

● Load ratio = 1:1 

The machine data are set acc. to the values above: 

● MD10210  $MN_INT_INC_PER_DEG (computational resolution) = 1,000 [incr./degree] 

● MD31020 $MA_ENC_RESOL (encoder resolution) = 500 [pulses/revolution] 

● MD31050 $MA_DRIVE_AX_RATION_DENOM (load rev. denominator) = 1 

● MD31060 $MA_DRIVE_AX_RATION_NUMERA (load rev. numerator) = 1 

● MD31070 $MA_DRIVE_ENC_RATION_DENOM (sensor speed denominator) = 1 

● MD31080 $MA_DRIVE_ENC_RATION_NUMERA (sensor speed numerator) = 1 

 

 
One encoder increment corresponds to 5.625 internal increments. 

One encoder increment corresponds to 0.005625 degrees (highest possible positioning 
resolution). 

Example B: encoder at motor 

Suppose the following conditions are provided: 

● The incremental encoder is mounted on the motor. 

● Encoder pulses = 2048 [pulses/rev.] 

● Pulse multiplication = 128 

● Internal precision = 1000 [increment/degree] 

● Sensor ratio = 1:1 

● Load ratio 1= 2.5:1 [motor speed/spindle speed] 

● Load ratio 2= 1:1 [motor speed/spindle speed] 

Gear stage 1 

 
 

 
One encoder increment corresponds to 0.54932 internal increments. 

One encoder increment corresponds to 0.00054932 degrees (highest possible positioning 
resolution). 
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Gear stage 2 

 
One encoder increment corresponds to 1.3733 internal increments. 

One encoder increment corresponds to 0.0013733 degrees (highest possible positioning 
resolution). 

7.5.4 Speeds and setpoint adjustment for spindle 

Speeds, gear stages    
Data for five gear stages is implemented for SINUMERIK 840D sl. These stages are defined 
by a minimum and maximum speed for the stage itself and by a minimum and maximum 
speed for the automatic gear stage change.  

A new set gear stage is output only if the new programmed speed cannot be traversed in the 
current gear stage. For the sake of simplification, the oscillation times for gear stage 
changes can be specified directly in the NC; the oscillation function must otherwise be 
implemented in the PLC. The oscillation function is initiated via the PLC. 

 
Figure 7-17 Example for speed ranges for automatic gear stage selection (M40) 
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Speeds for conventional operation 
The speeds of the spindle for conventional mode are entered in the following machine data:  

● MD32010 $MA_JOG_VELO_RAPID (rapid traverse in jog mode) 

● MD32020 $MA_JOG_VELO (axis velocity in JOG mode) 

The direction of rotation is specified via the appropriate directional keys for the spindle on the 
machine control panel. 

Direction of rotation 
The direction of rotation of a spindle corresponds to the traversing direction of an axis. 

Setpoint matching   
The speeds must be transferred with standardized values for the drive controller. The values 
are scaled in the NC using the selected load gear and the appropriate drive parameter.  

Machine data 
 
MD Identifier Meaning 
31050 $MA_DRIVE_AX_RATIO_DENOM Denominator load gearbox 
31060 $MA_DRIVE_AX_RATIO_NUMERA Numerator load gearbox 
32010 $MA_JOG_VELO_RAPID Rapid traverse in jog mode 
32020 $MA_JOG_VELO JOG axis velocity 
35010 $MA_GEAR_STEP_CHANGE_ENABLE Gear stage change possible 
35020 $MA_SPIND_DEFAULT_MODE Basic spindle setting 
35030 $MA_SPIND_DEFAULT_ACT_MASK Activate initial spindle setting 
35040 $MA_SPIND_ACTIVE_AFTER_RESET Spindle active after reset 
35200 $MA_GEAR_STEP_SPEEDCTRL_ACCEL[n] Acceleration in speed control mode 
35220 $MA_ACCEL_REDUCTION_SPEED_POINT Speed limit for reduced acceleration 
35230 $MA_ACCEL_REDUCTION_FACTOR Reduced acceleration 
35400 $MA_SPIND_OSCILL_DES_VELO Oscillation speed 
35410 $MA_SPIND_OSCILL_ACCEL Oscillation acceleration 
35430 $MA_SPIND_OSCILL_START_DIR Oscillation start direction 
35440 $MA_SPIND_OSCILL_TIME_CW Oscillation time for M3 direction 
35450 $MA_SPIND_OSCILL_TIME_CCW Oscillation time for M4 direction 
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7.5.5 Position spindle 

Functionality  
The NC provides an oriented spindle stop function with which the spindle can be moved into 
a certain position and held there (e.g. for tool changing purposes). Several programming 
commands are available for this function which define the approach and program 
processing.  

● To absolute position (0-360 degrees) 

● Incremental position (+/- 999999.99 degrees) 

● Positioning without influence of block change (SPOSA) 

● Block change when block end position is reached (calculated by interpolation) 

The controller brakes the spindle down to position-control speed at the acceleration rate for 
speed operation.  

If the position-control speed has been reached, the controller branches into position-control 
mode and the acceleration rate for position-control mode and the KV factor become active. 

The interface signal "Exact stop fine" is output to indicate that the programmed position has 
been reached (block change when position reached). 

Acceleration rate for position-control mode must be set such that the current limit is not 
reached. Acceleration rate must be entered separately for each gear step. 

If the spindle is positioned from zero speed, it is accelerated up to a maximum speed 
corresponding to position-control speed; the direction is defined via machine data. If no 
reference is present, the direction of motion is specified as in 
MD35350 $MA_SPIND_POSITIONING_DIR . The contour monitoring function is activated as 
soon as the control mode switches to position control. 

Machine data 
 
MD Identifier Meaning 
35300 $MA_SPIND_POSCTRL_VELO Position-control activation speed 
35350 $MA_SPIND_POSITIONING_DIR Direction of rotation when positioning from 

standstill 
35210 $MA_GEAR_STEP_POSCTRL_ACCEL Acceleration in position-control mode 
36000 $MA_STOP_LIMIT_COARSE Exact stop coarse 
36010 $MA_STOP_LIMIT_FINE Exact stop fine 
32200 $MA_POSCTRL_GAIN KV factor 
36400 $MA_CONTOUR_TOL Contour monitoring 

Literature 
Function Manual, Basic Functions; Spindles (S1) 
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7.5.6 Synchronizing spindle 

Overview 
To allow the spindle to be positioned from the NCK, its position has to be adjusted using the 
measuring system. This operation is called "synchronization". As a rule, synchronizing is 
done to the zero mark of the connected encoder or to a reference cam as zero mark 
substitute. 

The following machine data defines the actual position of the spindle at the zero-mark 
position: 

● MD34100 $MA_REFP_SET_POS (reference point value) 

The zero-mark offset is entered in the following machine data: 

● MD34090 $MA_REFP_MOVE_DIST_CORR (reference point offset) 

The following machine data specifies which signal is used for synchronization: 

● MD34200 $MA_ENC_REFP_MODE (referencing mode) 
1 = Encoder zero mark 
2 = Bero 

When is synchronization necessary?   
The spindle will be synchronized: 

● After the NC has powered up when the spindle is moved using a programming command 

● After a request for resynchronization by the PLC 

NST DB31,... DBX16.4 (resynchronize spindle 1) 

NST DB31,... DBX16.5 (resynchronize spindle 2) 

● After each gear stage change for an indirect measuring system 

MD31040 $MA_ENC_IS_DIRECT (direct measuring system) = 0 

● When the encoder limit frequency falls below the programmed value after a speed has 
been programmed which is above the encoder limit frequency. 

NOTICE  
 

Synchronization via BERO signal 

If the spindle encoder is not mounted directly on the spindle and there are gear ratios 
between the encoder and spindle (e.g. encoder mounted on motor), then a BERO signal 
connected to the drive (SERVO) must be used for synchronization. The control system 
then automatically resynchronizes the spindle after each gear stage change. The user 
does not have to contribute anything here. 

In general, backlash, gearbox elasticity and the BERO hysteresis reduce the accuracy 
achievable during synchronization. 
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Machine data 
 
MD Identifier Meaning 
34100 $MA_REFP_SET_POS Reference point value 
34090 $MA_REFP_MOVE_DIST_CORR Reference point offset 
34200 $MA_REFP_MODE Referencing mode 

 

7.5.7 Spindle monitoring 

Spindle stationary 
The maximum permissible spindle speed up to which spindle standstill is detected, is set 
using machine data:   

● MD36060 $MA_STANDSTILL_VELO_TOL (max. speed "Spindle stationary") 

If the actual speed falls below this speed limit, the NC/PLC interface signal is set: 

● DB31,... DBX61.4 = 1 (spindle stationary) 

Enabling path feed 

Precondition: 

● The spindle is in the open-loop control mode 

● MD35510 $MA_SPIND_STOPPED_AT_IPO_START == TRUE (feed enable for "Spindle 
stationary") 

The path feed is enabled when both conditions are fulfilled: 

● (actual speed of the spindle) < (MD36060 $MA_STANDSTILL_VELO_TOL) 

● DB31,... DBX61.4 == 1 (spindle stationary) 

Spindle in setpoint range 
If the spindle reaches the tolerance range specified in the following machine data, then the 
interface signal IS DB31,... DBX83.5 (spindle in setpoint range) is set: 

● MD35150 $MA_SPIND_DES_VELO_TOL (spindle speed tolerance) 

The path feedrate is then released in the following set machine data: 

● MD35510 $MA_SPIND_STOPPED_AT_IPO_START (feed enable for "Spindle stopped") 
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Maximum spindle speed 
The maximum spindle speed can be set using the following system data: 

● Machine-dependent maximum speed via machine data 
MD35100 $MA_SPIND_VELO_LIMIT (max. spindle speed) 

● Process-dependent maximum speed via immediately effective setting data 
SD43235 $SA_SPIND_USER_VELO_LIMIT (max. spindle speed) 

The NC limits the spindle speed to the lower of the two values. 

Error response: 

If the speed is nevertheless exceeded by the speed tolerance (drive error), the following 
signal is output: 

● DB31,... DBX83.0 = 1 (speed limit exceeded) 

● Alarm "22150 Maximum number of chucks exceeded" 

The following machine data also limits the speed of the spindle: 

● MD36200 $MA_AX_VELO_LIMIT (velocity-monitoring threshold) 

When the speed is exceeded, an alarm is generated. 

In position-control mode (e.g. SPCON), the NC limits the specified maximum speed specified 
in the machine or setting data to 90% of the maximum value (control reserve). 

Gear stage speed min./max. 
The default of a max./min. gear stage speed is entered in the following machine data: 

● MD35130 $MA_GEAR_STEP_MAX_VELO_LIMIT (maximum speed for gear stage) 

● MD35140 $MA_GEAR_STEP_MIN_VELO_LIMIT (minimum speed for gear stage) 

The speed cannot leave this range when the appropriate gear stage is engaged. 

Programmed spindle speed limitations 
The following functions can be used to specify a spindle speed limitation in an indexing 
program: 

● G25 S... (min. spindle speed) 

● G26 S... (max. spindle speed) 

The limitation is active in all operating modes. 

The function LIMS=... can be used to specify a spindle speed limit for G96 (constant cutting 
rate): 

● LIMS=... (speed limitation (G96)) 

This limitation is only effective when G96 is active. 
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Encoder frequency limit 
If the encoder frequency limit in the following machine data is exceeded, synchronization of 
the spindle is lost and spindle functionality is reduced (thread, G95, G96): 

● MD36300 $MA_ENC_FREQ_LIMIT (encoder frequency limit) 

The spindle will be re-synchronized automatically once the encoder frequency falls below the 
value defined in the following machine data: 

● MD36302 $MA_ENC_FREQ_LIMIT_LOW (encoder frequency limit at which the encoder 
is turned on again) 

The encoder frequency limit value must be such that the mechanical encoder speed limit is 
not exceeded or else the synchronization from high speeds will be incorrect. 
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Overview of the speed limit values 

 

Literature 
Function Manual Basic Functions; Spindles: Spindle monitoring (S1) 
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7.6 System data 

7.6.1 Resolutions 

Overview    
The following types of resolution, e.g. resolution of linear and angular positions, velocities, 
accelerations and jerk, must be differentiated as follows:  

● The input resolution, i.e. the input of data from the user interface or using the part 
programs. 

● The display resolution, i.e. the display of data on the user interface. 

● The computational resolution, i.e. the internal representation of the data input through the 
user interface or the part program. 

Input and display resolution    
The input and display resolution is specified via the control panel, whereby the display 
resolution of position values can be changed with MD9004 $MM_DISPLAY_RESOLUTION 
(display resolution).  

MD9011 $MM_DISPLAY_RESOLUTION_INCH (INCH measuring system display resolution) 
can be used to configure the display resolution for position values with inch setting. This 
allows you to display up to six decimal places with the inch setting. 

For the programming of part programs, the input resolutions listed in the Programming Guide 
apply. 

Computational resolution   
The computational resolution defines the maximum number of effective decimal places for all 
data the physical unit of which is referred to a length or an angle, e.g. position values, 
velocities, tool offsets, zero offsets, etc.  

The desired computational resolution is defined using the machine data 

● MD10200 $MN_INT_INCR_PER_MM (computational resolution for linear positions) 

● MD10210 $MA_INT_INCR_PER_DEG (computational resolution for angular positions).  

The default assignment is: 

● 1000 increments/mm 

● 1000 increments/degrees 
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The computational resolution thus also determines the maximum achievable precision for 
positions and selected offsets. However, it is essential that the measuring system is adapted 
to this degree of precision. 

 

 Note 

Although the computational resolution is generally independent of the input/display 
resolution, it should have at least the same resolution. 

 

Rounding 

The precision of angle and linear positions is limited to the computational resolution by 
rounding the product of the programmed value with the computational resolution to an 
integer number. 

Example of rounding: 

Computational resolution: 1000 increments/mm 
Programmed path: 97.3786 mm 
Effective value = 97.379 mm 

 

 Note 

To keep rounding easily understandable, it is better to use powers of 10 for the 
computational resolution (100, 1000, 10,000). 

 

Display resolution   
In MD9004 $MM_DISPLAY_RESOLUTION (display resolution), you can set the number of 
decimal places after the decimal point for the position values on the operator panel.  

Input and display limit values 
Limitation of the input values depends on the display features and on the input options on 
the operator panel. The limit is ten digits plus comma and sign.  

Example of programming in the 1 /10 - μm range: 

All the linear axes of a machine are to be programmed and traversed within the range of 
values 0.1 to 1000 mm. 

In order to position accurately to 0.1 μm, the computational resolution must be set to ≥ 104 

incr./mm. 

MD10200 $MN_INT_INCR_PER_MM = 10000 [incr./mm]: 

Example of related part program: 

N20 G0 X 1.0000 Y 1.0000 
;Axes move to position X=1.0000 mm, Y=1.0000 mm 

N25 G0 X 5.0002 Y 2.0003 
;Axes move to position X=5.0002 mm, Y=2.0003 mm 
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Machine data 
 
MD Identifier Comment 
9004 $MM_DISPLAY_RESOLUTION Display resolution 
9011 $MM_DISPLAY_RESOLUTION_INCH Display resolution for INCH system of 

measurement 
10200 $MN_INT_INCR_PER_MM Computational resolution for linear positions 
10210 $MN_INT_INCR_PER_DEG Computational resolution for angular positions 

Literature 
Function Manual, Basic Functions; Velocities, Setpoint-Actual Value Systems, Closed-Loop 
Control (G2) 

7.6.2 Normalization of phys. units of machine data and setting data 

Scaling of physical quantities   
Machine and setting data that have a physical unit are interpreted in the input/output units 
listed in the table "Scaling physical units of machine and setting data" by default, depending 
on the scaling system (metric/inch).  

The internally used units which the NC uses are independent and fixed.  

 
Physical unit Input/output units for the basic system Internally used unit 
 Metric Inch  
Linear position 1 mm 1 inch 1 mm 
Angular position 1 degree 1 degree 1 degree 
Linear velocity 1 mm/min 1 inch/min 1 mm/s 
Angular velocity 1 rpm 1 rpm 1 deg./s 
Linear acceleration 1 m/s2 1 inch/s2 1 mm/s2 
Angular acceleration 1 rev/s2 1 rev/s2 1 degree/s2 
Linear jerk 1 m/s3 1 inch/s3 1 mm/s3 
Angular jerk 1 rev/s3 1 rev/s3 1 degree/s3 
Time 1 sec 1 sec 1 sec 
Position controller servo gain 1 s-1 1 s-1 1 s-1 
Rev. feedrate 1 mm/rev 1 inch/rev 1 mm/degree 
Compensation value linear position 1 mm 1 inch 1 mm 
Compensation value angular position 1 degree 1 degree 1 degree 
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User-defined 
The user can define different input/output units for machine and setting data. This also 
requires an adjustment between the newly selected input/output units and the internal units 
via the following machine data:  

● MD10220 $MN_SCALING_USER_DEF_MASK (Activation of the scaling factors) and 

● MD10230 $MN_SCALING_FACTORS_USER_DEF[n] (Scaling factors of the physical 
quantities) 

 
The following applies: 

Input/output unit selected= 

MD10230 $MN_SCALING_FACTORS_USER_DEF[n] * internal unit 
The selected input/output unit, expressed in the internal units 1 mm, 1 degree and 1 s must 
therefore be entered in MD10230 $MN_SCALING_FACTORS_USER_DEF[n]. 

Table 7- 1 Bit number and index for user definition 

Physical unit MD10220  
Bit number 

MD10230  
Index n 

Linear position 0 0 
Angular position 1 1 
Linear velocity 2 2 
Angular velocity 3 3 
Linear acceleration 4 4 
Angular acceleration 5 5 
Linear jerk 6 6 
Angular jerk 7 7 
Time 8 8 
KV factor 9 9 
Rev. feedrate 10 10 
Compensation value linear position 11 11 
Compensation value angular position 12 12 
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Example 1: 

The data input/output of the linear velocities should be in m/min rather than mm/min (initial 
state). The internal unit is mm/s. 

MD10220 $MN_SCALING_USER_DEF_MASK Bit2 = 1 is used to enter the scaling factor for 
linear velocities as a user-defined value. The scaling factor is calculated using the following 
formula: 

 
Index 2 specifies the "linear velocity". 

Example 2: 

In addition to the change in example 1, the machine data input/output of linear accelerations 
is to be performed in ft/s2, instead of m/s2 (initial state) (the internal unit is mm/s2). 

 
Index 4 specifies the "linear acceleration".  

Machine data 
 
MD Identifier Comment 
10220 $MN_SCALING_USER_DEF_MASK Activation of scaling factors 
10230 $MN_SCALING_FACTORS_USER_DEF[n] Scaling factors of physical quantities 
10240 $MN_SCALING_SYSTEM_IS_METRIC Basic system metric 
10250 $MN_SCALING_VALUE_INCH Conversion factor for switchover to inch 

system 
10260 $MN_CONVERT_SCALING_SYSTEM Basic system switchover active 
10270 $MN_POS_TAB_SCALING_SYSTEM Measuring system of position tables 
10290 $MN_CC_TDA_PARAM_UNIT Physical units of the tool data for CC 
10292 $MN_CC_TOA_PARAM_UNIT Physical units of the tool edge data for CC 
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7.6.3 Modifying scaling machine data 
The scaling of machine data having physical units is defined by the following machine data:   

● MD10220 $MN_SCALING_USER_DEF_MASK (activation of standardizing factors) 

● MD10230 $MN_SCALING_FACTORS_USER_DEF (standardizing factors of the physical 
quantities) 

● MD10240 $MN_SCALING_SYSTEM_IS_METRIC (basic system metric) 

● MD10250 $MN_SCALING_VALUE_INCH (conversion factor for switchover to INCH 
system) 

● MD30300 $MA_IS_ROT_AX (rotary axis) 

When scaling machine data are modified, all machine data affected by this modification due 
to their physical unit are converted with the next NCK reset. 

Example: Redefining an A1 axis from linear to rotary axis. 

The control has been started up with default values. Axis A1 is declared as a linear axis. 

● MD30300 $MA_IS_ROT_AX[A1] = 0 (no rotary axis) 

● MD32000 $MA_MAX_AX_VELO [A1] = 1000 [mm/min] (max. axis velocity). 

Axis A1 is now declared as a rotary axis containing the following machine data: 

● MD30300 $MA_IS_ROT_AX[A1] = 1 (rotary axis) 

● MD32000 $MA_MAX_AX_VELO [A1] = 1000 [mm/min] (max. axis velocity). 

With the next NCK reset, the control system recognizes that axis A1 is defined as a rotary 
axis and standardizes MD32000 $MA_MAX_AX_VELO to [rev./min] with reference to a 
rotary axis. 

● MD30300 $MA_IS_ROT_AX[A1] = 1 (rotary axis) 

● MD32000 $MA_MAX_AX_VELO [A1]= 2.778 [rev./min] 

  Note 

If a scaling machine data item is altered, then the control outputs alarm "4070 Scaling 
data changed". 

Modifying manually 
The following procedure is recommended when modifying scaling machine data manually: 

1. Set all scaling machine data 

2. Carry out NCK reset 

3. Set all dependent machine data after the NC has powered up. 
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7.6.4 Loading default machine data 

Loading standard machine data   
Using the input values listed below in MD11200 $MN_INIT_MD (loading the standard 
machine data during the "next" NC boot), you can load various data storage areas with 
default values on the next NC boot. After setting the machine data, an NCK reset must be 
carried out: 

1. NCK RESET: The machine data is activated. 

2. NCK RESET: Depending on the input value, the corresponding machine data is set to its 
default values and the MD11200 $MN_INIT_MD is reset to "0". 

Input values: 

● MD11200 $MN_INIT_MD = 1 

On the next NC boot, all machine data (with the exception of the memory-configuring 
data) is overwritten with default values. 

● MD11200 $MN_INIT_MD = 2 

On the next NC boot, all memory-configuring machine data is overwritten with default 
values. 

7.6.5 Switching over the measuring system 

Switching over the measuring system   
The measuring system of the complete machine is switched in "Machine" operating area → 
"Settings" → "Switch to inch" ↔" Switch to metric". The actual switchover of the system of 
measurement is performed internally by writing all the necessary machine data and 
subsequently activating them with a Reset (po). 

MD10240 $MN_SCALING_SYSTEM_IS_METRIC and the corresponding 
G70/G71/G700/G710 settings in MD20150 $MC_GCODE_RESET_VALUES are switched 
over automatically and consistently for all configured channels. The value of machine data: 
MD20150 $MC_GCODE_RESET_VALUES[12] varies between G700 and G710. This 
process takes place independently of the protection level currently set. 
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Supplementary conditions 
The switchover occurs only under the following supplementary conditions:  

● MD10260 $MN_CONVERT_SCALING_SYSTEM=1. 

● Bit 0 of MD20110 $MC_RESET_MODE_MASK is set in every channel. 

● All channels are in the Reset state. 

● Axes are not traversing with JOG, DRF or PLC control. 

● Constant grinding wheel peripheral speed (GWPS) is not active. 

Actions such as part program start or mode change are disabled for the duration of the 
switchover. 

If the switchover cannot be performed, this is indicated by a message in the user interface. 
These measures ensure that a consistent set of data is always used for a running program 
with reference to the system of measurement. 

System data 
When switching over the measuring system, from the view of the user, all length-related 
specifications are converted to the new measuring system automatically. This includes: 

● Positions 

● Feedrates 

● Acceleration rates 

● Jerk 

● Tool offsets 

● Programmable, settable and work offsets external and DRF offsets 

● Compensation values 

● Protection zones 

● Machine data 

● JOG and handwheel factors 

After the switchover, all data is available in physical quantities. Data, for which no unique 
physical units are defined, is not converted automatically. 

● R parameters 

● GUDs (Global User Data) 

● LUDs (Local User Data) 

● PUDs (Program global User Data) 

● Analog inputs/outputs 

● Data exchange via FC21 
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The user is prompted to take the current valid measuring system MD10240 
$MN_SCALING_SYSTEM_IS_METRIC into consideration.  

The current system of measurement setting can be read at the PLC interface via the "inch 
system" signal DB10.DBX107.7. DB10.DBB71 can be used to read out the "system of 
measurement change counter". 

Machine data 
 
Number Identifier Comment 
10240 $MN_SCALING_SYSTEM_IS_METRIC Basic system metric 
10250 $MN_SCALING_VALUE_INCH Conversion factor for switchover to inch 

system 
10260 $MN_CONVERT_SCALING_SYSTEM Basic system switchover active 
32711 $MA_CEC_SCALING_SYSTEM_METRIC System of measurement of sag 

compensation 

Literature 
Function Manual, Basic Functions; Velocities, Setpoint-Actual Value Systems, Closed-Loop 
Control (G2) 

7.6.6 Traversing ranges 

Computational resolution and traversing ranges   
The range of values of the traversing range depends directly on the selected computational 
resolution.  

The pre-setting of the machine data for the computational resolution is set as follows: 

● 1000 inc./mm 

● 1000 inc./deg. 

The following traversing ranges result: 

 
 Traversing range in the metric system Traversing range in the inch system 
Linear axes ± 999,999.999 [mm; deg.] ± 399,999.999 [inch; deg.] 
Rotary axes ± 999,999.999 [mm; deg.] ± 999,999.999 [inch; deg.] 
Interpolation parameters I, J, K ± 999,999.999 [mm; deg.] ± 399,999.999 [inch; deg.] 

 

See also 
Resolutions (Page 219) 
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7.6.7 Positioning accuracy of the control system 

Computational resolution and traversing ranges 
The positioning accuracy depends on:   

● The computational accuracy (internal increments/(mm or degrees)) 

● The actual-value resolution (encoder increments/(mm or degrees)). 

The less-precise resolution of both determines the positioning accuracy of the NC. 

The input resolution, the position-control and interpolation clock do not affect the accuracy. 

Machine data 
 
Number Identifier Name / remarks 
10200 $MN_INT_INCR_PER_MM Computational resolution for linear positions 
10210 $MN_INT_INCR_PER_DEG Computational resolution for angular positions 
31020 $MA_ENC_RESOL[n] Encoder pulses per revolution 

 

7.6.8 Cycle times 

Cycle times  
For SINUMERIK 840D sl, the system clock cycle, the position-control cycle and the 
interpolation cycle of the NC are based on the DP cycle time that is configured in the STEP 7 
hardware configuration.  

 

 Note 
Check operating modes 

If you change the cycle times, check the behavior of the control in all operating modes before 
you finish commissioning. 

 

Boundary conditions: 

● For axes with Safety Integrated, the following applies: Max. sampling time 12 ms 

● Maximum number of SERVO axes = 6 per CU (integrated) or NX 

The lower the chosen cycle times (PROFIBUS DP cycle), the higher the control quality for 
the drive and better the surface quality on the workpiece. 
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Basic system clock cycle  
The system clock cycle is set fixed to the ratio of 1:1 with regard to the DP cycle time. The 
active value is displayed in the machine data MD10050 $MN_SYSCLOCK_CYCLE_TIME 
(system clock cycle). It cannot be changed.  

Adapt the DP cycle time in the STEP 7 hardware configuration to the basic system clock 
cycle.  

Position-control cycle  
The position-control cycle (MD10061 $MN_POSCTRL_CYCLE_TIME) is set to the fixed ratio 
1:1 with regard to the system clock cycle. It cannot be changed.  

Position-control cycle offset 
The position-control cycle offset TM is automatically determined in the default setting 
(MD10062 $MN_POSCTRL_CYCLE_DELAY=0).  

The effective position-control offset is displayed in the MD10063[1]. The following values can 
be read out via the MD10063 $MN_POSCTRL_CYCLE_DIAGNOSIS: 

● MD10063[0]= TDX 

● MD10063[1]= TM 

● MD10063[2]= TM + Tpos max 
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The following conditions must be met for explicit specification of the position-control cycle 
offset (MD10062 $MN_POSCTRL_CYCLE_DELAY!=0): 

● Cyclic communication with the DP slaves (drives) must be completed before the position 
controller is started. 

Condition: TM > TDX 

● The position controller must be completed before the DP cycle / system clock cycle is 
completed. 

Condition: TM + TPosition control max < TDP 

 
GC Global control: Broadcast message for cyclic convergence of the equidistance between 

DP master and DP slaves 
Dx Useful data exchange between the DP master and DP slaves 
MSG Non-cyclic services such as DP/V1, token passing 
R CPU time 
Res. Reserve: "Active pause" until the isochronous (equidistant) cycle has expired 
Tpos Computing time requirements for the position controller 
TDP DP cycle time: DP cycle time 
TDX Data exchange time: Total transfer time for all DP slaves 
TM Master time: Offset of the start time for NCK position control 
Figure 7-18 Position-control cycle offset compared to PROFIBUS DP cycle 

Error response 

● Alarm: "380005 PROFIBUS DP: Bus access conflict, type t, counter z" 
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Cause of errors / error handling 

● t = 1 

The position-control cycle offset selected is too small. The cyclic PROFIBUS 
communication with the drives was not yet completed with the start of the position 
controller. 

– Remedy: Increase the position-control cycle offset. 

● t = 2 

The position-control cycle offset selected is too large. The cyclic PROFIBUS 
communication with the drives started before the position controller had finished. The 
position controller requires more CPU time than available within the DP cycle. 

– Remedy: Decrease the position-control cycle offset or increase the DP cycle time. 

Interpolation cycle  
The interpolation cycle may be chosen freely as a whole multiple of the position-control 
cycle.  

● MD10070 $MN_IPO_SYSCLOCK_TIME_RATIO (factor for the interpolation cycle) 

Error response: 

● Alarm 4240: "CPU time overflow at the IPO or position controller level" 

Cause of errors / error handling  

The DP cycle time / position-control cycle, the interpolation cycle, or the NC CPU time share 
is set in such a way that not enough CPU time is available for one of the two cyclic levels of 
the NCK (position controller or interpolator). 

Remedy: Calculate the maximum values for Tpos max and TIPO max (see above) and adapt the 
following machine data: 

 
MD Identifier Remark 
10050 $MN_SYSCLOCK_CYCLE_TIME The system clock cycle is always equal to the 

equidistant PROFIBUS DP cycle.  
10060 $MN_POSCTRL_SYSCLOCK_TIME_R

ATIO 
Factor for the position-control cycle is 
permanently fixed to the factor 1. 

10061 $MN_POSCTRL_CYCLE__TIME Position-control cycle 
10062 $MN_POSCTRL_CYCLE_DELAY Position-control cycle offset 
10063 $MN_POSCTRL_CYCLE_DIAGNOSIS [0] = DP cycle time 

[1] = Position-control cycle offset 
[2] = Position-control cycle offset + max. 
computation time needed by the position 
controller 

10070 $MN_IPO_SYSCLOCK_TIME_RATIO Factor for the interpolation cycle can be freely 
selected in integer multiples. 

10185 $MN_NCK_PCOS_TIME_RATIO Computation time ratio NCK 
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References 
Special Functions, Function Manual; Cycle Times (G3) 

7.6.9 System utilization 

System utilization   
The system utilization is displayed channel-specific in the "Diagnostics" → Menu forward key 
→ "System utilization" operating area:  

 
Figure 7-19 System utilization 

The displayed values have the following significance:         

 
Component Display 
Position controller 
Interpolator 
Preprocessing 

Total utilization of the system: Current, minimum and maximum utilization 
of the NCK in milliseconds. 
 MD10050 $MN_SYSCLOCK_CYCLE_TIME (system clock cycle) 
 MD10061 $MN_POSTCTRL_CYCLE_TIME (position-control cycle) 
 MD10070 $MN_IPO_SYSCLOCK_TIME_RATIO (factor for the 

interpolation cycle) 
 MD10071 $MN_IPO_CYCLE_TIME (interpolation cycle) 
 MD11510 $MN_IPO_MAX_LOAD (time required for synchronized 

actions) 
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Component Display 
Position controller and 
interpolator NC load 

In order to have sufficient reserves for the program processing, the 
maximum load in typical operations should not exceed 75%. The current 
load on the average should not exceed 50%. MD10185 
$MN_NCK_PCOS_TIME_RATIO = 90 (default setting) 

Interpolator buffer level This display indicates whether batch preparation for batch processing can 
commence. Jerky processing in continuous-path mode, if for instance a 
number of short traversing blocks have been programmed in succession, 
is a typical indicator of the IPO buffer idling. Capacity indication is 
channel-specific. 
MD28060 $MC_MM_NUM_IPO_BUFFER_SIZE is displayed as a 
percentage.  

 

See also 
Section Cycle times (Page 228)  

7.6.10 Velocities 

Max. axis velocity and spindle speed    
The maximum possible axis velocities and spindle speeds depend on the machine design, 
drive dynamics and the encoder frequency limit of the individual drives.  

Max. programmable tool path velocity 
The maximum programmable tool path velocity results from the maximum axis velocities of 
the axes involved in the path programmed. 

Max. tool path velocity  
The maximum tool path velocity at which traversing is possible within a part program block 
results as follows:  
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Upper limit  
To guarantee that part program blocks are executed continuously (control margin), the NC 
limits the tool path velocity within a part program block to 90% of the max. possible tool path 
velocity as follows:  

 
For example, in the case of part programs generated by means of a CAD system which 
contain extremely short blocks, this limiting of the path velocity can result in a strong 
reduction of the path velocity over several part program blocks. 

A compressor function can be used to avoid such velocity drops. 

Lower limit  
The minimum tool path or axis velocity at which traversing is possible results from:  

 
If Vmin is not reached, no traversing motion is carried out. 

Literature 
You can find further details in: 

● Programming Manual Work Preparation: Special motion commands (COMPON, 
COMPCURVE) 

● Function Manual, Basic Functions; Velocities, Setpoint-Actual Value Systems, Closed-
Loop Control (G2) 
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7.7 Memory configuration 

Memory division   
On the SINUMERIK 840D sl, the persistent data is divided into various independent areas: 
Siemens, manufacturer, user.  

The memory available in the NCK is displayed on the user interface in the: 
"Commissioning" → "NC" → "NC memory" operating area. 

The figure below shows how NCK persistent data is divided: 

 
① Part programs and OEM cycles can be set via 

MD 18352 $MN_U_FILE_MEM_SIZE 
User 

② In addition to part programs and OEM cycles that can be set via 
MD 18353 $MN_M_FILE_MEM_SIZE 

User 

③ Siemens cycles Siemens 
④ Reserved Siemens 
⑤ RAM in NCK User 
⑥ RAM in the NCK that contains the system and user data currently 

being processed by the NCK. Numbers for tools, frames, etc., are set 
by default. 

User 

⑦ Additional memory (software option): can be used for RAM in the 
NCK, part programs and cycles 

User  

  Additional 2 MB CNC user memory (6FC5800-0AD00-0YB0) 

  Additional 128 KB PLC user memory (6FC5800-1AD00-0YB0) 

  Additional user memory on CompactFlash card of the NCU (6FC5800-0AP12-0YB0) 

Figure 7-20 Memory division 
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7.8 Application example 

Advanced Surface (option)   
Advanced Surface is a function for machining milled surfaces in the tool and mold making 
area.  

 

 

Software option 
You require the following software option in order to use this function: "Advanced 
Surface" (MLFB: 6FC5800-0AS07-0YB0).  

The machine and setting data influenced by this functionality as well as their contents are 
listed below. The values are recommended settings.  

7.8.1 Preconditions, G code 

Introduction 
Dynamic G groups are used for the Advanced Surface (AS) option. 

Preconditions 
● The machine axes have been optimized. 

● The dynamic G groups have been set-up and parameterized for the following machining 
sections: 

– Roughing (DYNROUGH) 

– Semi-finishing (DYNSEMIFIN) 

– Finishing (DYNFINISH) 

Recommendations 
● Dynamic G groups 

The following classification of dynamic G groups is recommended (G code group 59): 

 
DYNNORM → 2.5D machining without AS 
DYNPOS → Positioning mode (e.g. tool change, thread cutting) without AS 
DYNROUGH → Milling with AS 
DYNSEMIFIN → Milling with AS 
DYNFINISH → Milling with AS 
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 Note 

DYNNORM is the initial setting of the G group (default).  

For Advanced Surface, the precondition is that jerk-limited velocity control is active. Jerk-
limited velocity control is selected using the G code SOFT. 

 

● COMPCAD 

Using COMPCAD, it is possible to combine part programs with short linear blocks, with 
the associated tolerance, using polynomials.  

This path compression technique has been developed so that the surface character, 
which the milling paths form, is retained.  

● G645 

G645 (G code group 10) switches to the continuous path mode (Look Ahead).  

G645 has the ability to insert smoothing elements in existing contour elements so that 
acceleration steps (jumps) do not occur. 

● FIFOCTRL 

FIFOCTRL (G code group 4) switches to the automatic pre-processing memory control.  

The feed is adapted so that the pre-processing memory does not become empty. 

● FFWON 

FFWON (G code group 24) switches to the parameterized pre-control (speed or 
acceleration pre-control). FFWON can only be used if pre-control is parameterized. This 
must be ensured by the machine suppliers.  

Commands for 5-axis machining 
The following commands are important for 5-axis machining: 

● TRAORI enables the defined transformation and must be programmed alone in the block. 

● UPATH (G code group 45) switches to the path parameter that was developed for 5-axis 
interpolation. 

● ORIAXES (G code group 51) linearly interpolates the orientation axes in the block up to 
the end of block. 

● ORIWKS (G code group 25) defines the workpiece coordinate system for orientation 
interpolation. 

CYCLE832 (High Speed Cutting)  
The CYCLE832 (High Speed Cutting) cycle optimally supports Advanced Surface. This cycle 
has been developed for this purpose and sets the above mentioned commands and the 
tolerance. 
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Commands CTOL (Chord TOLerance) and OTOL (Orientation TOLerance) 
Commands CTOL (Chord TOLerance for chord tolerance) and OTOL (Orientation 
TOLerance) can be used if the tolerance is programmed without support of CYCLE832. 

Activating the G code 
Activation can be realized either using "Programming in the part program" or when 
commissioning machines, by re-configuring the RESET response (see 
$MC_GCODE_RESET_VALUES). 

Programmable program sequence without CYCLE832 
This produces the following program sequence for customers who do not use CYCLE832 or 
if the G commands do not correspond to the machine initial setting: 
SOFT 
FFWON 
FIFOCTRL 
G645 
COMPCAD 
DYNROUGH or DYNSEMIFIN or DYNFINISH {depending on the machining 
phase} 
TRAORI(<Transformation number>) {for 5-axis programs and 
transformation} 
ORIAXES 
ORIMKS 

7.8.2 Setting machine data 

Machine data preassignment for 3-axis and 5-axis machining 
 
MD Name Description Rec. value Comment 
10200 $MN_INT_INCR_PER_MM Internal calculation resolution, 

linear axis 
100000 10000 for 

export version 
10210 $MN_INT_INCR_PER_DEG Internal calculation resolution, 

rotary axis 
=MD10200 10000 for 

export version 
18360 $MN_MM_EXT_PROG_BUFFER_SIZE Maximum reload memory when 

executing from external 
500 Against 

jamming 
18362 $MN_MM_EXT_PROG_NUM Number of external programs that 

can be simultaneously processed 
2  

20150 $MC_GCODE_RESET_VALUES[3] Initial setting of G group 4 3 FIFOCTRL 
20150 $MC_GCODE_RESET_VALUES[19] Initial setting of G group 20 2 SOFT 
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MD Name Description Rec. value Comment 
20150 $MC_GCODE_RESET_VALUES[44] Initial setting of G group 45 2 UPATH (for 5-

axis machining)
20150 $MC_GCODE_RESET_VALUES[50] Initial setting of G group 50 2 ORIAXES (for 

5-axis 
machining) 

20170 $MC_COMPRESS_BLOCK_PATH_LIMIT Maximum length of POLY 
generated by the compressor 

20  

20172 $MC_COMPRESS_VELO_TOL Maximum deviation of the path 
feed for COMCAD 

1000 Default setting 

20443 $MC_LOOKAH_FFORM[0-1] Activates the extended Look 
Ahead in the associated 
technology group (DYNNORM, 
DYNPOS) 

0 Default setting 

20443 $MC_LOOKAH_FFORM[2-4] Activates the extended Look 
Ahead in the associated 
technology group (DYNROUGH, 
DYNSEMIFIN, DYNFINISH) 

1  

20482 $MC_COMPRESSOR_MODE Behavior of the compressor 
tolerance 

300  

20490 $MC_IGNORE_OVL_FACTOR_FOR_ADIS Control of G642 1  
20560 $MC_G0_TOLERANCE_FACTOR Factor for tolerance for 

COMPCAD, G645, OST, ORISON 
3  

20600 $MC_MAX_PATH_JERK [0-4] Path jerk 10000 Should not be 
effective 

20602 $MC_CURV_EFFECT_ON_PATH_ACCEL[0-1] Ratio of translatory acceleration to 
the centripetal acceleration 

0 Should not be 
effective 

20602 $MC_CURV_EFFECT_ON_PATH_ACCEL[2] Ratio of translatory acceleration to 
centripetal acceleration with 
DYNROUGH 

0.65 Must be 
effective so 
that the jerk is 
minimized 
during active 
curvature 
smoothing. 

20602 $MC_CURV_EFFECT_ON_PATH_ACCEL[3] Ratio of translatory acceleration to 
centripetal acceleration with 
DYNSEMIFIN 

0.6 Must be 
effective so 
that the jerk is 
reduced during 
active 
curvature 
smoothing. 
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MD Name Description Rec. value Comment 
20602 $MC_CURV_EFFECT_ON_PATH_ACCEL[4] Ratio of translatory acceleration to 

centripetal acceleration with 
DYNFINISH 

0.5 
(determine 
using the 
circularity 
test) 

Limit rotational 
acceleration, 
especially for 
"large" 
machines. 

20606 $MC_PREPDYN_SMOOTHING_ON[0-1] Activates curvature smoothing 0 Default setting 
20606 $MC_PREPDYN_SMOOTHING_ON[2-4] Activates curvature smoothing 1  
21104 $MC_ORI_IPO_WITH_G_CODE G code for orientation interpolation 1  
28060 $MC_MM_IPO_BUFFER_SIZE Memory, interpolator for number 

of G1 blocks 
150  

28070 $MC_MM_NUM_BLOCKS_IN_PREP Memory, preparation (pre-
processing) 

80  

28520 $MC_MM_MAX_AXISPOLY_PER_BLOCK Maximum number of axis 
polynomials per block 

5  

28530 $MC_MM_PATH_VELO_SEGMENTS Number of memory elements for 
limiting the path velocity 

5  

28533 $MC_MM_LOOKAH_FFORM_UNITS Memory for extended Look Ahead 18  
28540 $MC_MM_ARCLENGTH_SEGMENTS Number of memory elements to 

display the arc length function 
10  

28610 $MC_MM_PREPDYN_BLOCKS Memory, curvature smoothing 10  
29000 $OC_LOOKAH_NUM_CHECKED_BLOCKS Number of Look Ahead blocks 

(this must be the same as 
N28060) 

150  

42470 $SC_CRIT_SPLINE_ANGLE COMP criteria for target point 
analysis (should be >30°) 

36 Default setting 

42471 $SC_MIN_CURV_RADIUS Factor for compressor tolerance 
(should be 0.3 - 3) 

1  

42500 $SC_IS_MAX_PATH_ACCEL Limits the path acceleration via 
SD 

10000  

42502 $SC_IS_SD_MAX_PATH_ACCEL Activates the path acceleration via 
SD 

0  

42510 $SC_SD_MAX_PATH_JERK Limits the path jerk via SD 10000  
42512 $SC_IS_SD_MAX_PATH_JERK Activates path jerk via SD 0  
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Optimize the drive 8
8.1 Optimization overview 

Overview of drive optimization  
Once the drives and axes have been commissioned, it is time to start optimizing the 
particular machine or a machine type.  

 
Figure 8-1 Selection of "Automatic servo optimization" 

The following functions are available for this:  

● In the "Commissioning" → "Optimization/Test" operating area 

– Automatic servo optimization  

– Measuring functions (current control loop, speed control loop, position control loop)  

– Circularity test  

● In the "Diagnostics" operating area → Menu forward key → "Trace"  

With the "Trace" function, you can select the NC, PLC, or drive variables whose signal 
chart is to be visualized.  



Optimize the drive  
8.1 Optimization overview 

 CNC Commissioning: NC, PLC, Drive 
242 Commissioning Manual, 03/2013, 6FC5397-2AP40-3BA1 

During drive optimization, the following variables are of particular interest: 

– Trace for NC/PLC variables  

Recording and graphical representation of the temporal characteristics of SERVO 
signal values, such as actual position value, following error, etc. 

– Trace for drive variables 

Recording and graphical representation of the temporal characteristics of signal 
values from the drive system, such as actual speed value, actual current value, etc. It 
must be possible to interconnect the signals to be recorded via a BICO source. 

Description of the procedure 
The following procedures are described in this chapter:  

● Optimization by using all automatic defaults (especially efficient procedure) 

● Optimization with manual settings for position controllers, speed controllers and current 
controllers (procedure for experts) 

References 
You can find further details in the following manuals: 

● Basic Software and Operating Software Commissioning Manual, SINUMERIK Operate 
(IM9), "Trace" chapter 

● Basic Functions Function Manual; Axis Monitoring, Protection Zones (A3) 

● Function Manual, Basic Functions; Velocities, Setpoint / Actual Value Systems, Closed-
Loop Control (G2) 

● Extended Functions Function Manual; Compensations (K3) 
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8.2 Automatic drive optimization 

8.2.1 Automatic servo optimization 

Automatic servo optimization  
The following options are available for automatically optimizing an axis:  

● Selection of individual axis for optimization 

● Selection of a strategy from many options 

● Reconfiguration of measurement conditions 

● Chart display and activity log for optimization process 

● Display of current measurement and at the same time the average of previous 
measurements 

● Checking and processing of optimization results for speed and position controller 

● Accept or reject results 

The "Automatic servo optimization" function is started in the "Commissioning" → "Automat. 
Servo Opt." operating area and can be used for all SERVO and direct drives. 

 

 Note 

The master-slave axes for automatic optimization are not supported by SINUMERIK Operate 
Version 2.6 SP1.  

Master-slave axes can be optimized as individual axes if they are not coupled. 
 

Interpolation axes  
For axes which make up an interpolation group, additional optimization steps should be 
undertaken, e.g.: 

● Interpolation path (Page 264) with the automatic servo optimization 

● Circularity test (Page 284) 

● Adaptation of servo gains (e.g. smallest servo gain in all interpolating axes without DSC 
(see also: Position control loop measurement (Page 277)) 

● When using speed feedforward control, transfer equivalent time constants of the slowest 
axis (highest value) into all interpolating axes (see also: Speed control loop measurement 
(Page 274)). 
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Overview of navigation       
When optimizing an axis, you navigate via various dialogs. The following figure shows the 
navigation for optimizing an axis:  

1 2 3

6

7 8 9

54

 
Figure 8-2 Navigation for automatic optimization of an individual axis 

 

 Note 

The following chapter "General operating sequences for automatic servo optimization" uses 
the numbers shown in the figure above (e.g. "Strategy selection" dialog ②). 
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8.2.2 Setting the options for the measurement procedure 

Options 
In the first step, select the "Options" softkey to set the general behavior for automatic servo 
optimization.  

The following selections are recommended for a machine without a gantry axis grouping 
while using all automatic sequences and settings:  

 
Figure 8-3 Options 

Meaning of the options:  

● Perform all measurements of each measurement series with the first NC start: 

All repeats (e.g. motion in the positive and negative axis direction) within a measurement 
series are started automatically. 

● Start measurements automatically: 

The start screen of each measurement series is skipped and the measurement process is 
directly started with the default measurement parameters. 

● Automatic confirmation of the measurement: 

The final screen of each measurement series (is used to evaluate the measurement 
results -> if required, adapt measurement parameters and restart measurement series) is 
skipped. The algorithm changes directly to the next optimization step. 

● Automatic acknowledgement of the control data: 

The "control data overview" display is skipped. The control data determined by the 
algorithm are directly activated. 
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● Automatic data activation using the operator panel reset: 

The "Operator panel reset" signal is generated by the algorithm. If this option is 
deactivated, "Operator panel reset" is requested using a dialog screen. 

● Automatically backup drive boot files (ACX format): 

After completing the optimization of a machine axis, the drive data is automatically saved 
on the CompactFlash Card in the ACX format. If this option is deactivated, a query is 
made.  

● Allow strategy selection during optimization: 

The dialog screen to select the optimization strategies for the speed and position 
controller is displayed. This option is not necessary for a simple automated procedure. 

● Perform preliminary measurement to determine the excitation: 

Activate a preceding (additional) measurement for each measurement series to more 
precisely determine the measurement parameters. This is especially recommended when 
measuring directly-driven machine axes for the first time. 

● Switch off gantry consistency checking 

This option is only required for checking a gantry axis grouping. 

Further actions: 

● "Delete history" softkey to delete any measurement data that already exists for this axis. 

● "Optimization log" softkey to display the window in which the optimization log is output. 

● "Cancel" and "OK" softkeys to cancel or accept the new settings, respectively. 

8.2.3 General operating sequences for automatic servo optimization 

Precondition 
 

WARNING  
Avoiding unwanted axis movements 

Automatic servo optimization is based on the analysis of measurements. The 
measurements require the axis to move.  

Ensure that all axes are in a safe position and no collisions will occur during the traversing 
motion that is required. 
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General operating sequences 
Procedure: 

1. In the "Commissioning" operating area, press the "Automat. servo opt." softkey. The 
following dialog appears: ① 

 
Figure 8-4 Axis selection 

 
Figure 8-5 Axis selection with gantry axis grouping 

2. Use the cursor keys to select an axis for optimization. 
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  Note 

For a gantry axis grouping, only the guide axis is displayed and labeled with the "Gantry" 
text. Synchronous axes are hidden, but are measured and optimized when the guide axis 
is selected. 

3. In the "Axis selection" dialog ①, press the "Optimize" softkey. 

4. In the "Strategy selection" dialog ②, the predefined strategy for optimization is displayed: 

 
Figure 8-6 Strategy selection 

In a typical strategy, for example, the mechanical controlled system of the speed control 
is measured and gains and filters are defined for optimized dynamic behavior. 

  Note 

A user-defined strategy can be set using the vertical "User-defined" softkey.  

5. Press "OK". 



 Optimize the drive 
 8.2 Automatic drive optimization 

CNC Commissioning: NC, PLC, Drive 
Commissioning Manual, 03/2013, 6FC5397-2AP40-3BA1 249 

6. In the "Axis parking position" dialog ③, move the axes on the machine into a safe 
position for optimization. 

 
Figure 8-7 Axis parking position 

7. Press "OK". Optimization is started ⑤. 

 
Figure 8-8 Optimization in progress 

If measurement can only be continued after the necessary inputs have been made, then 
this is signaled using input prompts (screen forms). This is required because you need to 
initiate certain machine sequences (e.g. measurements which require an <NC START>).  

You can abort the coordination process at any stage of automatic servo optimization. 
Once optimization has been aborted, all original machine data which was present in the 
control and in the drives before optimization was started is restored.  
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  Note 

After the measurement has been completed, you can perform the measurements again. 
In this case, the quality of the measurement data can be influenced by changing the 
excitation parameters using the "Measurement configuration" dialog. 

 
Figure 8-9 Measurement configuration 

8. If the optimization process has completed certain optimizations for a control loop, the 
"Controller data overview" ⑦ dialog is displayed. 

 
Figure 8-10 Controller data overview 
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Figure 8-11 Controller data overview for gantry axis grouping 

You can modify and check the results and either accept or reject the proposed control 
parameters. 

9. To confirm that you wish to accept the determined values, click the "Accept" softkey. 
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Example of display switchover 
Procedure: 

 

 Note 

Alternatively, you can display the optimized values graphically as a Bode diagram using the 
"Bode diagram" softkey. 

 

1. If you accept the settings for speed control by pressing "Accept", the drive data is 
updated, and the strategy then runs the measurements for closed-loop position control, 
"Measurement in progress" dialog ⑥. 

 
Figure 8-12 Measurement in progress 

 
Figure 8-13 Measurement in progress, gantry axis grouping 

2. Once the optimum values for closed-loop position control have been selected, the data is 
transferred to the NC and drives, and the strategy runs the next stage. This might, for 
example, consist of performing a verification measurement. 
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8.2.4 Setting optimization strategy 

Optimization strategy  
For the speed controller and position controller axis strategies, the default settings 
(strategies 102, 303, and 203; see figure) are recommended: 

 
Figure 8-14 Selection of predefined strategy 

The default optimization objective is "Moderate fault clearance". The option selected 
depends on the mechanical properties of the machine/axis. The "Maximum fault clearance" 
option should not be used for a "weak" axis. 
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Optimization objective 
Description of the optimization objective: 

● Selection: "Maximum fault clearance"  

The speed and position controller gain (servo gain factor) is optimized with maximum 
values and minimum ruggedness.  

– Application: High speed machining with maximum suppression of all disturbing forces 
such as friction, teeth of the drive belt, strong cutting forces, when machining titanium, 
for example. 

Recommended for high-speed machining with linear motors. 

– Precondition: The machine must have a rigid design; the dynamic masses do not 
change significantly. 

● Selection: "Moderate fault clearance"   

The speed and position controllers are optimized with 80% of the maximum gain and a 
good level of ruggedness. 

– Application: There are many uses. 

– Precondition: No high expectations for the machine design; recommended for general 
use. 

● Selection: "Optimal damping"  

The speed controller is optimized so that it achieves maximum damping to prevent 
vibrations and to achieve a good position control value. 

– Application: Large machines with large dynamic masses. 

– Precondition: A weak machine design due to large masses/inertia. The size of the 
motor justifies a low dynamic response. Recommended, for example, for traversing 
columns where the operator cabin moves with the column. Can be used if the "Optimal 
damping" check produces a very low position controller gain. 
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User-defined settings 
The optimization process is re-defined using the "User-defined" softkey. 

Setting the speed controller:  

 
The most important settings are: Optimization aggressiveness and Min integral time Tn. 

● Optimization aggressiveness: 

This parameter determines the setting of Kp and Tn based on stability limits. 

– Default = 0.6 

– Min = 0 [maximum stability] 

– Max = 1 [maximum aggressiveness] 

● Minimum integral time Tn: 

This parameter prevents automatic servo optimization from setting the integrator time of 
the speed control loop too low. Otherwise, if automatic servo optimization sets a value 
lower than this parameter, the actual value used will be limited to the value set by the 
minimum integral time Tn. 

– Default setting = 5.0 ms 

– Min = 0.5 ms 

– Max = 100 ms 
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Setting the position controller:  

 
The most important setting is Kv (position controller) reduction factor 

● Kv reduction factor: 

This parameter acts in the same way as the aggressiveness of the position controller. 

It causes a specific reduction of the maximum Kv calculated by automatic servo 
optimization. 

The maximum Kv is the largest Kv that would cause the zero position to be overshot 
when the feedrate is deactivated. 

– Default = 0.8 

– Min = 0.1 

– Max = 1 [no reduction] 
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8.2.5 Example: How to optimize the X1 axis 

Precondition 
This example shows how to optimize the X1 axis using the "Automatic servo optimization" 
function. In this case, the following machine configuration is assumed: 

 
 

WARNING  
Avoiding unwanted axis movements 

Automatic servo optimization is based on the analysis of measurements. These 
measurements require the axis to move. 

Ensure that all axes are in a safe position and no collisions will occur during the traversing 
motion that is required. 

 

Number of measurements 
For optimization purposes, the following measurements are taken with the speed controller: 

● Overall bandwidth: 2 preliminary measurements 

● Overall bandwidth: 2 measurements 

● Reduced bandwidth: 2 preliminary measurements 

● Reduced bandwidth: 2 measurements 

Mechanical system motor to DMS: 2 measurements  
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Optimizing X1 axis 
Procedure: 

1. Select the X1 axis in the "Axis selection" dialog. 

2. Check the options set: "Options" softkey. 

3. Use the preset optimization strategy: "Select strategy" softkey. 

4. Check that the optimization objective "Moderate fault clearance" is selected. 

5. Start the measurement with the "Optimize" softkey. 

 
6. Confirm with "OK". 

7. Follow the prompts on the screen and press NC START. 

 
8. Two measurements are taken each time to optimize the axis. 
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9. Before the measurements are taken, you will be prompted to press NC START. After the 
successful completion of the measurements, the values of the parameters are output: 

 
10. If you agree with the optimized values, confirm with the "Accept" softkey. 

11. OR: Enter new values manually and repeat the measurements. 

12. After accepting the measurement results, optimization is complete. 

 
13. After completion of the measurement, you can display the complete optimization log: 

"Optimization log" softkey. 
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X1 axis result 
After confirming with "OK", you get the following result: 

 
Figure 8-15 X1 axis: optimized 

See also 
General operating sequences for automatic servo optimization (Page 246) 
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8.2.6 Example: How to optimize the Z1 axis 

Optimizing the Z1 axis 
Procedure: 

1. Select the Z1 axis in the "Axis selection" dialog. 

 
2. The options and strategy that are set continue to be valid. 

3. Start the measurement with the "Optimize" softkey. 

 
4. Confirm with "OK". 
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5. Follow the prompts on the screen and press NC START. 

 
6. Two measurements are taken each time to optimize the axis. 

7. Before the measurements are taken, you will be prompted to press NC START. After the 
successful completion of the measurements, the values of the parameters are output: 

 
8. If you agree with the optimized values, confirm with the "Accept" softkey. 

9. OR: Enter new values manually and repeat the measurements. 
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10. After accepting the measurement results, optimization is complete. 

 
11. After completion of the measurement, you can display the complete optimization log: 

"Optimization log" softkey. 

Z1 axis result 
After confirming with "OK", you get the following result: 

 
Figure 8-16 Z1 axis: optimized 

See also 
General operating sequences for automatic servo optimization (Page 246) 
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8.2.7 Example: How to start the interpolation 

Interpolation of the axes  
Procedure:  

1. Select the "Interpolation path" softkey to optimize the X1 and Z1 axes. 

 
2. Select the "Select strategy" softkey to check the default setting for the "Interpolation path 

strategy selection". Accepting the default setting is recommended. 

 
3. Confirm with "OK". This starts optimization. 
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4. After the "Interpolation path optimization completed" message is output, confirm with 
"OK". 

Then you can switch back and forth between the parameter view (softkey: "Parameters") 
and the graphical view (softkey: "Bode diagrams"). 

 
Figure 8-17 Parameter view 

 
Figure 8-18 Graphic view ***pre-release*** 
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With the " >>" softkey, you can switch the vertical softkey bar to access the following 
selection: 

– Softkey: "Reoptimize" 

– Softkey: "Back to optimized" 

– Softkey: "Back to axis optimization" 

– Softkey: "<<" 

– Softkey: "Save to file" 

To save the optimization data in a file, select "Save to file": An XML file is created. 

 
– Softkey: "Generate report" 

To create a report, select "Generate report (Page 267)": A report is created in RTF 
format. 

5. To exit the interpolation process, press the softkey: "Close". 

This message indicates that more axes must be optimized to provide a regular interpolation 
result: 
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Result 
If you want to accept the interpolation result, confirm with "Accept". "Cancel" will start the 
interpolation again. 

 
To check what values the parameters have been set to for optimization purposes, select the 
"<< Back" softkey.  

8.2.8 Example of a report 

Logging the result 
To document the results of optimization, i.e. parameters and diagrams, you can create the 
following logs:  

● You can save the interpolation result as an XML file: "Save to file" softkey. 

● In addition, you can create a report in RTF format: "Generate report" softkey. 

Example of a report 
The report is output in the language set on the control system: 

Machine 

 
Date of the session  2012-07-02 
Time of the session 14:58:42 
Machine axis name Z1 
SAT version 4.5.1.0.2 
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Serial number 112009D1008M1905 
Date of the report 2012-07-02 
Time of the report 15:07:56 
XML file AST_AX3_Z1_112009D1008M1905.xml 

Position controller: Bode diagrams 

 
Optimal standalone: 
--- (purple) Calculation of closed position control loop without FFW 
--- (blue) Measured position control loop 

 
Parameter Optimal 

standalone 
Optimal self-

optimized 
standalone axis 

Initial platform 
configuration 

 

Servo gain factor  5.154 5.154  6 1/min 
Feedforward control mode  Torque Torque  Off  
Equivalent time for FFW  0.001459 0.001459  0 s 
Speed FFW tap delay time  0.0004588 0.0004588 0 s 
Moment of inertia for FFW 
torque  

0.0002772  0.0002772 0 kgm² 

DSC active Correct Correct Correct  
Estimated dead time 0.000125 0.000125 0.000125 s 
Update date  0.002 0.002 0.002 s 
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Optimal standalone: Frequency XX_D filter 

amping 
Numerator 
frequency 

Numerator 
damping 

Res. Act.  

DS PT1 3999      
DS PT1 3999      

 

 
Optimal self-optimized 
standalone axis: 

Frequency XX_D filter 
amping 

Numerator 
frequency 

Numerator 
damping 

Res. Act.  

None        
 

 
Initial platform 
configuration: 

Frequency XX_D filter 
amping 

Numerator 
frequency 

Numerator 
damping 

Res. Act.  

None        

Speed controllers: Bode diagrams 

 
Optimal standalone: 
--- (purple) Closed speed control loop calculated 
--- (blue) Closed speed control loop measured 

 
Parameter Optimal 

standalone  
Optimal self-
optimized 
standalone axis 

Initial platform 
configuration  

 

Proportional gain Kp 0.09246  0.09246  0.2 Nms/rad 
Integral time Tn 0.007639 0.007639 0.05 s 
Reference model active Correct Correct Incorrect   
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Parameter Optimal 
standalone  

Optimal self-
optimized 
standalone axis 

Initial platform 
configuration  

 

Frequency reference model  77.12  77.12 0 Hz 
Damping reference model  0.7071 0.7071 1 s 
Dead time reference model 0 0 0 s 
Actual speed value 
smoothing time 

0 0 0 kgm² 

Motor moment of inertia  2.7e-05   2.7e-05   2.7e-05  kgm² 
Update date 0.000125 0.000125 0.000125 s 

 

 
 Optimal standalone: Frequency XX_D filter 

amping 
Numerator 
frequency 

Numerator 
damping 

Res. Act.  

SW PT2 2000 0.707   X X 
SW Second order  540.1 0.7071 540.1 0.04158  X 
SW Second order  1213 0.4158 1213 0.172  X 
SW PT2 387 0.707    X 

 

 
Optimal self-optimized 
standalone axis: 

Frequency XX_D filter 
amping 

Numerator 
frequency 

Numerator 
damping 

Res. Act.  

SW PT2 2000 0.707   X X 
SW Second order  540.1 0.7071 540.1 0.04158  X 
SW Second order  1213 0.4158 1213 0.172  X 
SW PT2 387 0.707    X 

 

 
Initial platform 
configuration: 

Frequency XX_D filter 
amping 

Numerator 
frequency 

Numerator 
damping 

Res. Act.  

SW Second order 500 2.182 550 0.1093 X X 
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8.3 Measuring functions 

8.3.1 Measuring functions 

Explanation of the measuring functions   
A range of measuring functions allows the time and frequency response of drives and 
controls to be displayed in graphical form on the screen. For this purpose, test signals with 
an adjustable interval are connected to the drives. 

Measurement/signal parameters 
The test setpoints are adapted to the application in question by means of measurement or 
signal parameters, the units of which are determined by the relevant measuring function or 
operating mode. The measurement or signal parameter units are subject to the following 
conditions: 

Table 8- 1 Quantity and units for measurement or signal parameters 

Size Unit 
Velocity Metric system: 

Specification in mm/min or rev/min for translatory or rotary 
movements 
Inch system: 
Specification in inch/min or rev/min for translatory or rotary 
movements 

Distance Metric system: 
Specification in mm or degrees for translatory or rotary 
movements 
Inch system: 
Specification in inch or degrees for translatory or rotary 
movements 

Time Specified in ms 
Frequency Specified in Hz 

 
 

 Note 

The default setting for all parameters is 0. 
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Preconditions for starting measuring functions 
To ensure that no erroneous traversing movements due to part programs can be carried out, 
the measuring functions have to be started in <JOG> mode. 

 

NOTICE  
Collision avoidance 

When traversing movements are carried out within the framework of measuring functions, 
no software limit switches and working area limitations are monitored, since these are 
carried out in follow-up mode. 

Prior to starting traversing movements, the user must therefore ensure that the axes are 
positioned such that the traversing limits specified within the framework of the measuring 
functions are sufficient to prevent collision with the machine. 

 

Starting measuring functions 
Measuring functions initiating a traversing movement are only selected using the specific 
softkey. The actual start of the measuring function and thus of the traversing movement is 
always carried out with <NC-START> on the machine control panel.  

If the main screen of the measuring function is quitted without the traversing movement 
being initiated, the selection of the traversing function is canceled. 

Once the traversing function has been started, the main screen can be exited without any 
affect on the traversing movement. 

 

 Note 

<JOG> mode must be selected when measuring functions are started. 
 

Further safety notices 
The user must ensure that when the measuring functions are used: 

● The <EMERGENCY STOP> button is always within reach. 

● No obstacles are in the traversing range. 

Canceling measuring functions 
The following events will cancel active measuring functions:  

● Hardware limit switch reached 

● Traversing range limits exceeded 

● Emergency stop 

● Reset (mode group, channel) 

● NC STOP 
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● No controller enabling command 

● Canceling drive enable 

● Canceling traversing enable 

● Selection of parking (in position-controlled operation). 

● Feed override = 0% 

● Spindle override = 50% 

● Change in operating mode (JOG) or operating mode JOG not selected 

● Actuation of traversing keys 

● Actuation of handwheel 

● Alarms leading to axis shutdown 

8.3.2 Measurement of current control loop 

Functionality   
The current control loop only needs to be measured for diagnostic purposes if there is a fault 
or if there is no standard data for the motor / power unit combination (third-party motor).  

 

NOTICE  
Protection of the machine 

The user must take special safety measures when measuring the current control loop (e.g. 
secure drive clamping) for hanging axes without external counterweight. 

 

Operating path 
Operating path for measuring the current control loop: Operating area switchover > 
"Commissioning" > "Optimization/Test" > "Current control loop" 

Measuring functions 
The following measuring functions are available for measuring the current control loop: 

 
Measuring type Measured variable 
Reference frequency response 
(downstream of the current setpoint filter) 

Torque-generating actual current value / 
torque-generating current setpoint 

Setpoint step change (downstream of the 
current setpoint filter) 

Measured variable 1: Torque-generating current setpoint
Measured variable 2: Torque-generating actual current 
value 
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Measurement 
The measurement sequence is divided into the following steps: 

1. Setting the traverse range monitoring and the enable logic 

2. Selecting the measurement type 

3. Setting the parameters, softkey: "Measuring parameters" 

4. Displaying the measurement results, softkey: "Display" 

 
Figure 8-19 Current controller 

Measuring parameters 

● Amplitude 

Magnitude of the test signal amplitude. Given in percent of the peak torque. Values from 
1% to 5% are suitable. 

● Bandwidth 

The frequency range analyzed with the measurement.  

The bandwidth depends on the current controller sampling time.  

Example: 

125 μs current controller sampling time, set bandwidth 4000 Hz 

8.3.3 Speed control loop measurement 

Functionality 
The response characteristics for the motor measuring system are analyzed when measuring 
the speed control loop. Various measurement parameter lists are available depending on the 
basic measurement setting which has been selected. 
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Operating path 
Operating path for measuring the speed control loop: Operating area switchover > 
"Commissioning" > "Optimization/Test" > "Speed control loop" 

Measuring functions 
The following measurement functions are available for measuring the speed control loop: 

 
Measuring type Measured variable 
Reference frequency response (downstream of 
the speed setpoint filter) 

Actual speed value motor encoder/speed setpoint 
after filter 

Reference frequency response (upstream of 
the speed setpoint filter) 

Actual speed value motor encoder/speed setpoint 
after filter 

Setpoint step change (downstream of the 
speed setpoint filter) 

Measured variable 1: 
 Speed setpoint downstream of the filter 
 Actual torque value 
Measured variable 2: Actual speed value motor 
encoder 

Interference frequency response (fault 
downstream of the current setpoint filter) 

Actual speed value motor encoder / torque setpoint 
fct. generator 

Disturbance variable step change (fault 
downstream of the current setpoint filter) 

Measured variable 1: 
 Torque setpoint fct. generator 
 Actual torque value 
Measured variable 2: Actual speed value motor 
encoder 

Speed-controlled system (excitation 
downstream of the current setpoint filter) 

Actual speed value motor encoder/actual torque 
value 

Frequency response of the mechanical parts 1) Actual speed value measuring system 1/actual 
speed value measuring system 2 

1) The machine axis in question must have both a direct and an indirect measuring system to 
determine the frequency response of the mechanical parts. 

Measurement 
The measurement sequence is divided into the following steps: 

1. Setting the traverse range monitoring and the enable logic 

2. Selecting the measuring type and measured variable 



Optimize the drive  
8.3 Measuring functions 

 CNC Commissioning: NC, PLC, Drive 
276 Commissioning Manual, 03/2013, 6FC5397-2AP40-3BA1 

3. Setting the parameters, softkey "Measuring parameters" 

4. Displaying the measurement results, softkey "Display" 

 
Figure 8-20 Speed controller 

In the example shown, the speed control loop has not yet been optimized. 

A suitable filter parameterization is used to optimize the dynamic response. This can be 
called with the "Filter" softkey. 

The following figure shows the standard settings for a low-pass filter at 1999 Hz (encoder 
mounting frequency).  

 
Figure 8-21 Standard settings of the speed control loop filter 
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Figure 8-22 Speed control loop filter with rejection band 1190 Hz 

The use of a rejection band at 1190 Hz and adaptation of the proportional gain results in the 
following optimized setting for the speed control loop. 

 
Figure 8-23 Optimized speed control loop 

8.3.4 Position control loop measurement 

Functionality 
This measuring function basically analyzes the response to the active position measuring 
system. If the function is activated for a spindle without a position measuring system, an 
alarm is displayed. Depending on the measured variable selected, various measurement 
parameter lists are displayed.   
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Operating path 
Operating path for measuring the speed control loop: Operating area switchover > 
"Commissioning" > "Optimization/Test" > "Position control loop" 

Measuring functions 
The following measuring functions are available for measuring the position control loop: 

 
Measuring type Measured variable 
Reference frequency response Actual position/position setpoint 
Setpoint step change Measured variable 1: Position setpoint 

Measured variable 2: 
 Actual position value 
 System deviation 
 Following error 
 Actual speed value 

Setpoint ramp Measured variable 1: Position setpoint 
Measured variable 2: 
 Actual position value 
 System deviation 
 Following error 
 Actual speed value 

Measurement 
The measurement sequence is divided into the following steps: 

1. Setting the traverse range monitoring and the enable logic 

2. Selecting the measuring type and measured variable 

3. Setting the parameters, softkey: "Measuring parameters" 

4. Displaying the measurement results, softkey: "Display" 
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The following figure shows an optimized position control loop in which the Kv factor has been 
adapted via the machine data MD32200 $MA_POSCTRL_GAIN. 

 
Figure 8-24 Optimized position control loop 

Reference frequency response measurement 
The reference frequency response measurement determines the transmission ratio of the 
position controller in the frequency range (active position measuring system).   

The setpoint filters, control loop gain (Kv factor) and feedforward control must be 
parameterized such that resonance is avoided wherever possible over the entire frequency 
range.  

Measuring parameters 

● Amplitude 

This parameter determines the magnitude of the test signal amplitude. It should be set to 
the smallest possible value (e.g. 0.01 mm). 

● Bandwidth 

The bandwidth parameter is used to set the analyzed frequency range. The larger this 
value, the finer the frequency resolution and the longer the measurement time. The 
maximum value is specified by the position controller cycle (Tposition controller):  

Bandwidthmax [Hz] = 1 / (2 * Tposition controller [sec]) 

 

Example: 

Position controller cycle: 2 ms 

Bandwidthmax = 1 / (2 * 2*10-3) = 250 Hz 

● Averaging 

The accuracy of the measurement and measurement duration increase with this value. 
A value of 20 is normally suitable. 
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● Settling time 

This value represents the delay between recording of the measured data and injection of 
the test setpoint and offset. A value of between 0.2 and 1 s is recommended. Do not set 
too low a value for the settling times, or the frequency response and phase diagrams will 
be distorted. 

● Offset 

The measurement requires a slight speed offset of a few motor revolutions per minute. 
The offset must be set such that no speed zero crossings occur at the set amplitude. 

Measurement: Setpoint step change and setpoint ramp 
The transient or positioning response of the position control in the time range, and in 
particular the effect of setpoint filters, can be assessed with the step and ramp stimulation 
functions.   

Possible measured variables: 

● Actual position value (active position measuring system) 

● Control deviation (following error) 

Measuring parameters 

● Amplitude 

Determines the magnitude of the specified setpoint step change or ramp. 

● Measurement time 

This parameter determines the period of time to be recorded (maximum: 2048 position 
controller cycles). 

● Settling time 

This value represents the delay between measured data recording / test setpoint output 
and the injection of the offset. 

● Ramp time 

With default setting: The position reference value is specified with the "Setpoint ramp" 
according to the set ramp time. In this case, the acceleration limits which currently apply 
to the axis or spindle are effective. 
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● Offset 

The step is stimulated from standstill or starting from the constant traverse speed set in 
this parameter. 

If an offset value other than zero is input, the step change is stimulated during traversal. 
For the sake of clarity, the displayed actual position value does not include this speed 
offset. 

 
Figure 8-25 Signal chart for position setpoint/ramp measuring function  

At maximum axis velocity, there is a (virtual) step change in the velocity (continuous line). 

The curves represented by the dashed line correspond to a realistic, finite value. The offset 
component is excluded from the display graphic in order to emphasize the transient 
processes. 

Measurement: Setpoint step change 
To avoid overloading the mechanical system of the machine, the step height is limited to the 
value specified in the machine data during the "Setpoint step change" measurement:   

● MD32000 $MA_MAX_AX_VELO (maximum axis velocity) 

This may result in failure to achieve the desired step height. 
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Measurement: Setpoint ramp 
With measurement "Setpoint ramp", the following machine data influences the measurement 
result:   

● MD32000 $MA_MAX_AX_VELO (maximum axis velocity) 

The maximum axis velocity limits the ramp gradient (velocity limitation). The drive does 
not reach the programmed end position (amplitude). 

● MD32300 $MA_MAX_AX_ACCEL (maximum axis acceleration) 

The maximum axis acceleration limits the velocity change (acceleration limitation). This 
leads to "rounding" on the transitions at the beginning and end of the ramp. 

NOTICE  
 

Protection of the machine 

In normal cases the machine data corresponds exactly with the load capacity of the 
machine kinematics and should not be changed (increased) as part of the 
measurements: 
 MD32000 $MA_MAX_AX_VELO (maximum axis velocity) 
 MD32300 $MA_MAX_AX_ACCEL (maximum axis acceleration) 

 

8.3.5 Function generator 

Function description 
The function generator can be used, for example, to perform the following tasks: 

● Measuring and optimizing closed-loop control circuits 

● Comparing the dynamic properties of coupled drives 

● Specifying a straightforward traversing profile without traversing program 

The function generator can be used to generate various signal forms.  

In the Servo mode, the setpoint can additionally be supplied into the control structure in 
accordance with the currently selected mode, for example, as a current setpoint, disturbing 
torque or speed setpoint. Any influence of overlaid closed-loop control circuits is suppressed 
automatically. 
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Position of the application points: 

 
Figure 8-26 Application points 

To activate the function generator, select "Commissioning" operating area → "Automatic 
servo optimization" → "Function generator". 

 

CAUTION  
Starting/stopping the function generator 

With the corresponding function generator parameter settings (e.g. offset), the motor can 
"drift" and travel to its end stop. The drive movement is not monitored for activated function 
generator. 
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8.4 Circularity test 

8.4.1 Circularity test: Function 
The circularity test serves to set and assess the dynamic response for interpolating axes and 
to analyze the contour accuracy on the quadrant transitions (circular contours) achieved by 
means of friction compensation (conventional quadrant error compensation).  

The circularity test is used to check the interpolation of the axes which work together. This 
function measures a circle with reference to the motor or to the direct measuring system. 
Alignment of the machine-mechanical equipment is not taken into account in the result. This 
gives the commissioning engineer the option of separating problems with the controller 
optimization from mechanical problems. 

The following axis machine data and parameters are checked with this procedure: 

● MD32200, MD32400, MD32402, MD32410, MD32490, MD32500, MD32510, MD32520, 
MD32540 MD32620, MD32640, MD32810, MD32900, MD32910, MD32930, MD32940 

● p1421 to p1426, p1400, p1433, p1434 

  Note 

MD32450 backlash must be adjusted via an external device, such as a circularity test or 
gauge.  

The following position error compensations should be disabled if this procedure is carried 
out:  

● MD32450 backlash compensation 

● MD32500 friction compensation active 

● MD32700 Encoder/lead error compensation 

● MD32710 enable sag compensation 

● MD32750 Temperature compensation type 

Example 
NC test program for the measurement of the X-Y axes:  

FFWON 

SOFT 

G90 G01 F3000 X400 Y200 Z500 

LAB: 

G91 G64 G02 X0 Z0 I10 

GOTOB LAB 

M30 

Position, feedrate and active plane must be adjusted to the machine!  
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Specification and results  
The best contour results are achieved when the circular form test results are in the correct 
actual size, shape and minimum p/p deviation between a combined interpolation of the axes 
(X-Y, X-Z, Y-Z). 

An NC program in the MDA operating mode and the circularity test function are used to 
measure and evaluate these results. The "worst case" of a circle radius and the path velocity 
must lead to a realistic radial acceleration of which the machine is capable.  

Machine manufacturers generally have specifications for the radius and feedrate test circuit. 

Circularity tests of machine manufacturers usually use a radius of 100 mm or 150 mm with 
feedrate speeds that are determined by the machine manufacturer. The machine 
manufacturer determines the specifications for an acceptable result. 

High-speed processes generally have higher requirements for testing circles with high-speed 
milling machines and can range from circle radii of 10 - 25 mm and feedrates of 5 - 10 
m/min. For high-speed milling machines, the results are generally acceptable if the P/P 
deviation ≤ 0.010 mm and the actual size of the circle is equal to the programmed radius, 
and in the worst-case scenario to the path velocity.  

8.4.2 Circularity test: Performing the measurement 

Setting parameters 

 
Figure 8-27 Circularity test - measurement: Parameters 
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Enter the following parameters to carry out a measurement:   

● "Measurement": Selection of the two axes that are meant to be measured and of the 
measuring system. 

● "Parameter": The parameter settings in the input fields "Radius" and "Feed" must 
correspond to the values from the part program that controls the circular motion of the 
axes, taking account of the feed override switch setting. 

● "Representation": Parameters for displaying the graphics 

– "Resolution" (scaling) of the diagram axes in [mm/scaled] 

– "Display" via the mean radius or programmed radius 

Perform measurement   
Procedure: 

1. In the "Commissioning" operating area select the "Optimization/Test" softkey → 
"Circularity test" softkey. 

2. Select the axes that are meant to be measured with the <SELECT> key or using the 
"Axis+"/"Axis -" softkeys. 

3. Set the "parameters" for the measurement: "Radius" and "Feed" 

The "Measuring time" display field shows the measuring time calculated from the 
"Radius" and "Feed" values for recording the actual position values during the circular 
movement:  

If the measuring time is not sufficient then only parts of the circle are portrayed. The 
measuring time can be increased by reducing the feed value. This also applies if the 
circularity test is started from the stationary condition. 

4. Set the parameters for displaying the graphic: 

If the measuring time calculated from this exceeds the time range that can be displayed 
(maximum measuring time = position controller cycle frequency * 2048), a coarser 
sampling rate is used for recording (n * position controller cycle frequency), so that a 
complete circle can be displayed. 

 

Further actions: 

● To start the measurement, press the "Start" softkey. 

● To stop the measurement, press the "Stop" softkey. 

● To make further adjustments for optimization, press the "Optimization" softkey. 

● On a new softkey bar, you can navigate directly to the following areas: 

– "Service axis" in the "Diagnostics" operating area 

– "Axis machine data" 

– "Drive machine data" 

– "User Views" 
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● In order to save the parameters for a measurement, press the "Save parameter" softkey. 

● In order, for example, to repeat a measurement with the same parameters, press the 
"Load parameter" softkey. 

Displaying a graphic 
In order to display the measurement result as a graphic, press the "Graphic" softkey.  

8.4.3 Circularity test: Examples 
The MD32400 $MC_AX_JERK_ENABLE axial jerk limitation is set via a time constant and is 
always active. 

Machine data for setpoint filter:  

● MD32402 $MC_AX_JERK_MODE = Type 2 is recommended, type 1 is preset for 
compatibility reasons. Parameterizing a pure band-stop filter is expressly not 
recommended. 

● MD32402 $MA_AX_JERK_MODE (filter type) and MD32410 $MA_AX_JERK_TIME > 0 is 
effective only if MD32400 $MA_AX_JERK_ENABLE = 1 is set. 

Example 1 for optimization 
Machine data after optimization of the axes: 

 
Parameters / machine data X axis Z axis 
MD32200 $MC_POSCTRL_GAIN 8.500 8.500
p1460 SPEEDCTRL_GAIN1 3.01 3.89
p1462 SPEEDCTRL_INTEGRATOR_TIME_1 6.18 6.18
p1463 SPEEDCTRL_REF_MODEL_FREQ 106.3 106.3
p1440 NUM_SPEED_FILTERS 0 0
MD32610 $MC_VELO_FFW_WEIGHT 1.0 1.0
MD32620 $MC_FFW_MODE 4 4
MD32810 $MC_EQUIV_SPEEDCTRL_TIME 0.0022 0.0022
MD32400 $MC_AX_JERK_ENABLE 0 0

The actual value of the radius is generally too large with optimized feed precontrol. This can 
be corrected with the MD32410 $MC_AX_JERK_TIME time constant. Use a time constant in 
all axes if required. 
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This circle displays the results after the feed precontrol has been optimized. However, the 
mean radius is 0.0019 mm too large:  

 
X1: active measuring system Parameter 
Z1: active measuring system Radius: 10.00000 mm

Feedrate: 3000.00000 mm/min
Measurement time: 1257 ms
X1: active measuring system 
Z1: active measuring system 
Representation 
Resolution: 0.01000 mm
Representation: mean radius 
Radius: 10.00190 mm 
Delta R: 4.02698 μm

 

 
Parameters / machine data X axis Z axis 
MD32200 $MC_POSCTRL_GAIN 8.500 8.500
p1460 SPEEDCTRL_GAIN1 3.01 3.89
p1462 SPEEDCTRL_INTEGRATOR_TIME_1 6.18 6.18
p1463 SPEEDCTRL_REF_MODEL_FREQ 106.3 106.3
p1440 NUM_SPEED_FILTERS 0 0
MD32610 $MC_VELO_FFW_WEIGHT 1.0 1.0
MD32620 $MC_FFW_MODE 3 3
MD32810 $MC_EQUIV_SPEEDCTRL_TIME 0.0022 0.0022
MD32400 $MC_AX_JERK_ENABLE 1 1
MD32402 $MC_AX_JERK_MODE 2 2
MD32410 $MC_AX_JERK_TIME 0.012 0.012
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Example 2 for optimization 
This circle shows the effect of a slightly different time constant for the axial jerk filter. The 
time constant is adapted in order to correct this type of error:  

 
Parameters / machine data X axis Z axis 
MD32400 $MC_AX_JERK_ENABLE 1 1
MD32402 $MC_AX_JERK_MODE 2 2
MD32410 $MC_AX_JERK_TIME 0.012 0.0125

 

 
X1: active measuring system Parameter 
Z1: active measuring system Radius: 10.00000 mm

Feedrate: 3000.00000 mm/min
Measurement time: 1257 ms
X1: active measuring system 
Z1: active measuring system 
Representation 
Resolution: 0.01000 mm
Representation: mean radius 
Radius: 10.00029 mm

 
Delta R: 25.47002 μm
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Example 3 for optimization 
This circle shows the effect of a considerably different time constant for the axial jerk filter. 
The time constant is adapted in order to correct this type of error:  

 
Parameters / machine data X axis Z axis 
MD32400 $MC_AX_JERK_ENABLE 1 1
MD32402 $MC_AX_JERK_MODE 2 2
MD32410 $MC_AX_JERK_TIME 0.015 0.012

 

 
X1: active measuring system Parameter 
Z1: active measuring system Radius: 10.00000 mm

Feedrate: 3000.00000 mm/min
Measurement time: 1257 ms
X1: active measuring system 
Z1: active measuring system 
Representation 
Resolution: 0.01000 mm
Representation: mean radius 
Radius: 9.98971 mm

 
Delta R: 75.67665 μm

8.4.4 Circularity test: Saving data 
The following data can be backed up with the circularity test:  

● Save parameters: The parameters entered can be saved as a file. 

The following path is the default path: 
user/sinumerik/hmi/log/optimization/cicular/<name>.sup  

● Save graphic: If the graphic has been saved correctly the message "Data was saved" 
appears, otherwise an "Error in saving the file" error message is received. 

The following path is the default path: 
user/sinumerik/hmi/log/optimization/cicular/<name>.sud  

● Print graphic: The graphic is saved as a pixel graphic in PNG format. Type in a name. 
The name can be freely selected. The following path is the default path: 
user/sinumerik/hmi/log/optimization/cicular/<name>.png 
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Save parameters   
The file format is structured as follows (with comments in brackets[ ]) 

H: CstPar [Identifier for circularity test parameters]  

V: 5.0 [Version number of the file format]  

@Measurement 

P 1: 1 [Axis number first axis] 

P 2: 2 [Axis number second axis] 

P 3: 0 [Measuring system Axis 1 - 0: active; 1:first; 2: second] 

P 4: 0 [Measuring system Axis 2 - 0: active; 1:first; 2: second] 

@ parameters 

P 10: 30  [Radius] 

P 11: 3000 [Feed] 

P 12: 3770 [Measuring time] 

P 14: 1 [Multiplier] 

@Representation 

P 20: 10  [Resolution] 

P 21: 8 [mean / prog. radius - 8 = mean R ; 9 = prog. Radius] 

Save graphic   
The file format is structured as follows (with comments in brackets[ ]): 

H: CstPic [Identifier for circularity test graphic] 

V: 5.0 [Version number of the file format] 

@ parameters 

P 1: 30 [Radius] 

P 2: 3000 [Feed] 

P 3: 3770 [Measuring time] 

P 4: 0 [Measuring system Axis 1 - 0: active; 1:first; 2: second] 

P 5: 0 [Measuring system Axis 2 - 0: active; 1:first; 2: second] 

@Representation  

P 10: 10 [Resolution] 

P 11: 9 [mean / prog. radius - 8 = mean R ; 9 = prog. Radius] 

P 12: X1 [Axis name 1] 

P 13: Z1 [Axis name 2] 

@Intermediate values 

P 20: 15.6632 [max. radius measured values] 
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P 21: 10.9326 [min. radius measured values] 

P 22: 13.6694 [mean radius measured values] 

P 23: 1886 [Number of measured values] 

@Additional values 

P 30: 1000 [Accuracy (1/P30)) 

@Physical units 

P 40: 5370 [Text number radius unit] 

P 41: 5381 [Text number feed unit] 

P 42: 6165 [Text number Resolution unit] 

P 43: 5346 [Text number DeltaRadius unit] 

P 44: 0 [New: Operate: Basislengthunit] 

@Abscissa 

Ai:   [Abscissa values i: 0..P23] 

@Ordinate 

Oi:   [Ordinate values i: 0..P23] 

@Radius 

Ri:   [Radius values i: 0..P23] 
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Commissioning of PLC-controlled drives 9
9.1 Introduction 

Commissioning of PLC-controlled drives 
The following tools support the commissioning of PLC-controlled drives of SINAMICS S120 
type: 

● All parameters of the drive DOs are shown in the operating area "Commissioning" → 
"Machine data", e.g. 

– "Control Unit Parameter" for the DO1 drive unit 

– "Infeed MD" for DRIVE-CLiQ Line Module DO2 

– "Drive MD" for drive control DO 

Parameters of the integrated drives with SINUMERIK view as well as PLC-controlled 
drives with SINAMICS view are displayed. 

● Support for the series commissioning of the PLC-controlled drives, because the 
parameters are contained in the commissioning archive. 

● Topology views, including a list of all of the drive units of this type that have been found. 

● Diagnostics with alarms from these PLC drives whose time stamp is synchronized with 
the system. 

In this case, it is necessary that the following general machine data is pre-assigned: 

– MD13120[…] $MN_CONTROL_UNIT_LOGIC_ADDRESS 

I/O address on a DO1 telegram of the SIEMENS telegram 390 type 

– MD13150 $MN_SINAMICS_ALARM_MASK 

Bit 2 =1, to indicate failures of the PLC-controlled drives. 

Bit 10 =1, to indicate warnings of the PLC-controlled drives. 

● SINUMERIK Operate (only for PROFIBUS connection): 

– Automatic device configuration (Page 78) 

– Guided commissioning (Page 76) with the drive wizards for SERVO DOs. 

– Manual commissioning (Page 101) performed by experienced commissioning 
engineers. 
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 Note 
SINAMICS G1x0 type drives  

Guided commissioning wizards, e.g. for vector control are not provided by SINUMERIK 
Operate. To do this, the STARTER commissioning software appropriate for the version can 
be used.  

PLC axes can only be used with the "basic positioning" (EPOS) function module if 
commissioning takes place via STARTER. 

In general, SINUMERIK Operate does not support drives of the SINAMICS G1x0 type and 
treats them like third-party devices.  
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9.2 Configuration via PROFIBUS 

9.2.1 Boundary conditions for PLC drives via PROFIBUS 

Permissible version combinations  
For PLC-controlled drives connected via PROFIBUS DP, the following applies: 

● Supply and disposal directly from the PLC user program. 

● Integrated in the part program operations using an H command. 

  Note 

In certain version combinations, the integration functions are checked for compatibility.  

As of SINUMERIK CNC V4.5 software, the following versions are supported:  

CU320-2 DP with SINAMICS firmware version 4.5 

All other SINAMICS drives can be connected to the PLC as standard slaves in accordance 
with the PROFIdrive profile and are not included in the quantity structure, according to the 
following "Quantity structure" table. 

Quantity structure  
 

SINUMERIK 840D sl NCU type:  
Scaling 710.3 PN 720.3 PN 730.3 PN 
Drives (drive control DOs) in total 2): 15 40 50 

 of which, assigned to the NC, maximum2): 8 31 31 

 resulting from this, those not assigned to the NC, 
minimum: 

7 9 19 

 not assigned to the NC, maximum: 15 40 50 

Drives units (DO1) with drive control objects, in total2): 9 13 15 

 of which, at the virtual, integrated PROFIBUS, 
maximum3): 

4 6 6 

 of which, at the virtual, integrated PROFIBUS, 
minimum: 

1 1 1 

 of which at the DP interface1) minimum: 5 7 9 

 of which at the DP interface1) maximum: 8 12 14 

1)  X126: PROFIBUS DP of the integrated PLC; X136: PROFIBUS DP/MPI of the integrated PLC 
2)  The sum is monitored using Alarm 380077 
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Supplementary conditions  
The additional operator control options for the PLC drives produce the following general 
conditions:  

● Because the PLC drives create an additional communication load, the number of these 
drive objects (DO) limits depending on the NCU ⇒ note the quantity structure: 

● Alarm 380077 "PROFIBUS/PROFINET: Too many DOs: currently %2, maximum %3 in 
DO group %1" 

● Depending on the versions used, the texts displayed for the SINAMICS parameters and 
alarms can be incomplete. 

● The extended operator control options are guaranteed in conjunction with the drive unit, 
infeed and the axis drive SERVO-DO. This is the reason why a device-granular view is 
considered. All SERVO-DOs of a drive unit can either be assigned to the NC or PLC. 

● As a maximum, all NC axis assignments can be made on axis drives at the external 
PROFIBUS DP (X126). 

● If the drives are assigned to the NC and distributed across several buses, such as DP 
and DP integrated, then it must be ensured that each equidistant bus has the same clock 
cycle settings. It is also true for the clock synchronization via NC with telegram 390 that 
the cycle settings match for each equidistant bus. 

● A DO1 drive unit is required for the internal virtual PROFIBUS DP3 for access to the 
onboard I/O including probe. 

● ADI4 can only be assigned to NC axes. The number of ADI4 does not reduce the 
maximum number of managed DO1 drive units. 

● A 611U connected to SINUMERIK solution line is not supported; it has not been checked 
as far as its reactions are concerned - and has therefore not been released. 

● PLC drives of the SINAMICS S120 CU320-2 DP type communicate on the external 
PROFIBUS DP-X126 as PN-IO 0x80E5. 

 

 Note 
PROFIBUS DP (X126) 

For all drive units connected to an external PROFIBUS DP (X126) , note the following:  
 In the configuration, the user must take into account the supply as well as the switch-on 

and switch-off behavior in interaction with the other axes and their supply. 
 For the terminal wiring, observe the "Machine Configuration Guidelines" system manual. 

In the simplest case, the feedback of the Line Module to the PLC drives must be wired 
(see also: Terminal assignment (Page 71)). 
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9.2.2 Example: Configuration of the drive components 

Overview 
The SINAMICS drive system for PLC-drives communicates with the PLC via the PROFIBUS 
DP X126 interface. The commissioning described in this chapter orientates itself on the 
following example configuration of the SINAMICS drive line-up:  

 
Figure 9-1 Configuration 

Already commissioned are: 

● NCU 720.3 PN and NX15.3 with additional components. 

In this section, the following will be put into operation:  

● CU320-2 DP with an infeed (Line Module) and a Double Motor Module. 
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9.2.3 Commissioning the PLC 

Overview 
The following steps are performed when commissioning PLC drives for the first time: 

1. PLC commissioning 

2. Generation of the PLC user program 

3. Commissioning the PLC drives 

4. Commissioning NCK ⇔ drive communication 

Precondition 
● You have connected the PG/PC to the PLC (see Connect PG/PC with the PLC 

(Page 33)). 

● You have started the SIMATIC Manager and created a project (see SIMATIC S7 project 
overview (Page 35)). 

● You have inserted a SIMATIC Station-300 in the project (see Inserting SINUMERIK NCU 
to the HW Config (Page 36)). 

● You have started HW Config. 

● On the integrated PROFIBUS you have configured an NCU 720.3 PN and NX15.3. 

Communication interfaces 
The PLC must be notified of the PROFIBUS communication interfaces of SINAMICS. You 
generate a SIMATIC S7 project using the SIMATIC Manager. 

To do this, perform the following steps: 

● Insert an S120 CU320-2 DP in HW Config. 

● Configure the properties of the PROFIBUS interface. 

● Compile the configuration and then download it to the PLC. 

See also: PLC commissioning  (Page 33) for the integrated drive. 
 

 Note 

The toolbox must have been installed. The GSD file for SINAMICS S120 from the 
SINUMERIK toolbox is required for configuration. 
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Inserting an S120 CU320-2 DP component 
Procedure: 

1. Navigate in the catalog to "PROFIBUS DP" → "SINAMICS" → "SINAMICS S120" → "S120 
CU320-2 DP": 

 
2. Keeping the left mouse key pressed, drag the "S120 CU320-2 DP" in the station window 

to PROFIBUS (1): DP master system. 
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3. After releasing the mouse key, configure the properties of the SINAMICS PROFIBUS 
interface: 

 
4. Confirm with "OK". 

5. In the "Version" selection box, select the firmware version of the Control Unit. 

  Note 

The firmware version must match the version of the CompactFlash card on the CU320-
2 DP. Refer to the upgrade instructions for the versions that have been released for PLC 
drives. 

6. Confirm with "OK". 
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7. In the PROFIBUS DP master system (SINUMERIK NCU) under "Properties" → "Network 
settings" → "Options" and under the "Equidistance" tab activate the option "Activate 
equidistant bus cycle". 

 
8. In the "DP Slave Properties" of the CU320-2 DP under the tab "Clock synchronization", 

activate the option "Synchronize drive to equidistant DP cycle". 
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9. In the "DP Slave Properties" dialog box, select the "Configuration" tab. 

 
10. Select in the "Overview" the telegrams required for the individual objects (axes and 

CU320-2 DP): 

– "Siemens telegram 2, PZD-4/4" for example, for speed-controlled axes 

– "Siemens telegram 390, PZD-2/2" for CU320-2 DP 

  Note 

SIEMENS telegram 390 is required for the time stamp of the PLC alarms.  

11. Change under "Configuration" to the "Details" view in order to display the associated 
generated input and output addresses for the individual objects: 

 
12. Confirm with "OK". 
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To support automatic device commissioning, the input and output addresses must be 
identical because the addresses in the PLC user program are required for FB283 (Generate 
PLC user program (Page 304)). 

Result 

 

Saving/compiling/loading into the module 
Procedure:  

1. Select the "Station" → "Save and compile" menu. 

2. Click the "Load in module" button to load the configuration to the PLC (End the hardware 
configuration and load it to the PLC (Page 47)). 

The next step is to create the PLC user program. 
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9.3 Generate PLC user program 

Preconditions 
This chapter describes the configuration of PLC drives that are not to be operated as NC 
axes. In the PLC user program the following expansions of the function blocks are required:  

● You will need additional S7 function blocks from the SINAMICS toolbox ≥ V2.1. 

The SINAMICS toolbox is in the SINUMERIK toolbox in directory BSP_PROG. The path 
depends on the version, e.g. \8x0d\040504\BSP_PROG\SINAMICS_V21.zip 

This Zip file contains a manual in several languages. 

● It is also available on the Internet at the following link: 

SINAMICS Toolbox V2.1 
(http://support.automation.siemens.com/WW/view/en/25166781) 

Signals "WR_PZD" and "RD_PZD"  
The "WR_PZD" and "RD_PZD" signals for FC70 in the example have the following meaning: 

 
Signal Type Type Range of values Remark 
WR_PZD I Any P#Mm.n byte x 

P#DBno.DBXm.n byte x
Target range for process data, master  → slave (control words / 
setpoints)  
Here, generally the axis DB is used, i.e. in the pointer, the same DB 
number must be specified as formal parameter "NR_ACHS_DB". 
The length of the pointer is 30 bytes for Siemens telegram 136.  

RD_PZD I Any P#Mm.n byte x 
P#DBno.DBXm.n byte x

Target range for process data, slave → master (status words / actual 
values)  
Here, generally the axis DB is used, i.e. in the pointer, the same DB 
number must be specified as formal parameter "NR_ACHS_DB". 
The length of the pointer is 38 bytes for Siemens telegram 136.  

Example with constant speed (fan, pump) 
Procedure: 

1. You have already created a project and find yourself on the main screen of the SIMATIC 
Manager. 

2. Select the "File" → "Open" menu and then click the "User projects" tab. 

3. Open the project example. 

4. Copy the FB283, FC70, DB70 and DB283 blocks as well as all UDT300xx into your 
existing project. 

5. As the DB70 could be used by another program, rename DB70 as DB111! 

6. Create a new FC73. Do not use the FC73 from the SINAMICS toolbox. 

In our example, 4000hex corresponds to the rated speed in drive parameter p2000. 

http://support.automation.siemens.com/WW/view/en/25166781�
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7. Edit the OB1, FC70 and FC73 blocks in accordance with the following examples. 

Example of OB1:  
 

…  
…  
CALL FC70  
CALL FC73  
…  
…  

Example of FC70: 
 

CALL FB 283, DB283  
NR_ACHS_DB := 111  
LADDR := 300 //Logical I/O address 
LADDR_DIAG := 8186 //Diagnostics address 
WR_PZD := P#DB111 DBX172.0 Byte 8 //Source range for outputs 
RD_PZD := P#DB111 DBX212.0 Byte 8 //Target range for inputs 
CONSIST := TRUE  
RESTART := FALSE  
AXIS_NO := B#16#3 //Drive object number 

Example of FC73: 
 

UN E 30.0 //E.g. switch for the enable 
SPB frei  
  
L W#16#47E //Set all enables 
T DB111.DBW 172  
  
U E 3.7 //MCP483 - reset 
= DB111.DBX 173.7 //Reset fault memory 
BEA  
  
L W##16#47E //All enable signals except ON/OFF1 
T DB111.DBW172  
L W##16#4000 //Rated speed in drive parameter p2000 
T DB111.DBW174 //Set speed high 

8. You have completed the programming of the user program: Now load the project to the 
PLC (Page 76). 
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Commissioning the PLC has been completed 
For the synchronization of PLC and NCK a reset (warm restart) of the system is required: 
Triggering a reset (warm restart) for NCK and drive system  (Page 76) The LEDs show the 
following state:  

● NCU: The "RUN" LED illuminates green continuously. 

● NCU: Status display shows a "6" with a flashing point. 

● CU320-2 DP: The "RDY" LED illuminates green continuously. 

⇒ PLC and NCK are in cyclic operation. The initial commissioning of the PLC is completed.  

See also 
You commission the devices, infeed(s) and drives in the next step:  

Guided commissioning of SINAMICS drives (Page 76)  
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9.4 Commissioning PLC drives 

Preconditions 
The following steps have already been performed: 

● The PLC project was loaded to the PLC. 

● To perform a synchronization, you have initiated a reset (warm restart) for the NCK and 
the drive system. 

● The PLC and NCK are in the following state after a reset (warm restart): 

– RUN LED illuminates GREEN continuously. 

– Status display shows a "6" with a flashing point. 

⇒ PLC and NCK are in cyclic operation. 

Automatic device configuration 
The following description for commissioning briefly discusses the procedure:  

1. Select the "Commissioning" → "Drive system" operating area. 

 
2. Press the "Drive unit" softkey to start the automatic device configuration. During 

commissioning, alarms in the display area for alarms/messages are output. 
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3. Confirm with "OK". You will then be guided through the individual steps of the automatic 
device configuration. 

 
The further commissioning corresponds to the SINAMICS commissioning via an integrated 
PROFIBUS. You are guided through the automatic device configuration up to commissioning 
of the individual drive objects that have still not been commissioned.  

See also 
For additional commissioning steps, please refer to Chapter Commissioning NC-controlled 
drives (Page 67) from Chapter Automatic device configuration (Page 78). 
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9.5 Checking the communication to the drive 

Check configuration 
The PLC alarms of the drives must have an identical time stamp with the NCK.  

For the configuration in the hardware configuration, define the associated Siemens telegram 
390 for the SINAMICS CU. The corresponding logical input and output addresses of this 
communication interface are entered in the following machine data item:  

● MD13120[n] CONTROL_UNIT_LOGIC_ADDRESS 

● MD13120[1]...[5] are reserved for NX expansion modules. 

  Note 

You can view these logical addresses in the HW configuration when configuring the 
properties of SINAMICS components under "Details".  

Procedure: 

1. Check the logical address for SINAMICS CU in the "Commissioning" → "Machine data" → 
"General MD" operating area and enter, for example, the following value: 

MD13120[6] = 288 

2. Press the "Reset (po)" softkey to accept the changed machine data. 

This completes the commissioning of the PLC drives. 
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9.6 Safety functions for PLC drives 

Introduction 
This section only partially describes how a PLC drive can be integrated in a safety-related 
application. In this case, the published supplement of the PROFIdrive profile that includes 
drive-based safety functions via the PROFIsafe supplement with telegram 30 is used. 

Basic procedure 
The following steps are necessary to integrate drive-based safety functions: 

● Configuration with SIMATIC Manager under HW Config. 

● Embedding in safe programmable logic (SPL). 

● Configuration of test cases with SinuCom NC ATW that must go through an acceptance 
procedure. 

Literature 
For the implementation, reference is made to the following function manuals for safety 
functions which are binding for the safety-related version: 

● SINUMERIK 840D sl "Safety Integrated" Function Manual 

● SINAMICS S120 "Safety Integrated" Function Manual, Chapter: "Structure of telegram 30". 
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9.6.1 Configuring PROFIsafe 

Precondition 
In order to configure PROFIsafe, it is necessary that the "S7 Configurations Pack" option is 
installed. 

Configuring the operating sequence for PROFIsafe 
Procedure: 

1. For this telegram, select the PROFIsafe telegram 30 in the "Option" selection field. 

 
2. Under the "Details" tab, set the input/output addresses. The PROFIsafe option requires 

an additional 6 bytes. 
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3. Press the "PROFIsafe ... " button to set the F parameters. 

4. To change the "F_Dest_Add" parameter, in the column, select "F_Dest_Add" in the 
"Parameter Name" column and click the "Change value ..." button. 

 
5. Check the following values/settings: 

– The value of the "F_Dest_Add" parameter must be entered as a hexadecimal value in 
p9610 and p9810 of the corresponding drive (e.g. 200dec corresponds to C8hex). 

– The value of the "F_Source_Add" must match the other used PROFIsafe modules and 
also be entered in MD10385 $MN_PROFISAFE_MASTER_ADRESS. 

– It must be ensured that the same source address is set for all PROFIsafe modules. 
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Result of the PROFIsafe configuring:  

 

9.6.2 Example: Embedding in safe programmable logic (SPL) 

Introduction 
The following machine data and files must be taken into account when embedding telegram 
30 in a safe programmable logic: 

● NC machine data 

● Drive machine data 

● "safe.SPF" file 

● PLC program expansion 
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NC machine data 
● Not bold: Values already used by PROFIsafe / F-Send/F-Rec. 

● Bold: Values that have been added as a result of telegram 30. 

The SPL PROFIsafe configuration for the basic safety functions STO without SSI are then 
shown as example:  

 
Archive excerpt Comment 
CHANDATA(1)  
N10385 $MN_PROFISAFE_MASTER_ADDRESS='H50007d2'  
N10386 $MN_PROFISAFE_IN_ADDRESS[0]='H50000c8' ;=> entry from HW Config 
N10387 $MN_PROFISAFE_OUT_ADDRESS[0]='H50000c8' ;=> entry from HW Config 
...  
N10390 $MN_PROFISAFE_IN_ASSIGN[0]=9011 ;=> INSE[9] for S_STW1.0 No 

Safe Torque Off 
;=> INSE[10] for S_STW1.1 No 
Safe Stop 1 
;=> INSE[11] for S_STW1.7 
INTERNAL_EVENT_ACK 
; No extended functions 

...  
N10400 $MN_PROFISAFE_OUT_ASSIGN[0]=9011 ;=> OUTSE[9] for S_ZSW1.0 

Power removed  
;=> OUTSE[10] for S_ZSW1.1 
Safe Stop 1 not active  
;=> OUTSE[11] for S_ZSW1.7 
INTERNAL_EVENT 
; No extended functions 

...  
N13300 $MN_PROFISAFE_IN_FILTER[0]='H83'  
...  
N13320 $MN_PROFISAFE_OUT_FILTER[0]='H83'  
...  

Drive machine data 
● Values that have been added as a result of telegram 30: 

p9601=p9801=0x8 

p9610=p9810=0xC8 

"safe.SPF" file 
 
Program example Comment 
IDS = 40 DO $A_OUTSE[09] = $A_INSE[2] ;If the cover is locked then deselect STO 
IDS = 41 DO $A_OUTSE[10] = $A_INSE[2] ;If the cover is locked then deselect SS1 
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PLC program expansion 
 
Program example Comment 
U     "SPL".SPL_DATA.INSEP[2]; // => cover switch locked? 
=     "SPL".SPL_DATA.OUTSEP[9]; // $A_OUTSE[9] =1 => Deselect STO 
=     "SPL".SPL_DATA.OUTSEP[10]; // $A_OUTSE[10] =1 => Deselect SS1 
//Enable signal OFF1 set: 
UN    "SPL".SPL_DATA.INSEP[9]; // => No STO? 
UN    "SPL".SPL_DATA.INSEP[10]; // => No SS1? 
U     E      0.0; // of course, only if OFF1 is also requested 

by switch 
=     
"CU320_A".Speed_Control.WR_PZD_DREHZAHL.STW1
.Aus1 ; 

 

9.6.3 Configuration of test cases with SinuCom NC SI-ATW that must go through an 
acceptance procedure 

Precondition 
SinuCom NC SI-ATW, which can be used for the acceptance of safety-related SINUMERIK 
Safety Integrated functions, can also be used to accept certain drive-based Safety Integrated 
functions. The alarms 201600 to 201799 of the drive-based Safety Integrated are displayed 
on the controller.  

The following example for STO (Safe Torque Off)/SH (safe standstill) of an external 
SINAMICS CU3xx device shows these functions. 

Operator input options when ATW is running 
The tests for the drives of the CU320 are integrated into the ATW using the "Function inter-
relationships". For the parameters there are two options: 

1. The contents of the parameters are entered into the result box. 

2. The "setpoints" are located in the condition box and are confirmed in the result box with 
"OK" if there is a match. 
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Test 1: Checking the version parameters 

 
Figure 9-2 Test 1: Result 

Test 2: Checking the SI monitoring clock cycles 

 
Figure 9-3 Test 2: Result 
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Test 3: Testing the safe shutdown (STO):  

 
Figure 9-4 Test 3: Result  

There is a separate test for each drive. 

References 
SINAMICS S120 Safety Integrated Function Manual (FHS) 

See also 
Safety functions for PLC drives (Page 310) 

 



Commissioning of PLC-controlled drives  
9.6 Safety functions for PLC drives 

 CNC Commissioning: NC, PLC, Drive 
318 Commissioning Manual, 03/2013, 6FC5397-2AP40-3BA1 

 



 

CNC Commissioning: NC, PLC, Drive 
Commissioning Manual, 03/2013, 6FC5397-2AP40-3BA1 319 

Saving and managing data 10
10.1 Saving data 

Time of the data backup   
The following times are recommended for performing a data backup:  

● After a commissioning 

● After changing machine-specific settings 

● After replacing a hardware component 

● For a software upgrade 

● Before the activation of memory-configuring machine data 

Data backup for DRIVE-CLiQ motors:   

We would recommend backing up the DRIVE-CLiQ motor data onto a CompactFlash card. 
Parameter p4692 = "1" must be set. 

Creating and importing a commissioning archive 
There are the following ways to create and reload archives:  

● The "Commissioning archive" softkey offers the following selection: 

– Creating a commissioning archive 

– Creating a PLC hardware upgrade archive (only SDBs) 

– Importing a commissioning archive 

– Creating an original status archive 

– Reading in an original status archive 

● The "System data" softkey can be used to select and import specific archives from the 
data structure. 

A commissioning archive is saved as a file of the ".arc" type.  
 

 Note 

Archives of this type can be processed with the SinuCom ARC commissioning and service 
software. 
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What data is saved? 
 
Components data 
NC data  Machine data 

 Setting data 
 Option data 
 Global (GUD) and local (LUD) user data 
 Tool and magazine data 
 Protection zone data 
 R parameters 
 Zero offsets 
 Compensation data 
 Workpieces, global part programs and sub-programs 
 Standard and user cycles 
 Definitions and macros 

 With compensation data  QEC - quadrant error compensation 
 CEC - operation/angularity compensation 
 EEC - leadscrew pitch / encoder error compensation 
Note: It only makes sense to archive machine-specific compensation 
data if the commissioning file is reloaded into the same controller. 

 With compile cycles The compile cycles ( * .elf) option is displayed only if compile cycles are 
also available. 

PLC data  OB (organization blocks) 
 FB (function blocks) 
 FC (functions) 
 DB (data blocks) 
 SFB (system function blocks) 
 SFC (system functions) 
 SDB (system data blocks). 

System data blocks are only used to back up the hardware 
configuration (not the program logic). 
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Components data 
Drive data Either in binary or ASCII format 
HMI data  Texts: PLC alarm texts, cycle alarm texts, part program message 

texts from the machine manufacturer 
 Templates: Individual templates, workpiece templates 
 Applications: Software applications, for example of the machine 

manufacturer 
 Configurations 
 Configuration: Configurations, incl. display machine data 
 Help: Online help files 
 Version data 
 Reports: For example, action log, screenshots 
 Program lists 
 Dictionaries: For Chinese simplified and Chinese traditional (IME) 
 Data backups: Channel data, axis data, etc. in ASCII format 
 Programs on a local drive: Programs that are in the user memory 

area of the CompactFlash card. 

 

10.1.1 Backup of PLC data 

PLC operating state   
When creating a commissioning archive with PLC data, the PLC image that is saved during 
this process depends on the operating state of the PLC at the time of creation:  

● Original image 

● Instantaneous image 

● Inconsistent image 

The operating state of the PLC can be changed in the following ways: 

● With SIMATIC STEP 7 Manager 

● With the PLC mode selector on the NCU: 

Position " 2" → STOP, position " 0" → RUN 
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Operating sequence for original image 
The original image of the PLC is represented by the PLC-data state immediately after 
loading the S7 project into the PLC. 

1. Set the PLC to the STOP operating state. 

2. Load the appropriate S7 project into the PLC using SIMATIC Manager STEP 7. 

3. Create a commissioning archive with PLC data. 

4. Set the PLC to the RUN operating state. 

Operating sequence for instantaneous image 
If you cannot create an original image, you can save an instantaneous image as an 
alternative. 

1. Set the PLC to the STOP operating state. 

2. Archive the PLC data. 

3. Set the PLC to the RUN operating state. 

Operating sequence for inconsistent image 
An inconsistent image results if a commissioning file with PLC data is created and the PLC is 
in the RUN state (cyclic operation). The data blocks of the PLC are saved at different times 
with contents that have changed in the meanwhile. This may result in a data inconsistency 
that, once the data backup has been copied back to the PLC, may under certain 
circumstances result in a PLC stop in the user program. 

 

NOTICE  
Ensure data consistency 

The creation of a commissioning file with PLC data while the PLC is in RUN state (cyclic 
operation) may result in an inconsistent PLC image in the commissioning archive. After this 
commissioning archive has been copied back, the data inconsistency in the PLC user 
program may under certain circumstances result in a PLC stop. 
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10.1.2 Creating a commissioning archive 

Precondition 
The following access levels are required:  

● In order to create a commissioning archive, at least access level 4 (key-operated switch 
3) is required. 

● In order to import a commissioning archive, at least access level 2 (service) is required. 

To prevent a topology error, Control Unit parameter p9906 (topology comparison stage of all 
components) should be set to "Medium" to import a commissioning archive.  

Creating a commissioning archive    
Series commissioning means bringing a series of control systems to the same initial state as 
regards their data. A commissioning archive contains NC, PLC, drive and HMI data. 
Compensation data of the NC can also be optionally saved. For a data backup, the drive 
data is saved as binary data that cannot be read. 

Procedure: 

1. To create a commissioning archive, select: "Commissioning" → forward key → 
"Commissioning archives" → "Creating a commissioning archive" option operating area: 

 
Figure 10-1 Commissioning archives 
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2. Select the data to be backed up: 

– NC data: With/without compensation data 

– PLC data 

– Drive data: Binary/ASCII 

– HMI data: All/selection 

3. Enter an archive name. 

4. The following directories are offered as a storage location for the archive: 

– Archives/user or archives/manufacturer on CompactFlash card or PCU 50 

– A logical drive, e.g. USB FlashDrive 

Memory locations 
Archives can be stored in the following directories: 

● Archives/user or archives/manufacturer on CompactFlash card or PCU 50 

Absolute path specification: /user/sinumerik/data/archive or /oem/sinumerik/data/archive 

● All configured logical drives (USB, network drives) 

  Note 
USB FlashDrive 

USB FlashDrives are not suitable as persistent memory media. 



 Saving and managing data 
 10.2 Managing data 

CNC Commissioning: NC, PLC, Drive 
Commissioning Manual, 03/2013, 6FC5397-2AP40-3BA1 325 

10.2 Managing data 

Application 
The "Manage data" function is used to support and simplify the commissioning and provides 
functions for backup, load and comparison of machine, setting, compensation and drive 
data.  

In contrast to a commissioning archive, only a single control object (axis, channel, servo, 
infeed, etc.) is saved in ASCII format (*.TEA). This file can be edited and transferred to other 
control objects of the same type. The "Manage data" function is also the basis for copying 
DO for SINAMICS drives.  

Managing data 
The "Manage data" function offers the following options:  

● Transfer data within the controller 

● Save data to a file 

● Load data in a file 

● Compare data 

The function is called from "Commissioning" → "Machine data" → "Manage data". 

Example of "transfer data within the controller":  

 
Figure 10-2 Managing data 
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The following data can be saved and stored under the following absolute path on the 
CompactFlash card:  

● user/sinumerik/hmi/data/backup/ec for compensation data 

● user/sinumerik/hmi/data/backup/md for machine data 

● user/sinumerik/hmi/data/backup/sd for setting data 

● user/sinumerik/hmi/data/backup/snx for SINAMICS parameters 

10.2.1 How to transfer data within the controller 

Transfer data within the control 
 

NOTICE  
Protection of the machine 

For safety reasons, the machine and setting data should only be transferred when the 
enable is locked. 

 

Procedure:  

1. Select the "Transfer data within the control" option. 

2. Select the source data in the data structure and confirm with "OK". 

3. In the drop-down list, select an object, e.g. a different axis or a different drive object, to 
which you want to transfer the data and confirm with "OK". 

4. Observe the safety instructions and check the enable signals at the machine and the 
drive. 

5. For drive data, the "Load" softkey is used to transfer the data to the target object. 

10.2.2 To save and load data 

Save data to a file 
Procedure:  

1. Select the "Save data to a file" option. 

2. In the data structure, select the data that you want to save to a file and confirm with "OK". 

3. Select as the storage location, a directory or a USB storage medium and enter a name. 
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 Note 
SINAMICS parameters 

An ASCII file (*.TEA) is always generated when saving. 

Three files of the following type are generated when saving the drive data: 
 A binary file (*.ACX) that cannot be read. 
 An ASCII file (*.TEA) that can be read or edited in the ASCII editor. 
 A log file (*.log) that contains message texts (error situation) or is empty (successful 

storage). 
 

Loading data from a file 
 

NOTICE  
Protection of the machine 

For safety reasons, the machine and setting data should only be transferred when the 
enable is locked. 

 

Procedure:  

1. Select the "Load data from a file" option. 

2. In the data structure, select the saved file and confirm with "OK". 

3. In the drop-down list, select an object, e.g. a different axis or a different drive object, to 
which you want to transfer the data and confirm with "OK". 

4. Observe the safety instructions and check the enable signals at the machine and the 
drive. 

5. For drive data, the "Load" softkey is used to transfer the data to the target object. 

10.2.3 How to compare data 

Compare data 
You can select different data sources for the data comparison: Store the current data in files 
on the controller or data. 

Procedure:  

1. Select the "Compare data" option. 

2. In the data structure, select the data that you want to compare. 

3. Press the "Add to list" softkey to transfer the data to the list in the lower area of the 
display. 

4. Press the "Delete from list" softkey to remove the data again. 
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5. If the list contains more than two data objects, you can activate the checkbox to compare 
two or more data objects from the list. 

6. Press the "Compare" softkey to start the comparison. The display of the comparison 
results can take some time for extensive parameter lists. 

7. Press the "Legend" softkey to display or hide the legend. The following display is the 
default: 

– Different parameters are displayed. 

– The same parameters are not displayed. 

– Parameters not available everywhere are displayed. 
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Licensing 11
11.1 SINUMERIK License Key 

Basic information on license keys   
If a license is required for a product, then with the purchase of the license the purchaser 
receives a CoL as proof for the rights to use this product and a corresponding license key as 
to the "technical representative" of this license. In conjunction with software products, the 
license key usually must be available on the hardware on which the software product is 
executed. 

SINUMERIK license keys 
Depending on the software product, there are license keys with different technical properties. 
The essential properties of a SINUMERIK license key are: 

● Hardware reference 
The hardware serial number included in the SINUMERIK license key provides a direct link 
between the license key and the hardware on which it can be used. In other words, a 
license key created for the hardware serial number of a specific CompactFlash card is 
only valid for this CompactFlash card and will be rejected on other CompactFlash cards 
as invalid.  

● Total number of assigned licenses 
A SINUMERIK license key not only refers to a single license, instead it is the "technical 
representative" of all licenses that are assigned to the hardware at the time of its 
generation. 

Content of the CompactFlash card  
The CompactFlash card contains not only the system and user software as well as the 
retentive system and user data, but also the data relevant for the license management of 
SINUMERIK software products of a controller:    

● Hardware serial number 

● License information including the license key 

The CompactFlash card thus represents the identity of a SINUMERIK controller. For this 
reason, assigning licenses to a controller always occurs using the hardware serial number. 

This has the advantage that the CompactFlash card can be inserted into a replacement NCU 
in the event of failure and all data is retained. 
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CompactFlash card as a spare part  
If the CompactFlash card of a SINUMERIK controller is replaced, for example, because of 
defective hardware, the license key loses its validity and the system is no longer operational. 

In case of defective hardware of the CompactFlash card, contact the "Technical Support". 
They will then send you a new license key without delay. The following data is required: 

● Hardware serial number of the defective CompactFlash card 

● Hardware serial number of the new CompactFlash card 

  Note 

Only CompactFlash cards can be used that were released as spare part, as only these 
are known to the license database. 

Determining the hardware serial number  
The hardware serial number is a permanent part of the CompactFlash card. It is used to 
identify a control system uniquely. The hardware serial number can be determined by: 

● Certificate of License (CoL)  

● SINUMERIK user interface 

● Label on the CompactFlash card 

  Note 
Hardware serial number and CoL 

The hardware serial number is located only on a CoL of the system software or if the 
license was ordered bundled, in other words the system software came together with 
options. 
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11.2 Web License Manager 

Overview 
The use of the installed system software and the options activated on a SINUMERIK control 
system require that the licenses purchased for this purpose are assigned to the hardware. In 
the course of this assignment, a license key is generated from the license numbers of the 
system software, the options, as well as the hardware serial number. Here, a license 
database administered by Siemens is accessed via the Internet. Finally, the license 
information including the license key is transferred to the hardware. 

The license database can be accessed using the Web License Manager. 

Web License Manager   
By using the Web License Manager, you can assign licenses to the hardware in a standard 
Web browser. To conclude the assignment, the license key must be entered at the controller 
via the user interface. 

 

Internet links  
Web License Manager (http://www.siemens.com/automation/license)  

Siemens Industry Mall (http://mall.automation.siemens.com)  

http://www.siemens.com/automation/license�
http://mall.automation.siemens.com/�


Licensing  
11.3 License database 

 CNC Commissioning: NC, PLC, Drive 
332 Commissioning Manual, 03/2013, 6FC5397-2AP40-3BA1 

11.3 License database 

License database access   
The license database contains all relevant license information required for the license 
management of SINUMERIK software products. The central management of the license 
information in the license database ensures that the existing license information regarding a 
piece of hardware is always up to date. 

Direct access 
The direct access in the Web License Manager is made with: 

● License number 

● Delivery note number 

The direct access enables the direct assignment of licenses for which the license numbers 
are available, e.g. in the form of a CoL. 

Direct access with barcode scanner 
The direct access in the Web License Manager is made with: 

● Hardware serial number 

● Product selection 

The direct access enables the assignment of licenses with a barcode scanner for which the 
license numbers are available as a barcode, for example in the form of a CoL. 

Customer login  
The customer login in the Web License Manager is made with: 

● User name 

● Password 

The customer login enables the assignment of all the licenses available to the machine 
manufacturer that are delivered at the time of the login and have not yet been assigned to 
any machine. Here, the license numbers of licenses that can still be assigned need not be 
directly at hand, instead these are displayed from within the license database. 

 

 Note 
Obtaining access data 

You can obtain the address data for the customer login from the Siemens Industry Mall 
under the associated selected region with: "> Register" (above).  
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11.4 How to perform the assignment 

Assigning a license to a piece of hardware 
1. Determine the hardware serial number and the product name ("type of hardware") on the 

user interface via the licensing dialog: 

Commissioning > menu forward key > Licenses > Overview operating area 

  Note 

Ensure that the hardware serial number displayed is also really the one you want to make 
the assignment for. The assignment of a license to a piece of hardware cannot be 
reversed via the Web License Manager. 

2. Go to the Internet page of the Web License Manager. 

3. Click the appropriate access to the license database: 

– Direct access 

– Direct access (barcode scanner ) 

– Customer login 

4. Follow the instructions in the Web License Manager. 

A progress bar shows you the individual steps:  

 
5. Check the details of the selected licenses before confirmation of the assignment process. 

  Note 

After confirmation, the generated license key irrevocably links the selected licenses with 
the specified hardware. 

6. Confirm the assignment process. 

7. After completing the assignment process, enter the license key displayed on the Web 
License Manager into the license dialog of the user interface. 

Commissioning > menu forward key > Licenses > Overview operating area 

8. Press the <INPUT> button to confirm the input of the new license key. 

Displaying the license key and sending via e-mail 
For archiving or for documentation of the associated machine, you can also send a license 
report with the grouping of all assigned licenses. Follow the instructions in the Web License 
Manager under "Display License Key".  
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11.5 Import licensing terms 

Product  
A product is marked by the data below within the license management of SINUMERIK 
→ software products: 

● Product designation 

● Order number: 

● → License number 

Software product  
The term software product is generally used to describe a product that is installed on a piece 
of → hardware to process data. Within the license management of SINUMERIK software 
products, a corresponding → license is required to use each software product. 

Certificate of License (CoL)   
The CoL is the proof of the → license. The product may only be used by the holder of the 
→ license or authorized persons. The CoL includes the following data relevant for the license 
management: 

● Product name 

● → License number 

● Delivery note number 

● → Hardware serial number 

Hardware  
In the context of license management of SINUMERIK → software products, hardware refers 
to the component of a SINUMERIK control system to which → licenses are assigned on the 
basis of its unique identifier. The license information is also saved to non-volatile memory on 
this component, e.g. on a → CompactFlash card. 

CompactFlash card   
As the carrier of all non-volatile data in a SINUMERIK solution line control system, the 
CompactFlash card represents the identity of this control system. The CompactFlash card is 
a memory card that can be plugged into the → control unit from outside. The CompactFlash 
card also contains the following data relevant for the license management: 

● → Hardware serial number 

● License information including the → license key 
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Hardware serial number   
The hardware serial number is a permanent part of the → CompactFlash card. It is used to 
identify a control system uniquely. The hardware serial number can be determined by: 

● → Certificate of License 

● User interface 

● Label on the CompactFlash card 

License   
A license gives the user the legal right to use a → software product. Evidence of this right is 
provided by the following: 

● → Certificate of License (CoL) 

● → License key 

License number   
The license number is the feature of a → license used for its unique identification. 

License key   
The License Key is the "technical representative" of the sum of all the → licenses that are 
assigned to one particular piece of → hardware, which is uniquely marked by its → hardware 
serial number. 

Option   
One option is a SINUMERIK → software product that is not contained in the basic version 
and which requires the purchase of a → license for its use. 
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Cycle protection (option) 12
12.1 Overview, cycle protection 

Functionality 
With cycle protection, cycles can be encrypted and then stored, protected in the controller. 
The processing of cycles with cycle protection in the NC is possible without restrictions. 

 

 

Software option 
You require the following software option in order to use this function: "Lock 
MyCycles" (MLFB: 6FC5800-0AP54-0YB0).  

 

 

 Note 

This type of encryption is in compliance with export restrictions and embargo regulations. 
 

In order to protect the manufacturer's know-how, any type of view is inhibited for cycles with 
cycle protection. If service is required the machine manufacturer must provide the 
unencrypted cycle. 

 

 Note 
End user 

When using encrypted cycles of a machine manufacturer, when problems occur, then only 
the service department of the machine manufacturer should be contacted.  
Machine manufacturer 

When using encrypted cycles, the machine manufacturer must ensure that original, 
unencrypted cycles are archived with the appropriate version management. 
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Copying encrypted cycles 
The encrypted cycle can be copied and can therefore be used at other machines.  

● Using encrypted cycles at only one machine  

If the cycle must not be used at another machine, then the cycle can be permanently 
linked to a particular machine. The machine data MD18030 $MN_HW_SERIAL_NUMBER 
can be used for this purpose.  

When the controller boots, the unique hardware serial number of the CompactFlash card 
is saved in this machine data. If a cycle is to be permanently linked to a machine, then in 
the call header of the cycle, the serial number of the CompactFlash card must be queried 
(MD18030 $MN_HW_SERIAL_NUMBER). If the cycle identifies a serial number that does 
not match, then an alarm can be output in the cycle and so prevents further processing. 
As the code of the cycle is encrypted, there is always a fixed link to a defined hardware. 

● Using encrypted cycles for several machine data 

If a cycle is to be permanently linked to several, defined machines, the cycle must be 
entered into each hardware serial number. The cycle must be re-encrypted with these 
hardware serial numbers. 

Handling encrypted cycles 
A _CPF file can be deleted or unloaded just like an _SPF or _MPF file. All the encrypted 
_CPF files are also backed-up when an archive is generated. 

● An encrypted cycle cannot be directly selected for processing. It can only be called from a 
program - or directly in MDI. 

● An encrypted cycle cannot be processed with the "Process external" function. 
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12.2 Preprocessing 

File extensions  
The cycle to be protected is encrypted on an external PC using the Lock MyCycles program. 
The encrypted cycle has the extension _CPF (Coded Program File).  

The following prededefined extensions are relevant for the file extensions: 

● _ .MPF "Main Program File" for unencrypted main programs; ASCII format 

● _ .SPF "Sub-Program File" for unencrypted sub-programs; ASCII format 

● _ .CYC "Cycle" for pre-compiled file; binary format 

The following file extensions are available for encrypted cycles: 

● _ .CPF "Coded Program File" for encrypted files in binary format 

The _CPF files are either loaded to /_N_CST_DIR , /_N_CMA_DIR or /_N_CUS_DIR. These 
files are visible there and can be processed just like the previous part programs (_MPF, 
_SPF). To execute a _CPF file, a Power On is required after loading the cycles.   

If no power on is performed, the processing of a _CPF file causes the following alarm: 

15176 "Program %3 can be executed only after power on". 
 

 Note 

A machine manufacturer cycle can be called from a main program using the cycle name and 
an extension, for example _SPF. This is possible in the CALL, PCALL command or also 
directly with the name.  

If this machine manufacturer cycle is loaded encrypted as _CPF, all sub-program calls with 
extension must be changed to _CPF. 

 

Preprocessing 
As well as _SPF files, encrypted files can be preprocessed. To activate preprocessing, the 
MD10700 $MN_PREPROCESSING_LEVEL machine data must be set. Pre-processing is 
always recommended for runtime reasons.  

For pre-processing, an NC program (_MPF) or cycle (_SPF) must be converted from the 
ASCII format into the binary format (compiled). The following NC alarm is issued if, at the 
time of execution, the compilation is older than the encrypted cycle file: 

15176 "Program%3 can be executed only after power on". 
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12.3 Call as sub-program 

Sub-program calls without extensions 
A directory can include an encrypted file file _CPF and also an unencrypted file _SPF with 
the same name, e.g. CYCLE1. If the unencrypted _SPF file is pre-processed, then the 
following are located in directory: 

● CYCLE1.SPF ; unencrypted cycle 

● CYCLE1.CYC ; compilation unencrypted cycle  

● CYCLE1.CPF ; encrypted cycle 

For a call in the part program without extension, e.g. N5 CYCLE1(1.2) the call is made with 
the following priority: 

● CYCLE1.CYC 

● CYCLE1.SPF 

● CYCLE1.CPF 

If only the encrypted file (*.CPF ) is in a directory, for a call without extension, nothing has to 
be changed. The encrypted file or its compilation is called. In the case of service, an 
unencrypted file (*.SPF ) is loaded. As this file has a higher priority, for the same call without 
extension, this file is called. 

 

 Note 

An unencrypted file and its compilation have a higher priority than an encrypted file. 
 

Sub-program calls with extensions 
Sub-program calls with extension are: 

● Direct call N5 CYCLE1_SPF 

● Indirect sub-program call ( CALL ) N5 CALL "CYCLE1_SPF" 

● Sub-program call with path data ( PCALL ) N5 PCALL /_N_CMA_DIR /_N_CYCLE1_SPF 

The following extensions are possible: 

● N3_MPF; calls the unencrypted file. 

● N5 _SPF ; calls the unencrypted cycle. 

● N10 _CYC ; calls the compilation of the unencrypted cycle. 

● N15 _CPF ; calls the encrypted cycle or its compilation. 

If a previous unencrypted cycle CYCLE1 is called with _SPF and this is now only loaded 
encrypted as _CPF, then all of the calls must be adapted. 
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NC language commands with absolute path data 
Using the following commands, files can be accessed in the passive file system from the part 
program. In this case, absolute path data with extensions are used. 

● WRITE: Data cannot be attached to a _CPF file, return 4 "incorrect file type". 

● READ: Lines cannot be read from a _CPF file, return 4 "incorrect file type". 

● DELETE: _CPF files can be deleted. 

● ISFILE: A check can be made as to whether a _CPF file is available. 

● FILEDATE 

● FILETIME 

● FILESIZE 

● FILESTAT 

● FILEINFO 

All commands can also be called for _CPF files. The commands then supply the 
corresponding information. 
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12.4 Processing the program 

Actual block display 
If an encrypted cycle is executed, then DISPLOF is always active, independent of the 
programmed PROC attributes. DISPLOF and DISPLON in the block have no effect. If an 
alarm occurs in the cycle, when programming ACTBLOCNO, the block number is not output 
in the alarm line, but always just the line number. 

Basic block display 
If a _CPF cycle is executed, for an active basis block display, the absolute end of block is still 
displayed. In the single block, this information corresponds to the display of the actual axis 
values and can also be entered there. 

Version display 
If a version is entered in the header of an encrypted _CPF cycle, then this version is 
displayed in the contents screen of a cycle directory, just the same as for unencrypted 
cycles. 

Simulation 
The absolute end values are displayed during the processing of a _CPF file in the simulation. 



 

CNC Commissioning: NC, PLC, Drive 
Commissioning Manual, 03/2013, 6FC5397-2AP40-3BA1 343 

New installation/upgrading 13
13.1 With the help of an NCU service system 

Introduction 
The CNC software on the CompactFlash card can be newly installed or upgraded. 

● A reinstallation is required if there is no CNC software on the CompactFlash card (see 
Chapter New installation (Page 343)).  

● An upgrade is required if an older CNC software is available on the CompactFlash card 
(see Chapter Upgrading (Page 350)).  

Tools for reinstallation/upgrade 
The following tools allow you to perform a reinstallation/upgrade: 

● USB FlashDrive 

● WinSCP on PC/PG 

● VNC viewer on PC/PG 

Literature 
A reinstallation/upgrade always requires a bootable USB FlashDrive. In order that this USB 
FlashDrive is capable of being booted, an "NCU Service System" must be installed on it.  

This description and other details can be found in: 

Base Software and Operating Software Commissioning Manual, NCU operating system (IM7) 

13.1.1 New installation 

Introduction 
No CNC software was installed on the CompactFlash Card. The CompactFlash Card is 
empty. 

You have the following options of initiating a new installation of the CNC software: 

● Automatic installation using USB-FlashDrive 

● Installation using USB-FlashDrive 

● Installation using WinSCP on PG/PC 

● Installation using VNC Viewer on PG/PC 
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13.1.1.1 Automatic installation of the CNC software using USB-FlashDrive 

Flow diagram 

 
Figure 13-1 Automatic installation using USB-FlashDrive 
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13.1.1.2 Installation of the CNC software using USB-FlashDrive 

Flow diagram 

 
Figure 13-2 Installing the control software using USB-FlashDrive 
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Flow diagram - installation of the system TCU (1) continued 

 
Figure 13-3 Installing the control software using USB-FlashDrive - continued (TCU system) 
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Flow diagram - installation of the system PCU (2) continued 

 
Figure 13-4 Installing the control software using USB-FlashDrive - continued (PCU system) 
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13.1.1.3 Installation of the CNC software using WinSCP on PC/PG 

Flow diagram 

 
Figure 13-5 Installation using WinSCP on PG/PC 
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13.1.1.4 Installation of the CNC software using VNC Viewer on PC/PG 

Flow diagram 

 
Figure 13-6 Installation using VNC Viewer on PG/PC 
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13.1.2 Upgrading 

Upgrade options 
You have the following options of upgrading the CNC software: 

● Automatic upgrade using USB-FlashDrive 

● Upgrade using USB-FlashDrive 

● Upgrade using WinSCP on PG/PC 

● Upgrade using VNC Viewer on PG/PC 

  Note 

An upgrade is possible as of CNC software 2.xx. An upgrade from other software 
versions is not permitted. In this case, a new installation is required. 

Before the upgrade, you can backup the complete CompactFlash card. Using Restore, 
you can write back this backup to the CompactFlash card. 

Data backup before upgrades 
Carry out a data backup before each upgrade: 

● Commissioning archive of NC/PLC/drive data 

● Load the PLC project into the PC/PG (STEP 7) 

● License key 

When the software is upgraded, all user data is kept on the CompactFlash card in the 
directories /user, /addon, /oem. The license key is kept as well. 

Prior to overwriting a licensed CompactFlash card, a backup of the license key is absolutely 
necessary. The key is available in the ‘keys.txt’ file and stored under the path 
/card/keys/sinumerik The backup of the key can be performed, for example, with WinSCP, 
from the PG/PC. 

 

 Note 

The licenses are permanently assigned to the CompactFlash card (card ID) and can only be 
used on this card. 

The license key can be read back via Web License Manager (Page 331) using the card 
number. 
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Automatic upgrading 
For an automatic upgrade with autoexec.sh from the USB-FlashDrive, the CompactFlash 
card is first backed up.  

The backup file "card_img.tgz" is saved under the following directory: 

/machines/[machine name+serial number of the CompactflashCard] 

An existing data backup is not overwritten. In this case, the operation is exited with an error. 
The upgrade is made once the backup has been successfully completed. 
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13.1.2.1 Backup/Restore 

Introduction 
Before the upgrade, you can backup the complete CompactFlash Card. Using Restore, you 
can write back this backup to the CompactFlash Card. 

Automatic backup of the complete CompactFlash Card 

Flow diagram 

 
Figure 13-7 Automatic backup of the complete CompactFlash Card 
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Automatic restoration of the complete CompactFlash Card 

Flow diagram 

 
Figure 13-8 Automatic restoration of the complete CompactFlash Card 
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13.1.2.2 Automatic upgrade of the CNC software using USB-FlashDrive 

Flow diagram 

 
Figure 13-9 Automatic upgrade of the CNC software using USB-FlashDrive 
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13.1.2.3 Upgrading the CNC software using USB-FlashDrive 

Flow diagram 

 
Figure 13-10 Upgrading the CNC software using USB-FlashDrive 
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Flow diagram - continued system TCU (1) 

 
Figure 13-11 Upgrading the CNC software using USB-FlashDrive - continued (TCU system) 
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Flow diagram - continued PCU system (2) 

 
Figure 13-12 Upgrading the CNC software using USB-FlashDrive - continued (PCU system) 
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13.1.2.4 Upgrading the CNC software using WinSCP on PC/PG 

Flow diagram 

 
Figure 13-13 Upgrading the CNC software using WinSCP on PG/PC 
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13.1.2.5 Upgrading the CNC software using VNC Viewer on PC/PG 

Flow diagram 

 
Figure 13-14 Upgrading the CNC software using VNC Viewer on PC/PG 
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13.2 With the help of the "Create MyConfig" software 

Precondition 
Precondition for the configuring of a package for the automatic reinstallation/upgrade is that 
the "Create MyConfig" software as of version 4.5 is installed on your PG/PC.   

Basic procedure 
The descriptions for reinstallation/upgrading with Create MyConfig include the basic steps for 
configuring and subsequent automatic reinstallation/upgrading of an NCU.  

The "Create MyConfig Expert" software also provides detailed online help. 

13.2.1 Automatic reinstallation with Create MyConfig (CMC) 

Preconditions 
The following preconditions must be met for the CompactFlash card of the NCU: 

● The CompactFlash card of the NCU is empty or contains executable NCU software. 

If any CNC software and possibly irrelevant user data are on the CompactFlash card, 
then these are lost when the software is newly installed. 

● You have a <name>.tgz file (cnc-sw.tgz ) with the actual software. 

● You want to initiate a new installation of the NCU via a USB FlashDrive. 

● If the CompactFlash card is empty or does not contain executable CNC software, you 
need a USB FlashDrive with installed "NCU Service System". 

Operating sequence 
In order to configure a package for the reinstallation of the CNC software with "Create 
MyConfig Expert": 

1. Start the "Create MyConfig Expert" software. 

With this software you configure an Installer package that initiates a reinstallation from 
the USB Flashdrive to the CompactFlash card of the NCU. 

2. Create a new project under "File" > "New" > "New Project". 
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3. Activate the "NCU" area under the "Package" tab. 

 
4. Activate the "NCU software" window from the "Dialogs" tab. 
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5. In the context menu, select > right mouse button > "Edit mode for all dialog boxes" > 
"Automatic". 

 
Figure 13-15 Automatic edit mode 

6. In the "CNC software" window under "Installation", select the "New installation" mode. 

 
7. For the file "<name>.tgz" you have the following options: 

– The file is embedded in the project or linked to the project. 

For the automatic reinstallation, insert the "<name>.tgz" file in the project under "CNC 
software (*.tgz)". To do this, enter the name of the tgz file in the "Preselection" area. 

– Copy the file to the USB FlashDrive in the root directory in which the package is stored 
subsequently. The file is automatically selected while the package is running. 

Enter the name with the prefix "./" in the "Preselection" field under "CNC software 
(*.tgz)": ./<name>.tgz  
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8. Create a package "<name>.usz" via the menu "File" > "Transfer" > "Linux package (NCU) 
and select as target path the root directory of the USB FlashDrive. 

Create MyConfig Expert saves the project, performs a validation run, creates and saves 
the package under the specified target path. 

A "<name>.usz" package is then located in the root directory of the USB FlashDrive. 
Depending on the configuration in the previous step, the "<name>.tgz" file is also located 
next to the package. 

  Note 

The USB FlashDrive must only be bootable if the CompactFlash card of the NCU does 
not contain executable CNC system software. 

9. Insert the USB FlashDrive into a USB socket (X125 or X135) of the NCU. 

10. Switch the control system off and on again. 

Provided that when configuring you configured the "Edit mode of all dialogs" > 
"Automatic", then the package is automatically executed when the control system boots-
up. The dialogs are displayed, but require no operator actions. 

The CNC software has been installed once the package has been completed. 

A logbook about the activities that have been performed can be saved. The logbook 
documents all activities performed during the new installation. 

11. Switch-off the control system. 

12. Remove the USB FlashDrive. 

13. Commissioning work can continue after the control system has been switched on. 

Optional additional functions for the installation of the CNC software 
In the same package - after the CNC software has been installed - the following actions can 
be optionally configured, which can either run completely automatically or conditionally at the 
machine: 

● Loading an SDB Archive 

● SINAMICS device configuration 

● Renaming DO, SINAMICS components and DO numbers 

● Assignment of the drives to NC axes 

● Manipulation of display machine data 

● Manipulation of individual NC and drive data 

● Loading PLC user programs or individual blocks 

● Installation of user software 

● Copying, deleting and manipulating files on the CompactFlash card 

● Conditional execution of actions, executing, deleting, copying and manipulating 

● Messages and interactions to the operator 
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13.2.2 Automatic upgrade with Create MyConfig (CMC) 

Introduction 
 

 Note 

For details on upgrading the CNC software versions, read the "siemensd.rtf" (German) or 
"siemense.rtf" (English) file on the product CD of Create MyConfig.  

 

When the software is upgraded, all user data is kept on the CompactFlash card and in the 
control areas NC, PLC, and drives. The NC and drive data is automatically transferred into 
the new CNC software version. Archives neither have to be created nor imported again.  

The "NCK commissioning switch" and "PLC mode selector switch" remain during the 
upgrade in position "0".  

In conjunction with an upgrade, using the same package, the automatic generation of a 
backup can be configured, which is then stored on the USB FlashDrive. It is not necessary to 
first generate an archive. 

 

 Note 

After the CNC software has been upgraded, adaptations may be required. Using the Create 
MyConfig Expert, these adaptations can also be configured and therefore automatically 
executed. 
For information about the necessary adaptations, please refer to the upgrade instructions of 
the respective CNC software versions. 

 

Operating sequence 
In order to configure a package for the upgrade of the CNC software with "Create MyConfig 
Expert": 

1. You have started the "Create MyConfig Expert" software. 

Using this software, you configure a package that initiates an upgrade of the CNC 
software on the CompactFlash card of the NCU. 

2. You have created a new project under "File" > "New" > "New Project". 
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3. Activate the "NCU" area under the "Package" tab. 

 
4. Activate the "NCU software" window from the "Dialogs" tab. 
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5. In the context menu, select > right mouse button > "Edit mode for all dialog boxes" > 
"Automatic". 

 
6. In the "CNC software" window under "Installation", select the "Upgrade" mode. 

 
7. For the <name>.tgz files you have the following options: 

– The file is embedded in the project or linked to the project. 

For the automatic reinstallation, insert the "<name>.tgz" file in the project under "CNC 
software (*.tgz)". To do this, enter the name of the tgz file in the "Preselection" area. 

– Copy the file to the USB FlashDrive in the root directory in which the package is stored 
subsequently. The file is automatically selected while the package is running. 

Enter the name with the prefix "./" in the "Preselection" field under "CNC software 
(*.tgz)": ./<name>.tgz  

8. Create a package "<name>.usz" via the menu "File" > "Transfer" > "Linux package (NCU) 
and select as target path the root directory of the USB FlashDrive. 

Create MyConfig Expert saves the project, performs a validation run, creates and saves 
the package under the specified target path. 

A "<name>.usz" package is then located in the root directory of the USB FlashDrive. 
Depending on the configuration in the previous step, the "<name>.tgz" file is also located 
next to the package. 
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9. Insert the USB FlashDrive into a USB socket (X125 or X135) of the NCU. 

10. Switch the control system off and on again. 

Provided that when configuring you configured the "Edit mode of all dialogs" 
→ "Automatic", then the package is automatically executed when the control system 
boots-up. The CNC software has been upgraded and all data is available again after the 
package has been completed on the NCU.  

A logbook about the activities that have been performed can be saved. The logbook 
documents all activities performed during the upgrade. 

11. Switch-off the control system. 

12. Remove the USB FlashDrive. 

13. The machine is ready for operation again after switch-on. 

Optional additional functions when upgrading the CNC software 
In the same package - after the CNC software has been installed - the following actions can 
be optionally configured, which can either run completely automatically or conditionally at the 
machine: 

● Manipulation of display machine data 

● Manipulation of individual NC and drive data 

● Loading PLC user programs or individual blocks 

● Installation of user software 

● Copying, deleting and manipulating files on the CompactFlash card 

● Conditional execution of actions, executing, deleting, copying and manipulating 

● Messages and interactions to the operator 
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Fundamentals 14
14.1 Basic information on SINAMICS S120 

14.1.1 Rules for wiring the DRIVE-CLiQ interface 

Topology rules  
When wiring components with DRIVE-CLiQ, the following rules apply: The rules are 
subdivided into obligatory rules, which must be observed, and optional rules, which enable 
automatic topology detection if they are adhered to. 

 
NCU SINUMERIK control system 
ALM Active Line Module 
SMM Single Motor Module 
DMM Double Motor Module 
M Motor 

Figure 14-1 Topology example 
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Obligatory rules: 

● A maximum of 198 DRIVE-CLiQ node components can be connected for each NCU. 

● Up to 16 nodes can be connected to a DRIVE-CLiQ socket. 

● A maximum of 7 nodes can be connected in one row. A row is always considered from 
the perspective of the closed-loop control module. 

● Ring wiring is not permitted. 

● Components must not be double-wired. 

Optional rules: 

When the optional rules for the DRIVE-CLiQ wiring are observed the components concerned 
will be automatically assigned to the drives:  

● For one motor module, the related motor encoder must also be connected. 

● Due to the improved performance utilization, use as many DRIVE-CLiQ points on the 
NCU as possible. 

● It is essential that you comply with the optional rules when using the macro. This is the 
only way to achieve a proper assignment of the drive components. 

14.1.2 Drive objects and drive components 

Example of a drive line-up    
The components that belong to the drive group are reflected in the parameterization in a 
drive object. Each drive object has its own parameter list.  
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Using the example of a SINAMICS S120 drive line-up, the significance of the drive 
components on drive objects is shown:  

 
Drive object DO3 comprises the following components: 
③ Single Motor Module 
⑧ SMC20 
⑨ Motor encoder 
⑩ Motor 

Figure 14-2 Drive group  

The component number is assigned by the drive after detection of the DRIVE-CLiQ topology. 
You can see the respective component numbers in the parameter list for the relevant drive 
object in the operator area "Start-up" → "Machine data" → "Drive MD" → "Axis + ":  

 
Parameter Parameter designation  
p0121 Power unit component number 
p0131 Motor component number 
p0141 Encoder interface (Sensor Module) component number 
p0142 Encoder component number 
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14.1.3 BICO interconnection 

Introduction 
Each drive unit contains a large number of interconnectable input and output variables as 
well as internal control variables. BICO technology ( binector connector technology) allows 
the drive to be adapted to a wide variety of conditions. 

Digital and analog signals, which can be interconnected as required by means of BICO 
parameters, are identified by the prefix BI, BO, CI, or CO in their parameter name. These 
parameters are identified accordingly in the parameter list or in the function diagrams:  

● Binectors (digital): BI: binector input, BO: binector output 

● Connectors (analog): CI: connector input, CO: connector output 

To interconnect two signals, a BICO input parameter (signal sink) must be assigned to the 
required BICO output parameter (signal source). 

Visualization of the BICO interconnection  
Under the following menu you can create a BICO interconnection to the components 
involved in the SINAMICS drive lineup.  

 
Figure 14-3 Example: "Interconnections" 

References 
SINAMICS S120/S150 List Manual /LH1/ 
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14.1.4 Transfer telegrams 

Introduction 
The transfer telegrams from the NC to the drive are transferred via an internal PROFIBUS on 
the NCU:  

● Send telegrams (drive → NC) 

● Receive telegrams (NC → drive) 

The telegrams are standard telegrams with pre-defined assignment of the process data. 
These telegrams are interconnected in the drive object using BICO technology.  

The following drive objects can exchange process data: 

1. Active Line Module (A_INF) 

2. Basic Line Module (B_INF) 

3. Motor Module (SERVO) 

4. Control Unit (CU) 

The sequence of the drive objects in the telegram is displayed on the drive page via the 
parameter list in the "Commissioning" → "Machine data" → "Control Unit MD" operating area 
in p0978[0...15] and may also be changed through it. 

Receive words / send words 
Selecting a telegram via p0922 of the related drive object ("Commissioning" → "Machine 
data" → "Drive MD" operating area) determines the process data to be transferred between 
the master and slave. 

From the perspective of the slave, the received process data comprises the receive words 
and the process data to be sent the send words. 

The receive and send words are comprised of the following elements: 

● Receive words: Control words or setpoints 

● Send words: Status words or actual values 

Telegram types 
What telegram types are available? 

● Standard telegrams  

The standard telegrams are structured in accordance with the PROFIdrive Profile V3.1. 
The internal process data links are set up automatically in accordance with the telegram 
number setting. 

● Manufacturer-specific telegrams  

The manufacturer-specific telegrams are structured in accordance with internal company 
specifications. The internal process data links are set up automatically in accordance with 
the telegram number setting. 
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The telegram length for communication with the drive must be defined in the hardware 
configuration. The telegram length to be chosen depends on the axis functions required, e.g. 
the number of encoders or the functions in the drive. 

 

 Note 

If you change the telegram length of a drive component in HW Config, you also must adjust 
the selection of the telegram type in the configuration of the interface in the NC. 

 

The following vendor-specific telegrams can be set via p0922: 

 
Telegram number:  

116: Speed setpoint, with 2 position encoders, torque reduction and 
DSC, plus load, torque, power and current actual values 

118: Speed setpoint, with 2 external position encoders, torque reduction 
and DSC, plus load, torque, power and current actual values 

for axes (SERVO) 

136: DSC with torque pre-control, 2 position encoders (encoder 1 and 
encoder 2), 4 trace signals 

 138: DSC with torque precontrol, 2 external position encoders (encoder 
2 and encoder 3), 4 trace signals 

 139: For Weiss spindle only:  
Speed/position control with DSC and torque precontrol, 1 position 
encoder, clamping status, supplementary actual values 

390: Telegram without measuring probe for NX expansion for Control Unit 
391: Telegram for up to two probes for NCU 

 395: Control Unit with digital inputs/outputs and 16 probes 

References 
You can find further details in  

● SINAMICS S120 Commissioning Manual (IH1); Section "Preparations for 
Commissioning" 

● SINAMICS S120 Function Manual (FH1); Section "Communication" 

● SINAMICS S120/S150 List Manual (LH1); Section "Function block diagrams" 



 Fundamentals 
 14.2 Axis data 

CNC Commissioning: NC, PLC, Drive 
Commissioning Manual, 03/2013, 6FC5397-2AP40-3BA1 375 

14.2 Axis data 

Introduction 
The term "axis" is often used either as a single term in conjunction with SINUMERIK 840D sl 
or in compounded form, e.g. machine axis, channel axis, etc. To provide an overview of the 
philosophy used as the basis, here is a brief explanation of this term. 

Definition 
Generally, 4 types of axes are distinguished: 

1. Machine axes 

2. Channel axes 

3. Geometry axes 

4. Special axes 

Machine axes 
Machine axes are the motion units existing on a machine, which can also be designated as 
linear or rotary axes, depending on their usable movement. 

Channel axes 
The total of all machine, geometry and special axes assigned to a channel is designated as 
channel axes. 

In this context, the geometry and special axes constitute the program-technological part of 
the machining process, i.e. they are used for programming in the parts program. 

The machine axes constitute the physical part of the machining process, i.e. they carry out 
the programmed traversing movements on the machine. 

Geometry axes 
The geometry axes constitute the rectangular Cartesian basic coordinate system of a 
channel. 

Generally, (Cartesian arrangement of the machine axes) direct imaging of the geometry axes 
to the machine axes is possible. If the arrangement of the machine axes, however, is not 
Cartesian at right angles, the imaging is performed using a kinematic transformation. 
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Special axes 
Additional axes are all other channel axes that are not geometry axes. Unlike for geometry 
axes (Cartesian coordinate system), no geometric context is defined for additional axes, 
neither between additional axes or with respect to geometry axes. 

Literature 
Function Manual Basic Functions; Axes, Coordinate Systems, Frames, Workpiece numbers 
IWS: Axes 

14.2.1 Axis assignment 

Assigning axes   
The assignment of geometry axes to channel axes and channel axes to machine axes, as 
well as the definition of the names of the different axis types is realized via machine data.  
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The following diagram illustrates this relationship:  

 
Figure 14-4 Axis assignment 
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 Note 
Geometry and special axes 

A maximum of three channel axes can be declared as geometry axes. The geometry axes 
must be assigned to the channel axes in ascending order without any gaps. 

All channel axes that are not geometry axes are special axes. 
 

Channel axis gaps  
Normally, using MD20070, a channel axis is assigned to one machine axis. Not every 
channel axis must be assigned to a machine axis. Each channel axis that cannot be 
assigned to a machine axis (MD20070 [n] = 0), represents a channel axis gap. 

Channel axis gaps allow the creation of a uniform configuration of the channel axes over 
different machine versions of a series. Each channel axis of the series has a defined task or 
function. If the function and therefore the machine axis does not exist at a specific machine, 
the corresponding channel axis is not assigned to a machine axis: 

MD20070  $MC_AXCONF_MACHAX_USED[<channel axis>] = 0 

Advantages: 

● Commissioning archive with uniform basic configuration 

● Simple post configuration for the specific machine 

● Flexible portability of part programs 

Enabling channel axis gaps 
The use of channel axis gaps must be enabled using the machine data: 

MD11640 $MN_ENABLE_CHAN_AX_GAP = 1 (channel axis gap allowed). 

If the use of channel axis gaps has not been enabled, then the value 0 for channel axis n in 
the following machine data terminates the allocation of additional machine axes to possible 
channel axes from channel axis n onwards: 

MD20070  $MC_AXCONF_MACHAX_USED[<channel axis n>] 
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Boundary conditions:  

● Regarding the number of channel axes and the indexing, a channel axis gap counts just 
the same as axes. 

● Ensure that a geometry axis is not assigned to a channel axis, that is not assigned to a 
machine axis (channel axis gap). No alarm is displayed! 

● Transformation: When configuring a channel axis in the following machine data, which is 
not assigned a machine axis (channel axis gap), then Alarm 4346 / 4347 displayed: 

– MD24110 ff.  $MC_TRAFO_AXES_IN1...8 

– MD24120 ff.  $MC_TRAFO_GEOAX_ASSIGN_TAB1...8 

Example 
The 5th channel axis "B" in MD20070 is not assigned to a machine axis. 

If channel axis gaps are enabled, six machine axes (1 - 4, 5, 6) are available. 

If channel axis gaps are not enabled, then there are four machine axes (1 - 4) available. 

 
Figure 14-5 Axis configuration with channel axis gap 
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14.2.2 Drive assignment 

Drive assignment 
The assignment of machine axes to the drive objects SERVO is realized using machine 
data. The following diagram illustrates this relationship. 

 
① Using the machine data, the NC is informed about the I/O addresses of the SERVO drive objects defined in the S7 

project in "HW Config": 
MD13050 $MN_DRIVE_LOGIC_ADDRESS[n] (I/O address of the drive) 

② Using the machine data of the setpoint and actual value assignment, the machine axes are assigned to the 
particular SERVO drive objects: 
 MD30110 $MA_CTRLOUT_MODULE_NR[0] (setpoint assignment) 
 MD30220 $MA_ENC_MODULE_NR[0] (actual value assignment) 
The logical drive number m to be entered into the two machine data, refers to the I/O address entered in (1) under 
index n = (m - 1). 

③ Using machine data, MD10000 $MN_AXCONF_MACHAX_NAME_TAB, the machine axes are allocated a unique 
name NC-wide.  
Index n addresses the (n+1)th machine axis. 

Figure 14-6 Drive assignment 
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Machine data 
The following machine data are relevant for the assignment of channel axes to drives: 

 
MD Name Meaning 
10000 $MN_AXCONF_MACHAX_NAME_TAB Machine axis name 
10002 $MN_AXCONF_LOGIC_MACHAX_TAB Logical machine axis image 
13050 $MN_DRIVE_LOGIC_ADDRESS I/O address of drive 
20050 $MC_AXCONF_GEOAX_ASSIGN_TAB Assignment of geometry axis to channel 

axis 
20060 $MC_AXCONF_GEOAX_NAME_TAB Geometry axis name in channel 
20070 $MC_AXCONF_MACHAX_USED Machine axis number valid in channel 
20080 AXCONF_CHANAX_NAME_TAB Name of channel axis in the channel 
30110 $MA_CTRLOUT_MODULE_NR Setpoint assignment 
30220 $MA_ENC_MODULE_NR Actual-value assignment 

 

See also 
Axis assignment (Page 376) 

14.2.3 Axis names 

Machine axes 
Each machine, channel and geometry axis can/must be assigned an individual name 
unambiguously identifying it in its name range. The name of the machine axes are defined 
via the following machine date: 

MD10000 $MN_AXCONF_MACHAX_NAME_TAB [n] (machine axis name) 

Machine axis names must be unambiguous for the entire NC. 

The names and the corresponding index defined in the machine date above is used for: 

● Accessing axis-specific machine data (loading, saving, displaying) 

● Reference point approach from the parts program G74 

● Measuring 

● Test point traversing from the parts program G75 

● Traversing the machine axis from PLC 

● Display of axis-specific alarms 

● Display in the actual-value system (machine-related) 

● DRF handwheel function 
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Channel axes 
The name of the channel axes are defined via the following machine date: 

MD20080 $MC_AXCONF_CHANAX_NAME_TAB[n] (name of the channel axis in the channel) 

Channel axis names must be unambiguous for the entire channel. 

Geometry axes 
The name of the geometry axes are defined via the following machine data: 

MD20060 $MC_AXCONF_GEOAX_NAME_TAB [n] (geometry axis in the channel) 

Geometry axis names must be unambiguous for the entire channel. 

The axis names for channel and geometry axes are used in the parts program for 
programming general traversing movements or to describe the workpiece contour. The axis 
names are used for 

● Path axes 

● Synchronized axes 

● Positioning axes 

● Command axes 

● Spindles 

● Gantry axes 

● Coupled axes 

● Guide value coupling axes 

Machine data 
The following machine data are relevant for the axis names: 

 
MD Name  Designation 
10000 $MN_AXCONF_MACHAX_NAME_TAB Machine axis name 
20060 $MC_AXCONF_GEOAX_NAME_TAB Geometry axis name in channel 
20080 $MC_AXCONF_CHANAX_NAME_TAB Channel axis name/special axis name in 

channel 
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14.3 Spindle data 

14.3.1 Basic spindle setting 

Introduction 
The spindle mode of a machine axis is a subset of the general axis functionality. For this 
reason, the machine data required to start up an axis have also to be set for a spindle. 

The machine data to parameterize a rotary axis as spindle are therefore to be found under 
the axis-specific machine data (from MD 35000 onwards). 

 

 Note 

After the default machine data have been loaded, no spindle is defined. 
 

Spindle definition 
With the following machine data, a machine axis is declared to be an endlessly rotating 
rotary axis whose programming and display is carried out modulo 360 degrees.  

● MD30300 $MA_IS_ROT_AX (rotary axis/spindle) 

● MD30310 $MA_ROT_IS_MODULO (modulo conversion for rotary axis/spindle) 

● MD30320 $MA_DISPLAY_IS_MODULO (display modulo 360 degrees for rotary 
axis/spindle) 

The machine axis is converted to a spindle by defining the spindle number x (with x = 1, 2, 
...max. number of channel axes) in machine data 

● MD35000 $MA_SPIND_ASSIGN_TO_MACHAX (spindle number) 

The spindle number must be unique within the channel axes of the channel to which the 
spindle is assigned.  

Spindle modes   
The spindle can have the following modes: 

● Control mode 

● Oscillation mode 

● Positioning mode 

● Synchronous mode, synchronous spindle 

References: Function Manual, Extended Functions; Synchronous Spindle (S3) 
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● Tapping without compensating chuck 

References: Programming Manual, Fundamentals; motion commands  

● Axis operation: The spindle can be switched from spindle mode to axis mode (rotary axis) 
if the same motor is used for spindle and axis operation. 

Basic spindle setting 
The following machine data is used to specify a spindle mode as basic setting: 

MD35020 $MA_SPIND_DEFAULT_MODE  

 
Value Spindle basic setting 
0  Speed control mode, position control deselected 
1  Speed control mode, position control activated 
2  Positioning mode 
3  Axis mode 

Time when the basic position of the spindle becomes effective 
The time when the basic setting of the spindle takes effect is set in the machine data: 

MD35030 $MA_SPIND_DEFAULT_ACT_MASK  

 
Value Effective time 
0  POWER ON 
1  POWER ON and program start 
2  POWER ON and RESET (M2 / M30) 

 

14.3.2 Spindle modes 

Functionality 
If for certain machining tasks, e.g. on lathes with end-face machining, it is not sufficient to 
traverse the spindle exclusively under speed control via M3, M4, M5 or to position with SPOS, M19 
or SPOSA, the spindle can be switched to position-controlled axis mode and traversed as a 
rotary axis.  

Examples of rotary axis functions: 

● Programming with axis name 

● Zero offsets (G54, G55, TRANS, etc.) 
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● G90, G91, IC, AC, DC, ACP, ACN 

● Kinematic transformations (e.g. TRANSMIT) 

● Path interpolation 

● Traversing as positioning axis 

References: Function Manual, Extended Functions; Section "Rotary axes (R2)" 

Preconditions 
● The same spindle motor is used for spindle mode and axis mode. 

● The same position measurement system or separate position measurement systems can 
be used for spindle mode and axis mode. 

● An actual position value encoder is a mandatory requirement for axis mode. 

● For axis operation, the spindle must be referenced, e.g. with G74. 

Example: 

 
Program code Comment 

M70 ; Switch spindle over to axis mode 

G74 C1=0 Z100 ; Reference axis 

G0 C180 X50 ; Traverse axis position-controlled 

Configurable M function  
The M function used to switch the spindle to axis mode can be configured channel-
specifically via the following machine data: 

MD20094 $MC_SPIND_RIGID_TAPPING_M_NR  
 

 Note 

The controller detects the transition to axis mode automatically from the program sequence. 
The explicit programming of the configured M function for switching the spindle to axis mode 
in the part program is therefore not necessary. However, the M function can continue to be 
programmed, e.g. to increase the readability of the part program. 

 

Special features 
● The feed override switch is active. 

● The NC/PLC interface signal does not terminate the axis mode per default: 
DB21, ... DBX7.7 (reset). 

● The NC/PLC interface signals: 
DB31, ... DBB16 to DBB19 and DBB82 to DBB91 
are not important if: 
DB31, ... DBX60.0 (axis / no spindle) = 0 
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● Axis mode can be activated in all gear steps. 

If the actual position value encoder is installed on the motor (indirect measuring system), 
the positioning and contouring accuracy can vary for the different gear steps. 

● The gear step cannot be changed when the axis mode is active. 

The spindle must be switched to control mode.  

This is done with M41 ... M45 and M5, SPCOF. 

● In the axis mode, the first parameter set is effective (machine data index = zero). 

References: Function Manual, Basic Functions; Chapter "Velocities, setpoint / actual 
value systems, closed-loop control (G2)" > "Closed-loop control" > "Parameter sets of the 
position controller" 

Dynamic response 
In axis mode, the dynamic limits of the axis apply, e.g.: 

● MD32000 $MA_MAX_AX_VELO[<axis>] (maximum axis velocity) 

● MD32300 $MA_MAX_AX_ACCEL[<axis>] (maximum axis acceleration) 

● MD32431 $MA_MAX_AX_JERK[<axis>] (maximum axial jerk for path motion) 

Feedforward control 

The feedforward control mode active for the axis is retained.  

A detailed description of the "Dynamic feedforward control" function can be found in: 

References: Function Manual, Extended Functions; Chapter "Compensations (K3)" > 
"Dynamic feedforward control (following error compensation)" 

Example: Resolution switchover for analog actuator 
Switching to axis mode 

 
Programming Comment 

SPOS=...   

M5 ; Controller enable off (by PLC) 
→ is output on PLC 

M70 ; Switch actuator (by PLC on account of M70) 
Controller enable on (by PLC) 

C=... ; NC traverses with axis parameter set 
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Switching to spindle mode 

 
Programming Comment 

C=...   

M71 ; → is output to PLC 

Closed-loop controller enable off (by PLC) 

Switch actuator (by PLC)  

Switched to spindle parameter set (1-5) internally in 
the NC, controller enable on (by PLC) 

M3/4/5 or SPOS=... ; NC traverses with spindle parameter set 

Change to spindle mode 
The appropriate parameter set 1...5 is selected for the active gear stage. 

The feedforward control is activated, except for tapping with compensating chuck, if the 
following applies: 

MD32620 $MA_FFW_MODE (feedforward control mode) ≠ 0 

 
Parameter set Axis mode Spindle mode 

1 Valid - 
2 - Valid 
3 - Valid 
4 - Valid 
5 - Valid 
6 - Valid 

Spindle mode: Parameter set according to the gear stage 

Master spindle   
In the following machine data, a master spindle has been defined in the relevant channel:  

● MD20090 $MC_SPIND_DEF_MASTER_SPIND (master spindle initial setting in channel) 

The spindle number of the channel spindle which is to be the master spindle defined in 
machine data MD35000 $MC_SPIND_ASSIGN_TO_MACHAX (spindle number) is entered in 
this machine data. 

Diverse spindle functions can be used in one channel, e.g.:  

● Revolutional feed (G95) 

● Tapping with compensation chuck (G63) 

● Thread cutting (G33) 

● Dwell time in spindle revolutions (G4 S...) 
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Spindle reset 
The following machine data is used to define whether the spindle should remain active after 
a reset (DB21,... DBX7.7) or end of program (M02/M30):  

● MD 35040 $MC_SPIND_ACTIVE_AFTER_RESET (spindle active after reset) 

To cancel spindle movements, an independent spindle reset is required: 

● DB31,... DBX2.2 (spindle reset) 

References 
Function Manual, Basic Functions; Spindles (S1) 
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14.4 Configure PROFIBUS components 

Configuration of the PROFIBUS machine control panel 
The following is required in the HW Config for a PROFIBUS machine control panel on the 
HMI: 

● Configuration of the properties of the network interface for PROFIBUS 

● Supplementation of the machine control panel and hand wheel in HW Config 

● Modification of the machine control panel in OP100 

14.4.1 Configure network interface for PROFIBUS 

Introduction 
In the STEP7 project, you configure the network interfaces PROFIBUS DP, via which you 
want to reach the machine control panel: 

PROFIBUS DP operating sequence 
1. Use the left mouse button to select NCU 720.1 and while holding down the mouse button 

drag it to the "Station design" station window. 

2. After you release the mouse button, configure the properties of the PROFIBUS DP 
interface for socket X126 (machine control panel) in the dialog box. 

 
3. Click the following successively: 

– The "New..." button, 

– The "Network settings" tab in the "Properties new subnet PROFIBUS Subnet" dialog 
box. 



Fundamentals  
14.4 Configure PROFIBUS components 

 CNC Commissioning: NC, PLC, Drive 
390 Commissioning Manual, 03/2013, 6FC5397-2AP40-3BA1 

4. Select the transmission speed of "12 Mbit/s" for the "DP" profile. 

 
5. Click "Options" and then the "Isochronous mode" tab. 

 
6. To enable reproducible access to peripherals (for handwheel mode), the PROFIBUS DP 

must have a constant bus cycle time. The following entries are necessary under 
Equidistance: 

– Click on the "Activate equidistance bus cycle" field. 

– Enter the cycle, e.g. "2 ms" for the "Equidistance DP cycle" (for integrated PROFIBUS) 
(see MD10050 $MN_SYSOCK_CYCLE_TIME). 

– Click the "Times Ti and To equal for all slaves" field. 

– The fields "Time Ti" and "Time To" must contain a value "< 2 ms". 
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7. Click "OK" three times. 

8. The NCU module with SINAMICS S120 is inserted in the HW Config. 

  Note 

With the <F4> key and confirmation of the prompt regarding "Reorganize", you can 
reorganize the display in the station window. 

 
As the next step configure a machine control panel with handwheel. 
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14.4.2 Load GSD file (contains machine control panel) 

Introduction 
To expand the machine control panel, you need the device master data (GSD file) with the 
SINUMERIK MCP. This file contains information that a DP master system requires to link the 
MCP as DP slave in its PROFIBUS configuration. 

Operating sequence 
The file is a component of the STEP 7 package for NCU7x0 (Toolbox). 

1. Search in the HW config under "Extras" > "Install GSD file…" in the installation directory 
of the toolbox for the corresponding GSD directory under: 

..\8x0d\GSD\MCP_310_483  

2. Choose the corresponding language you want to install. 

3. Select "Install". 

4. Exit with "Close". 

14.4.3 Adding a machine control panel and handwheel in HW Config 

Introduction 
The machine control panel (MCP) can be connected via PROFIBUS to the PLC. In later 
configurations, this will also be possible over the network. 

Operating sequence for adding an MCP in HW Config 
You have created a NCU and a NX in the HW Config and installed the GSD file for the MCP. 

1. Search under "PROFIBUS DP" > "Further field devices" > "NC/RC" > "MOTION 
CONTROL" for the "SINUMERIK MCP" module. 

2. Click with the left mouse button to select the "SINUMERIK MCP" module and drag it to 
the chain for the "PROFIBUS DP master system" in the "Station design" station window. 

3. After releasing the mouse button, the machine control panel is added (see figure below). 

4. Select "MCP" and enter the PROFIBUS address 6 under "Object properties" > button 
"PROFIBUS..." > tab "Parameter" > input field "Address". 
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5. Click on "OK" twice. 

Now you can assign the slots of the machine control panel, e.g., "Standard + Hand 
wheel". 

 
Figure 14-7 Machine control panel in HW Config 
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6. In the hardware catalog under "SINUMERIK MCP" click with the left mouse button to 
select the "Standard+Hand wheel" option and drag it to Slot 1 (see figure below). 

 
Figure 14-8 Standard+Handwheel for slot 

You have configured a machine control panel with handwheel in HW Config. 
 

 Note 

If a handwheel has been configured, equidistance is required. You set this when you 
configured the PROFIBUS DP. PROFIBUS address for the machine control panel is "6". 

 

Save, compile and load the configuration to the PLC as the next operating sequence.  
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14.4.4 Modifying PROFIBUS machine control panel in OB100 

Introduction 
The PLC base program transfers the signals from the machine control panel. To ensure that 
the signals are transferred correctly to and from the machine control panel, enter the 
following parameters in the OB100 on the FB1. 

Double-click OB100 the editor to configure the machine control panel below "Blocks". 

Example: MCP1 is connected via PROFIBUS DP. 

Another example for the connection of the machine control panel via Industrial Ethernet (IE) 
can be found at:  
Modifying machine control panel in OB100 (Page 52)  

Configuring the machine control panel 
 
OB100  

CALL "RUN_UP" , "gp_par"     FB1 / DB7 -- Startup Baseprogram/ Parameters for 
Baseprogram 

 MCPNum :=1 // An MCP is present 

 MCP1In :=P#E 0.0 

 MCP1Out :=P#A 0.0 

 MCP1StatSend :=P#A 8.0 

 MCP1StatRec := 

 

 MCP1BusAdr :=6 

 MCP1Timeout := 

 MCP1Cycl := 

 MCP2In := 

 MCP2Out := 

 MCP2StatSend := 

 MCP2StatRec := 

// PROFIBUS DP address: 6 

 MCP2BusAdr := 

 MCP2Timeout := 

 MCP2Cycl := 

 MCPMPI :=FALSE 

 MCP1Stop :=FALSE 

 MCP2Stop := 

 MCP1NotSend :=FALSE 

 MCP2NotSend := 

 MCPSDB210 := 

 MCPCopyDB77 := 

 

 MCPBusType :=B#16#03 // Parameter [3] := PROFIBUS DP 

 

 BHG := 

 BHGIn := 
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OB100  

 BHGOut := 

    

... 

    

 UDInt := 

 UDHex := 

 UDReal := 

 IdentMcpType := 

 IdentMcpLengthIn := 

 IdentMcpLengthOut:= 

//Insert User program from here 

...  

References 
You can find additional information about the connection of components:  
Function Manual, Basic Functions (P3), Section "Structure and functions of the base program" 
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Appendix A
A.1 Information about third-party software used 

Copyright 1995 Sun Microsystems, Inc. 
Printed in the United States of America. 
All Rights Reserved. 

This software product (LICENSED PRODUCT), implementing the Object Management 
Group's "Internet Inter-ORB Protocol", is protected by copyright and is 
distributed under the following license restricting its use. Portions of 
LICENSED PRODUCT may be protected by one or more U.S. or foreign patents, or 
pending applications. 

LICENSED PRODUCT is made available for your use provided that you include 
this license and copyright notice on all media and documentation and the 
software program in which this product is incorporated in whole or part. 
You may copy, modify, distribute, or sublicense the LICENCED PRODUCT without 
charge as part of a product or software program developed by you, so long as 
you preserve the functionality of interoperating with the Object Management 
Group's "Internet Inter-ORB Protocol" version one. However, any uses other 
than the foregoing uses shall require the express written consent of Sun 
Microsystems, Inc. 

The names of Sun Microsystems, Inc. and any of its subsidiaries or 
affiliates may not be used in advertising or publicity pertaining to 
distribution of the LICENSED PRODUCT as permitted herein. 
This license is effective until terminated by Sun for failure to comply with 
this license. Upon termination, you shall destroy or return all code and 
documentation for the LICENSED PRODUCT. 

LICENSED PRODUCT IS PROVIDED AS IS WITH NO WARRANTIES OF ANY KIND 
INCLUDING THE WARRANTIES OF DESIGN, MERCHANTIBILITY AND FITNESS FOR A 
PARTICULAR PURPOSE, NONINFRINGEMENT, OR ARISING FROM A COURSE OF 
DEALING, USAGE OR TRADE PRACTICE. 

LICENSED PRODUCT IS PROVIDED WITH NO SUPPORT AND WITHOUT ANY 
OBLIGATION ON THE PART OF SUN OR ANY OF ITS SUBSIDIARIES OR AFFILIATES 
TO ASSIST IN ITS USE, CORRECTION, MODIFICATION OR ENHANCEMENT. 
SUN OR ANY OF ITS SUBSIDIARIES OR AFFILIATES SHALL HAVE NO LIABILITY WITH 
RESPECT TO THE INFRINGEMENT OF COPYRIGHTS, TRADE SECRETS OR ANY 
PATENTS BY LICENSED PRODUCT OR ANY PART THEREOF. 

IN NO EVENT WILL SUN OR ANY OF ITS SUBSIDIARIES OR AFFILIATES BE LIABLE 
FOR ANY LOST REVENUE OR PROFITS OR OTHER SPECIAL, INDIRECT AND 
CONSEQUENTIAL DAMAGES, EVEN IF SUN HAS BEEN ADVISED OF THE POSSIBILITY 
OF SUCH DAMAGES. 
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Use, duplication, or disclosure by the government is subject to restrictions 
as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and 
Computer Software clause at DFARS 252.227-7013 and FAR 52.227-19. 
SunOS, SunSoft, Sun, Solaris, Sun Microsystems and the Sun logo are 
trademarks or registered trademarks of Sun Microsystems, Inc. 

SunSoft, Inc.  
2550 Garcia Avenue  
Mountain View, California 94043  

Copyright (c) 1991 by AT&T. 
Permission to use, copy, modify, and distribute this software for any purpose without fee is 
hereby granted, provided that this entire notice is included in all copies of any software which 
is or includes a copy or modification of this software and in all copies of the supporting 
documentation for such software. 
THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED 
WARRANTY. IN PARTICULAR, NEITHER THE AUTHOR NOR AT&T MAKES ANY 
REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE 
MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR 
PURPOSE. 
This product includes software developed by the University of California, Berkeley and its 
contributors. 
QLocale's data is based on Common Locale Data Repository v1.6.1. 

 

 Note 

You can find additional information on the product DVD in the Readme_OSS file about the 
third-party software used. 
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A.2 Abbreviations 
 
ACX Compressed format from XML 
ALM Active Line Module 
BASP Command output disable 
BERO Proximity limit switch 
BI Binector Input 
BICO Binector Connector 
BO Binector Output 
CF CompactFlash 
CI Connector Input 
CNC Computerized Numerical Control  
CO Connector Output 
CoL Certificate of License 
CP  Communications Processor 
CPU Central Processing Unit 
CU Control Unit 
DHCP Dynamic Host Configuration Protocol: Protocol for automatic assignment of IP addresses from a DHCP 

server to a client computer 
DIP Dual In–Line Package: dual in-line arrangement 
DO Drive objects 
DP Distributed Peripherals 
DRAM Dynamic Random Access Memory 
DRF Differential resolver function: differential-synchro transmitter function 
DRIVE-CLiQ Drive Component Link with IQ 
DSC Dynamic Servo Control 
DWORD Doubleword 
EMC Electro-Magnetic Compatibility 
EN European standard 
EPOS Basic positioning 
ESD Electrostatic Sensitive Device 
GC Global Control 
GSD Device master file 
GUD Global User Data 
GWPS Grinding wheel peripheral speed 
IPO Interpolator cycle 
IS Interface Signal 
JOG JOG mode: manual mode for setting up the machine 
LAN Local Area Network 
LED Light Emitting Diode 
LR Position controller 
LUD Local User Data 
MAC Media Access Control 
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MCP Machine Control Panel 
MD Machine data 
MLFB Machine-readable product designation 
MM Motor Module 
MSGW Message word 
NC Numerical Control: Numerical control with block preparation, traversing range, etc. 
NCU Numerical Control Unit: The NC hardware unit 
NX Numerical Extension (axis extension module) 
OB Organization Block 
OLP Optical Link Plug  
PCU PC Unit: computer unit 
PD Process Data 
PELV Protective Extra-Low Voltage 
PG Programming device 
PII Process Input Image  
PIO Process Output Image 
PLC Programmable Logic Control (component of the CNC controller) 
PM Power Module 
PNO PROFIBUS User Organization 
PUD Global Program User Data 
RAM Random Access Memory (can be read and written) 
RDY Ready 
REF Reference point 
RES Reset 
RTCP Real Time Control Protocol 
SBC Safe brake activation 
SD Setting Data 
SH Safe standstill 
SIM Single Inline Module 
SLM Smart Line Module 
SMC Sensor Module Cabinet-Mounted 
SME Sensor Module Externally Mounted 
SMI Sensor Module Integrated 
STW Status Word 
TCU Thin Client Unit  
USB Universal Serial Bus 
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A.3 Overview 
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Glossary 

Active Line Module  
Controlled, self-commutating feed/feedback unit (with -> "IGBTs" in feed/feedback direction), 
which supplies the DC-link voltage for the -> "Motor Module". 

Certificate of License (CoL)  
The CoL is the proof of the → license. The product may only be used by the holder of the 
→ license or authorized persons. The CoL includes the following data relevant for the license 
management: 

● Product name 

● → License number 

● Delivery note number 

● → Hardware serial number 

CompactFlash card  
As the carrier of all non-volatile data in a SINUMERIK solution line control system, the 
CompactFlash card represents the identity of this control system. The CompactFlash card is 
a memory card that can be plugged into the → control unit from outside. The CompactFlash 
card also contains the following data relevant for the license management: 

● → Hardware serial number 

● License information including the → license key 

Control Unit  
Central control module in which the closed-loop and open-loop control functions for one or 
more -> ”SINAMICS” -> ”Line Modules” and/or -> ”Motor Modules” are implemented. 
There are three types of Control Unit: 
- SINAMICS Control Units, e.g. -> ”CU320” 
- SIMOTION Control Units, e.g. -> ”D425” and -> ”D435” 
- SINUMERIK solution line Control Units, e.g. NCU710, NCU720 and NCU730 

Control Word  
Bit-coded ->"Process data" word, transmitted by -> "PROFIdrive" at cyclic intervals to control 
the drive states. 
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Double Motor Module  
Two motors can be connected to and operated with a Double Motor Module. 
See –> "Motor Module" –> "Single Motor Module" 
Former term: –> "Double-Axis Module" 

Drive  
The drive includes the motor (electric or hydraulic), the actuator (converter, valve), the 
control unit, the measuring system, and supply components (line infeed module, pressure 
reservoir). 
For electric drives, a distinction is made between a converter system and an inverter system. 
With a converter system (e.g. -> "MICROMASTER 4"), from the user's point of view the line 
infeed, the actuator, and the control component form a single device; with an invertor system 
(e.g. -> "SINAMICS S"), the supply is ensured by means of -> "Line Module", thereby 
realizing a DC line to which the -> "Invertors" (-> "Motor Modules") are connected.  
The (–> "Control Unit") is implemented as a separate device and connected to the other 
components by means of –> "DRIVE-CLiQ". 

Drive Component  
Hardware component connected to a –> "Control Unit" via –> "DRIVE-CLiQ", for example. 
Drive units are for instance: -> "Motor Modules", -> "Line Modules", -> "Motors", -> "Sensor 
Modules" and -> "Terminal Modules". 
The overall layout of a Control Unit together with the connected drive components is called  
-> "Drive unit". 

Drive Group  
A drive group comprises a -> "Control Unit" and the -> "Motor Modules" and -> "Line 
Modules" connected via -> "DRIVE-CLiQ". 

Drive Object  
A drive object is an autonomous, individual software function with its own -> "Parameters" 
and may also have its own -> "Faults" and -> "Alarms". Drive objects may exist by default 
(e.g. On-board I/O), can be created individually (e.g. –> "Terminal Board" 30, TB30) or also 
as multiples (e.g. –> "Servo Control"). As a rule, each drive object has its own window for 
parameterization and diagnostic purposes. 

Drive Parameters  
Parameters of a drive axis that include, for example, the parameters of the corresponding 
controllers, as well as the motor and encoder data. The parameters of the higher-level 
technology functions (positioning, ramp-function generator), however, are called –> 
"Application Parameters". 
See –> "Basic Unit System". 
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Drive System  
A drive system includes all the components in a product family, e.g. SINAMICS. A drive 
system comprises, e.g, -> "Line Modules", -> "Motor Modules", -> "Sensors", -> "Motors",  
-> "Terminal Modules" and -> "Sensor Modules" as well as additional components (reactors, 
filters, cables, etc.). 
See -> "Drive Unit" 

Drive Unit  
The drive unit includes all the components connected via –> "DRIVE-CLiQ" that are required 
for carrying out a drive task: -> "Motor Module" –> "Control Unit" –> "Line Module" and the 
required –> "Firmware" and –> "Motor"s, but not additional components, such as filters or 
reactors. 
Several –> "Drives" can be implemented in a drive unit. 
See –> "Drive System". 

DRIVE-CLiQ  
Abbreviation of "Drive Component Link with IQ". 
Communication system for connecting the different components of a SINAMICS drive 
system, e.g. -> "Control Unit", -> "Line Modules", -> "Motor Modules", -> "Motors", and 
speed/position sensors. 
The DRIVE-CLiQ hardware is based on the Industrial Ethernet standard with twisted-pair 
lines. The DRIVE-CLiQ line provides the send and receive signals, as well as the +24 V 
power supply. 

DRIVE-CLiQ Hub Module Cabinet  
The DRIVE-CLiQ Hub Module Cabinet (DMC) is a star coupler for multiplying –> "DRIVE-
CLiQ sockets. The DMC can be clipped onto a rail. The DMC20 is available, for example. 

See –> "Hub" 

Encoders  
An encoder is a measuring system that captures actual values for the speed and/or 
angular/position values and makes them available for electronic processing. Depending on 
the mechanical construction, encoders can be integrated in the –> "Motor" (–> "Motor 
Encoder") or mounted on the external mechanics (–> "External Encoder"). Depending on the 
type of motion, a distinction is made between rotary encoders ("Rotary Transducers") and 
translatory encoders (e.g. -> Linear Encoders). In terms of measured value provision, a 
distinction is made between –> "Absolute Encoders" (Code Encoders) and –> "Incremental 
Encoders". 
See –> "Incremental Encoder TTL/HTL" –> "Incremental Encoder sin/cos 1 Vpp"  
–> "Resolver". 
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External Encoder  
Position encoder that is not built in or mounted on the –> "Motor", but fitted instead via a 
mechanical transmission element or mechanical intermediate element. 
The external encoder (see –> "Externally-Mounted Sensor") is used for –> "Direct Position 
Detection". 

Hardware  
In the context of license management of SINUMERIK → software products, hardware refers 
to the component of a SINUMERIK control system to which → licenses are assigned on the 
basis of its unique identifier. The license information is also saved to non-volatile memory on 
this component, e.g. on a → CompactFlash card. 

Hardware serial number  
The hardware serial number is a permanent part of the → CompactFlash card. It is used to 
identify a control system uniquely. The hardware serial number can be determined by: 

● → Certificate of License 

● User interface 

● Label on the CompactFlash card 

Hub 
A central connection device in a network with star-shaped topology. A hub distributes 
incoming data packages to all connected end devices. 

See –> "DRIVE-CLiQ Hub Module Cabinet" (DMCxx)  

Infeed  
Input component of a converter system for generating a DC-link voltage to supply one or 
more -> "Motor Modules", including all the required components, e.g. -> "Line Modules", 
fuses, reactors, line filters, and firmware, as well as proportional computing power (if 
required) in a -> "Control Unit". 

License  
A license gives the user the legal right to use a → software product. Evidence of this right is 
provided by the following: 

● → Certificate of License (CoL) 

● → License key 
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License key  
The License Key is the "technical representative" of the sum of all the → licenses that are 
assigned to one particular piece of → hardware, which is uniquely marked by its → hardware 
serial number. 

License number  
The license number is the feature of a → license used for its unique identification. 

Line Module  
A Line Module is a power component that generates the DC-link voltage for one or more  
–> "Motor Modules" from a 3-phase mains voltage. 
In SINAMICS, the following three types of Line Module are available: 
–> "Basic Line Module", –> "Smart Line Module" and –> "Active Line Module". 
The overall function of an infeed, including the required additional components like –> "Line 
Reactor", proportional computing power in a –> "Control Unit", switching devices, etc., is 
called –> "Basic Infeed", –> "Smart Infeed", and –> "Active Infeed". 

Modular machine  
The modular machine concept is based on a maximum target topology created offline. The 
maximum design of a particular machine type is referred to as the maximum configuration in 
which all the machine components that may be used are pre-configured in the target 
topology. By deactivating/deleting drive objects (p0105 = 2), sections of the maximum 
configuration can be removed. 

If a component fails, the sub-topology can also be used to allow a machine to continue 
running until the spare part is available. In this case, however, no BICO source must be 
interconnected from this drive object to other drive objects.  

 

NOTICE  
Data backup 

To prevent data loss, save the drive data in a commissioning archive, before you make any 
changes! 

 

Motor  
For the electric motors that can be driven by –> "SINAMICS", a basic distinction is made 
between rotary and linear motors with regard to their direction of motion, and between 
synchronous and induction motors with regard to their electromagnetic operating principle. In 
SINAMICS, the motors are connected to a –> "Motor Module". 
See –> "Synchronous Motor" –> "Induction Motor" –> "Built-In Motor" –> "Motor Encoder"  
-> "External Encoder" –> "Third-Party Motor". 
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Motor Encoder  
An –> "Encoder" (e.g. –> "Resolver", –> "Incremental Encoder TTL/HTL", or –> "Incremental 
Encoder sin/cos 1 Vpp" that is integrated in or attached to the motor. 
The encoder detects the motor speed. In the case of synchronous motors, it can also detect 
the rotor position angle (the commutation angle for the motor currents). 
For drives without an additional –> "Direct Position Measuring System", it is also used as a  
–> "Position Encoder" for position control. 
In addition to the motor encoders, –> "External Encoders" for –> "Direct Position Sensing" 
are available. 

Motor module  
A Motor Module is a power component (DC-AC inventor) that supplies the power for the 
connected motor(s). 
Power is supplied through the –> "DC Link" of the –> "Drive Unit". 
A Motor Module must be connected to a –> "Control Unit" via –> "DRIVE-CLiQ". The open-
loop and closed-loop control functions for the Motor Module are stored in the Control Unit. 
–> "Single Motor Modules" and –> "Double Motor Modules" are available. 

Option  
One option is a SINUMERIK → software product that is not contained in the basic version 
and which requires the purchase of a → license for its use. 

Option Slot  
Slot for an optional module (e.g. in the –> "Control Unit"). 

Parameters  
Variable quantity within the drive system that the user can read and, in some cases, write. 
For –> "SINAMICS", all specifications defined in the –> "PROFIdrive" profile are defined by a 
parameter. 
See –> "Visualization Parameters" and –> "Adjustable Parameters". 

Product  
A product is marked by the data below within the license management of SINUMERIK 
→ software products: 

● Product designation 

● Order number: 

● → License number 
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PROFIBUS  
Field bus according to IEC 61158, Sections 2 to 6. 
The abbreviation "DP" is no longer included because PROFIBUS FMS is not standardized 
and PROFIBUS PA (for Process Automation) is now part of the "general" –> "PROFIBUS". 

Sensor Module  
Hardware module for evaluating speed/position encoder signals and providing detected 
actual values as numerical values at a -> DRIVE-CLiQ Socket". 
Three mechanical Sensor Module variants are available: 
- SMCxx = Sensor Module Cabinet Mounted 
- SME = Sensor Module Externally Mounted (with a high degree of protection) 

Servo Control  
For -> Motors equipped with a -> "Motor encoder", this control type allows operation with a 
high level of -> "Accuracy" and -> "Dynamic response". In addition to speed control, position 
control can be included. 

Servo Drive  
An electric servo drive comprises a motor, a –> "Motor Module", a –> "Servo Control" and, in 
most cases, a speed and position –> "Encoder". 
Electric servo drives are normally extremely precise and have a high dynamic response. 
They are designed for cycle times less than 100 ms, and often have a short-time overload 
capacity which enables quick acceleration. Servo drives are available as rotary and linear 
drives and are used for machine tools, handling robots, and packaging machines. 

SITOP power  
Component for the -> "Electronic power supply". Example: 24 VDC 

Smart Line Module  
Unregulated line infeed / feedback unit with a diode bridge for the infeed and stall-protected, 
line-commutated feedback via -> "IGBTs". 
The Smart Line Module supplies the DC-link voltage for the -> "Motor Modules". 

Software product  
The term software product is generally used to describe a product that is installed on a piece 
of → hardware to process data. Within the license management of SINUMERIK software 
products, a corresponding → license is required to use each software product. 
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Status Word  
Bit-coded -> "Process data" word, transmitted by -> "PROFIdrive" at cyclic intervals to 
control the drive states. 

Vector Control  
Vector control (field-oriented control) is a high-performance control type for induction 
machines. It is based on an exact model calculation of the motor and two current 
components that simulate and accurately control the flux and torque by means of software 
algorithms. As a consequence, the entered speeds and torques can be precisely maintained 
and limited with a good dynamic performance. 
The vector control is available in two variants: 

The frequency control (-> "Sensorless vector control") and the speed-torque control with 
speed feedback (-> "Encoder"). 
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A 
Absolute encoders, 205 

Calibration, 173 
Acceleration, 184 

Checking, 184 
Access levels, 31 
Adjustment, 206 
Advanced Surface (option), 236 
ALM identification, 148 
Assigning actual-value channels, 174 
Assigning setpoint channels, 174 
Automatic servo optimization, 241, 243 

Creating a report, 267 
Interpolation path, 264 
Measurement, 244 
Optimization log, 259, 263 

Axis 
Assigning, 162, 376 
Monitoring functions, 190 
Reference point approach, 199 
Velocity matching, 188 

Axis selection, 244 

B 
Basic system clock cycle, 229 
Brake behavior OFF3, 153 

C 
Catalog motor, 86 
Certificate of License (CoL), 330, 334 
Channel axes, 375 
Circularity test, 241 

Carry out measurement, 286 
Examples of the position setpoint filter, 287 
Optimization example 1, 288 
Optimization example 2, 289 
Optimization example 3, 290 
Save graphic, 291 
Save parameters, 291 
Setting parameters, 286 

Clamping tolerance, 191 
Coding switches, 26 

Commissioning archive 
Creating, 323 
Reading in, 323 

CompactFlash card, 329, 334 
Computational resolution, 219 
Configuration 

Change, 130 
Sorting, 131 

Contour monitoring, 195 
Control direction, 182 
Control mode, 91 
Controller data overview, 244 
Create MyConfig, 360 
Current control loop, 241 
Cycle times, 228 
CYCLE832 (High Speed Cutting), 237 

D 
Data backup 

DRIVE-CLiQ motors, 319 
Point in time, 319 

Data set 
Adding, 113 
Drive (DDS), 112 
Encoder (EDS), 112 
Modify, 119 
Motor (MDS), 112 
Removing, 120 

DC-link identification, 148 
Details, 39 
Device configuration, 78 
Display resolution, 219, 220 
Distancecoded reference marks, 203 
Drive 

Faults, 124 
NC controlled, 67 
PLC-controlled, 295 
PROFIBUS DP, 295 
Warnings, 124 

Drive components, 370 
Drive object, 370 
Drive Object 

Activate, 135 
Deactivation, 135 
Delete, 137 

Drive optimization, 241 
Drive system diagnostics, 123 
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Drive Unit 
Configuration, 126 
Topology, 128 

Drive wizard, 85 
DSC, 176 
Dynamic monitoring functions, 193 
Dynamic servo control, 176 

E 
Encoder monitoring 

Position tolerance when switching over the 
encoder, 197 
Zero-mark monitoring, 197 

Encoder Monitoring 
Cut-off frequency, 196 

Encoder type 
Absolute measuring system, 172 
Rotary measuring system, 169 

Exact stop 
Coarse, 190 
Fine, 190 

F 
Factory settings, 103 
Firmware update, 105 
Firmware version 

Sensor module, 147 
SINAMICS S120, 146 

G 
Geometry axes, 375 

H 
Hardware configuration, 39 
Hardware limit switch, 192 
Hardware reference, 329 
Hardware serial number, 329, 335 
Hirth axes, 180 

I 
Indexing axes, 180 
Indexing position tables, 180 
Infeed power supply data, 147 
Input resolution, 219 
Interpolation, 264 

Interpolation axes, 243 
Interpolation cycle, 231 

J 
Jerk, axial, 185 
JOG axis velocity, 189 

L 
License, 335 
License database, 332 
License information, 329 
License key, 329, 335 
License number, 335 
Linear axis 

With linear scale, 171 
With rotary encoder on motor, 169 
With rotary encoder on the machine, 169 

M 
Machine axes, 375 
Machine data 

Changing scaling, 224 
Loading of default data, 225 

Max. axis velocity, 188 
MD10050 $MN_SYSCLOCK_CYCLE_TIME, 232 
MD10061 $MN_POSCTRL_CYCLE_TIME, 232 
MD10070 $MN_IPO_SYSCLOCK_TIME_RATIO, 232 
MD10071 $MN_IPO_CYCLE_TIME, 232 
MD10185 $MN_NCK_PCOS_TIME_RATIO, 232 
MD11510 $MN_IPO_MAX_LOAD, 232 
MD28060 $MC_NUM_IPO_BUFFER_SIZE, 232 
MD35010 $MA_GEAR_STEP_PC_MAX_VELO_LIMIT, 
208 
Measurement of current control loop, 273 
Measurement of speed control loop, 274 
Measuring functions, 271 

Cancel, 272 
Start, 272 

Measuring system 
Absolute, 172 
Linear, 171 
Parameterize, 169, 171, 172 
Rotary, 169 
Switchover, 175 

Modular machine, 126 
Modulo display, 178 
Monitoring the supply system voltage, 148 
Motor data set direct selection, 117 
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N 
NCK commissioning switch, 26 
NCK memory allocation, 235 
NCU interfaces, 25 

O 
Optimization objective 

Maximum fault clearance, 254 
Moderate fault clearance, 254 
Optimal damping, 254 

Optimization strategy, 253 
Option, 335 

P 
Parameter sets 

Axis, 167 
Position controller, 167 
Spindle, 167 
Validity, 167 

Parking position, 244 
Password 

Change, 32 
Set, 32 

PLC 
Changing the operating state, 321 
Communication setup, 34 
Mode selector switch, 26 

PLC-controlled drives quantity structure, 295 
Position control loop, 241 

Measurement, 277 
Overshoots, 184 
Reference frequency response, 279 
Setpoint step change, 280 
Step height, 281, 282 

Position-control cycle, 229 
Positioning accuracy of the control system, 228 
Positioning axes, 179 
Power on reset, 80 
PROFIBUS connection, 159 
PROFIBUS telegram type, 91 
Pulse multiplication, 209 

R 
Rapid traverse in jog mode, 188 
Reference point approach, 199 
Reinstallation of the CNC software, 343 
Resolutions, 219 

Rotary axis 
Drive Optimization, 178 
Modulo conversion, 178 
With rotary encoder on motor, 170 
With rotary encoder on the machine, 170 

S 
Safe operation, 19 
Scaling of physical quantities, 221 
Servo gain, 182 

Checking, 183 
Servo gain factor definition, 182 
Setting the axis-specific setpoint / actual value 
parameters, 174 
Setting the axis-specific setpoint parameters, 174 
Signal distortion, 196 
SIMATIC Manager, 33 
SIMATIC S7 project, 35 
SINUMERIK 840D sl Toolbox, 24 
Software limit switch, 192 
Software product, 329 
Speed adjustment, 153 
Speed control loop, 241 
Speed setpoint matching, 186 
Speed setpoint monitoring, 193 
Spindle 

Encoder matching, 209 
Gear stages, 208, 211 
Master, 387 
Measuring systems, 209 
Modes, 383 
Monitoring functions, 215 
Parameter sets, 208 
Positioning, 213 
Setpoint matching, 212 
Setpoint/actual value channels, 208 
Synchronization, 214 
Velocities, 211 

Static monitoring functions, 190 
Strategy 

Selection, 244 
Switching over the measuring system, 225 
System data, 219 
System utilization, 232 

T 
Tapping, 167 
Telegrams 

Manufacturer-specific, 373 
Standard, 373 
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Terminal assignment 
Inputs/outputs, 75 
NCU - X122, 71 
NCU - X132, 72 
NCU - X142, 73 
NX 1x.3, 73 
Support, 75 

Third-party motor, 93 
Thread cutting, 167 
Topology 

"Change >" softkeys, 133 
Actual/reference topology comparison, 132 
Delete the component, 139 

Topology rules, 369 
Travel direction, 181 
Traversing ranges, 227 

U 
Upgrade 

Create MyConfig, 364 
Service system, 343 

V 
Velocity, 233 

Dynamic monitoring functions, 195 
Lower limit, 234 
Max. axis velocity, 233 
Max. tool path velocity, 233 
Maximum spindle speed, 233 
Upper limit, 234 

W 
Web License Manager, 331 
Working area limitation, 191 

Z 
Zero speed tolerance, 190 
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